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1 What is interoperability?

Interoperability is often seen as the missing link between different software systems. It
allows best-of-breed applications to share common objects, geometry and properties
between applications. Interoperability is a process, which allows diverse systems and
organizations to work together. This allows common 3D models to be built or information
and geometry defined in one system to be used in another. An example of this would be a 3D
structural frame from a modeling application being transferred and used by an Analysis &
Design system. Another example would be an Architectural model being used within a
structural modeling system.

What is interoperability? 9



2 Industry standards

There are many industry standard file transfer formats. The principle ones supported by Tekla
Structures are IFC, CIS/2, DSTV, SDNF, DGN, DXF, DWG, IGES, and STEP. Older formats are also
included. For a tighter integration, you can link to Tekla Structures using the Tekla Open API
technology.

The file name extension normally informs the user which format it is based upon. If you do
not know what format it is, or the file does not import, then you will need to open the file in
a text editor to look at the header information, where the file type and the authoring
application is usually noted. With CIS/2 files the authoring application and version number is
sometimes written at the end of the file.

Compatible formats on page 11See also
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3 Compatible formats

The following table lists many of the different formats you can use in Tekla Structures to
import and export data.

Format Import Export
AutoCAD (.dwg) X X

AutoCAD (.dxf) X X

Bentley ISM X X

BVBS (.abs) X

Cadmatic models (.3dd) X

Calma plant design system (.calma) X X

CIS/2 LPM5/LPM6 analytical (.stp,.p21,.step) X X

CIS/2 LPM5/LPM6 design (.stp,.p21,.step) X X

CIS/2 LPM6 manufacturing (.stp,.p21,.step) X

DSTV (.nc,.stp,.mis) X X

EJE X

Elematic ELiPLAN, ELiPOS (.eli) X X

EPC X

FabTrol Kiss File (.kss) X

FabTrol MIS Xml (.xml) X X

GTSdata Priamos X

High Level Interface File (.hli) X X

HMS (.sot) X

IBB Betsy X

IFC2x/IFC2x2/IFC2x3 (.ifc) X X

IFCXML2X3 (.ifcXML) X X

IFCZIP (.ifcZIP) X X

Initial Graphics Exchange Specification (IGES) (.iges,.igs) X X

Compatible formats 11



Format Import Export
Intergraphs Parametric Modeling Language (.plm) X

Microsoft Project (.xml) X X

Microstation (.dgn) X X

Oracle Primavera P6 (.xml) X X

Plant Design Management System (.pdms) X

RIB iTWO X

SAP, Oracle, ODBC, etc. X * X *

SketchUp (.skp) X X

Staad ASCII file (.std) X X

Steel Detailing Neutral Format (.sdf,.sdnf, .dat) X X

Steel12000 X

STEP AP203 (.stp,.step) X

STEP AP214 (.stp,.step) X X

Tekla BIMsight project file (.tbp) X X

Tekla-FabTrol Report (.xsr) X

Tekla Structures shape (.tsc) X X

Trimble LM80 (.txt,.cnx) X X

Unitechnik (.uni) X

* Tekla OpenAPI used

Compatible software on page 13See also
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4 Compatible software

The following table lists Tekla Structures compatible software and the formats that you can
import to and export from Tekla Structures.

Product Company Import to Tekla Structures Export from Tekla
Structures

3D+ Tekla AutoCAD (.dwg)

AutoCAD (.dxf)

Steel Detailing Neutral Format
(.sdf,.sdnf)

AutoCAD (.dwg)

AutoCAD (.dxf)

3ds
Max

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

AutoCAD (.dwg)

AutoCAD (.dxf)

3ds
Max
Design/
VIZ

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

AutoCAD (.dwg)

AutoCAD (.dxf)

Adapt Adapt
Corporation

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

Advanc
e Steel,
Advanc
e
Design/
Enginee
ring

GRAITEC CIS/2 LPM5 analytical
(.stp,.p21,.step)

IFC2X3 (.ifc)

Steel Detailing Neutral Format
(.sdf,.sdnf)

CIS/2 LPM5 analytical
(.stp,.p21,.step)

IFC2X3 (.ifc)

Steel Detailing Neutral
Format
(.sdf,.sdnf)

Allplan Nemetschek AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)
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Product Company Import to Tekla Structures Export from Tekla
Structures

ANSYS ANSYS IGES (.iges, .igs) IGES (.iges, .igs)

ArchiCA
D

Graphisoft /
Nemetschek

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

IFCXML 2X3 (.xml)

IFCZIP (.ifczip)

Coordinated view v1

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

IFCXML 2X3 (.xml)

IFCZIP (.ifczip)

Coordinated view v1

Archon
CAD

ArchonCAD
Ltd.

AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

AutoCAD (.dwg)

AutoCAD (.dxf)

ASI Applied
Science
International
LLC

 Staad ASCII file
(.std)

AutoCA
D

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCA
D
Archite
cture

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

IGES (.iges, .igs)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

AutoCA
D Civil
3D

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

Microstation (.dgn)

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCA
D MEP

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

AutoPL
ANT

Bentley AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoVu
e

Oracle  AutoCAD (.dwg)

AutoCAD (.dxf)
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Product Company Import to Tekla Structures Export from Tekla
Structures

IFC2X3 (.ifc)

STEP AP214
(.stp,.step)

AxisVM Inter-CAD
Kft.

Direct Link Direct Link

IFC2X3 (.ifc)

Bentley
Archite
cture

Bentley Direct Link (ISM)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

STEP AP203/AP214 (.stp,.step)

Direct Link (ISM)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

STEP AP214
(.stp,.step)

Bentley
Buildin
g
Electric
al
Systems

Bentley AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

STEP AP214
(.stp,.step)

Bentley
Buildin
g
Mechan
ical
Systems

Bentley AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

STEP AP214
(.stp,.step)

Bentley
Structu
ral

Bentley Direct Link (ISM)

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 design (.stp,.p21,.step)

IFC2X3 (.ifc)

Microstation (.dgn)

Steel Detailing Neutral Format
(.sdf,.sdnf)

STEP AP203/AP214 (.stp,.step)

Direct Link (ISM)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

STEP AP214
(.stp,.step)
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Product Company Import to Tekla Structures Export from Tekla
Structures

BVBS BVBS BVBS (.abs)

CADme
p+

MAP
Software /
Autodesk

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

IFCXML 2X3 (.xml)

IFCZip (.ifczip)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

IFCXML 2X3 (.xml)

IFCZip (.ifczip)

Cadmat
ic

Cadmatic AutoCAD (.dwg)

AutoCAD (.dxf)

Cadmatic models (.3dd)

AutoCAD (.dwg)

AutoCAD (.dxf)

CADPip
e

AEC Design
Group

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

CADWo
rx Plant

Intergraph /
Hexagon

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

CAESAR
II

Intergraph /
Hexagon

AutoCAD (.dwg) AutoCAD (.dwg)

CATIA Dassault AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

Steel Detailing Neutral Format
(.sdf,.sdnf)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

Steel Detailing Neutral
Format
(.sdf,.sdnf)

STEP AP214
(.stp,.step)

ConSte
el

ConSteel
Solutions
Limited

ASCII

Constru
ctor

VICO
Software

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

IfcXML 2X3 (.xml)

Microstation (.dgn)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

IfcXML 2X3 (.xml)

Microstation (.dgn)

CYPECA
D

Cype Direct Link
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Product Company Import to Tekla Structures Export from Tekla
Structures

Daystar
Softwar
e

Daystar
Software
Inc.

AutoCAD (.dxf)

Steel Detailing Neutral Format
(.sdf,.sdnf)

AutoCAD (.dxf)

Steel Detailing Neutral
Format
(.sdf,.sdnf)

DDS-
CAD

DDS IFC2X3 (.ifc) IFC2X3 (.ifc)

Diamon
ds

Buildsoft Direct Link Direct Link

Digital
Project

Gehry
Technologies

AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

Steel Detailing Neutral Format
(.sdf,.sdnf)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

Steel Detailing Neutral
Format
(.sdf,.sdnf)

STEP AP214
(.stp,.step)

DuctDe
signer
3D

QuickPen /
Trimble

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

elcoCA
D

Hannappel
SOFTWAR E
GmbH

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

ELiPLAN Elematic ELiPLAN (.eli) ELiPLAN (.eli)

ELiPOS Elematic ELiPLAN (.eli)

EliteCA
D

Messerli
Informatik

IFC2X3 (.ifc)
AutoCAD (.dxf)

IFC2X3 (.ifc)

AutoCAD (.dxf)

ETABS Computers
&Structures,
Inc.

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

Steel Detailing Neutral Format
(.sdf,.sdnf)

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

Steel Detailing Neutral
Format
(.sdf,.sdnf)

STEP AP214
(.stp,.step)

FabPro
Pipe

UHP Process
Piping Inc.

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)
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Product Company Import to Tekla Structures Export from Tekla
Structures

FabTrol
MRP

FabTrol FabTrol MIS XML (.xml) FabTrol MIS XML
(.xml)

FabTrol KISS File
(.kss)

Tekla-FabTrol Report
(.xsr)

Factory
CAD

Siemens AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

Fastrak CSC Direct Link Direct Link

FelixCA
D

SofTec AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

FEM
Design

StruSoft Direct Link

IFC2X3 (.ifc)

Direct Link

IFC2X3 (.ifc)

Floor
Pro

Adapt
Corporation

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

FormZ AutoDesSys,
Inc.

AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

STEP AP214
(.stp,.step)

GSA Oasys CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

GT
Strudl

GT Strudl Direct Link

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

Direct Link

AutoCAD (.dxf)

HMS HMS  HMS (.sot)

HOOPS Tech Soft 3D  AutoCAD (.dwg)

AutoCAD (.dxf)

Invento
r

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

STEP AP214
(.stp,.step)
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Product Company Import to Tekla Structures Export from Tekla
Structures

IronCA
D

IronCAD AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

STEP AP214
(.stp,.step)

KeyCrea
tor

Kubotek AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

STEP AP214
(.stp,.step)

LEIT200
0

SAA  Unitechnik (.cam)

MagiCA
D

Progman AutoCAD (.dwg)

IFC2X3 (.ifc)

AutoCAD (.dwg)

IFC2X3 (.ifc)

MasterF
rame

MasterSeries DSTV96 (.nc,.stp,.mis) DSTV96
(.nc,.stp,.mis)

Maxon
Cinema
4D

Nemetschek AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

Maya Autodesk AutoCAD (.dxf)

IGES (.iges, .igs)

STEP AP214
(.stp,.step)

Autodesk Maya
AutoCAD (.dxf)

Mesh
Weldin
g

Filzmoser  Unitechnik (.cam)

Mesh
Weldin
g

Progress /
EBAW E

 Unitechnik (.cam)

Microso
ft
Office
Project

Microsoft Project (.xml) Project (.xml)

Microst
ran

Engineering
Systems Pty
Limited

AutoCAD (.dxf) AutoCAD (.dxf)

Microst
ation

Bentley AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)
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Product Company Import to Tekla Structures Export from Tekla
Structures

Microstation (.dgn)

STEP AP203/AP214 (.stp,.step)

Microstation (.dgn)

STEP AP214
(.stp,.step)

Midas
Gen

MIDAS Direct Link Direct Link

ModeSt Tecnisoft Direct Link Direct Link

Multifr
ame

Daystar
Software
Inc.

AutoCAD (.dxf)

Steel Detailing Neutral Format
(.sdf,.sdnf)

AutoCAD (.dxf)

Steel Detailing Neutral
Format
(.sdf,.sdnf)

Nastran MSC
Software
Corporation

AutoCAD (.dwg)

IGES (.iges, .igs)

AutoCAD (.dwg)

IGES (.iges, .igs)

NavisW
orks

Autodesk  AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

IFC2X3 (.ifc)

Microstation (.dgn)

NISA Cranes
Software
International
Ltd. / CSC

Direct Link Direct Link

NX
(Unigra
ph)

Siemens AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

STEP AP214
(.stp,.step)

Orion CSC Direct Link

AutoCAD (.dxf)

Direct Link

AutoCAD (.dxf)

PDMS AVEVA Microstation (.dgn)

Steel Detailing Neutral Format
(.sdf,.sdnf,.dat)

Microstation (.dgn)

Steel Detailing Neutral
Format
(.sdf,.sdnf,.dat)

PDS Intergraph /
Hexagon

Microstation (.dgn)

Steel Detailing Neutral Format (.dat)

Microstation (.dgn)

Steel Detailing Neutral
Format (.dat)
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Product Company Import to Tekla Structures Export from Tekla
Structures

PipeCA
D

Mc4
Software

AutoCAD (.dxf) AutoCAD (.dxf)

PipeDes
igner
3D

QuickPen /
Trimble

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Plancal Plancal Ag /
Trimble

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

Plant-4
D

CEA
Technology

 AutoCAD (.dwg)

AutoCAD (.dxf)

Microstation (.dgn)

PowerC
onnect

Buildsoft Work in progress Work in progress

PowerFr
ame

Buildsoft Direct Link Direct Link

Primave
ra

Oracle P6 (.xml) P6 (.xml)

ProCon
crete,
ProStee
l,
ProStru
ctures

Bentley Steel Detailing Neutral Format
(.sdf,.sdnf)

AutoCAD (.dwg)

AutoCAD (.dxf)

Microstation (.dgn)

Steel Detailing Neutral
Format
(.sdf,.sdnf)

Pro/
Enginee
r

PTC IGES (.iges,.igs)

STEP AP203/AP214 (.stp,.step)

STEP AP214
(.stp,.step)

Prokon Prokon CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

QUEST
ware

QUESTware
Corporation

Direct Link Direct Link

RAM
(CAD
Studio)

Bentley AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design (.stp,.p21,.step)

ISM

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design
(.stp,.p21,.step)

ISM
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Product Company Import to Tekla Structures Export from Tekla
Structures

Revit
Archite
cture

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

Tekla Collaboration
files (.tczip)

Revit
Structu
re

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 design (.stp,.p21,.step)

IFC2X3 (.ifc)

Microstation (.dgn)

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 design
(.stp,.p21,.step)

IFC2X3 (.ifc)

Microstation (.dgn)

Tekla Collaboration
files (.tczip)

Revit
MEP

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Microstation (.dgn)

Tekla Collaboration
files (.tczip)

RFEM Dlubal Direct Link

CIS/2 LPM6 analytical
(.stp,.p21,.step)

IFC2X3 (.ifc)

Direct Link

CIS/2 LPM6 analytical
(.stp,.p21,.step)

IFC2X3 (.ifc)

Rhinoce
ros

McNeel
North
America

AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

Microstation (.dgn)

STEP AP203/AP214 (.stp,.step)

Geometry Gym link

AutoCAD (.dwg)

AutoCAD (.dxf)

Microstation (.dgn)

STEP AP214
(.stp,.step)

Geometry Gym link
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Product Company Import to Tekla Structures Export from Tekla
Structures

RISA-3
D
(Suite)

Risa
Technology

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design (.stp,.p21,.step)

Steel Detailing Neutral Format
(.sdf,.sdnf)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design
(.stp,.p21,.step)

Robot
Milleni
um

Autodesk Direct Link

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design (.stp,.p21,.step)

Direct Link

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design
(.stp,.p21,.step)

RSTAB Dlubal Direct Link

CIS/2 LPM6 analytical
(.stp,.p21,.step)

IFC2X3 (.ifc)

Direct Link

CIS/2 LPM6 analytical
(.stp,.p21,.step)

IFC2X3 (.ifc)

SACS Engineering
Dynamics
Inc.

AutoCAD (.dxf)

Steel Detailing Neutral Format (.sdnf)

SAFE Computers
&
Structures,
Inc.

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

IGES (.iges, .igs)

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

SAM Bestech
Limited

AutoCAD (.dxf) AutoCAD (.dxf)

SAP200
0

Computers
&
Structures,
Inc.

Direct Link

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

Direct Link

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

SCIA Nemetschek Direct Link

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

SDS/2 Design Data AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)
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Product Company Import to Tekla Structures Export from Tekla
Structures

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design (.stp,.p21,.step)

Microstation (.dgn)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design
(.stp,.p21,.step)

CIS/2 LPM6
manufacturing
(.stp,.p21,.step)

Microstation (.dgn)

S-
FRAME

S-FRAME
Software
Inc.

Direct Link

AutoCAD (.dxf)

Direct Link

AutoCAD (.dxf)

Sketch
Up
Make

Trimble SketchUp (.skp) SketchUp (.skp)

Sketch
Up Pro

Trimble SketchUp (.skp)
AutoCAD (.dwg)

AutoCAD (.dxf)

SketchUp (.skp)
AutoCAD (.dwg)

AutoCAD (.dxf)

Smart
3D
(SmartP
lant /
SmartM
arine)

Intergraph /
Hexagon

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design (.stp,.p21,.step)

Microstation (.dgn)

IFC2X3 (.ifc), with SmartPlant 3D

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 design
(.stp,.p21,.step)

Microstation (.dgn)

Solibri
Model
Checker

Solibri  IFC2X3 (.ifc)

SolidEd
ge

Siemens AutoCAD (.dxf)

Microstation (.dgn)

IGES (.iges, .igs)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dxf)

Microstation (.dgn)

STEP AP214
(.stp,.step)

SolidW
orks

Dassault AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

IFC2X3 (.ifc)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

STEP AP214
(.stp,.step)

SPA CE
GASS

SPA CE
GASS

CIS/2 LPM6 analytical
(.stp,.p21,.step)

CIS/2 LPM6 analytical
(.stp,.p21,.step)
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Product Company Import to Tekla Structures Export from Tekla
Structures

SpaceCl
aim

SpaceClaim
Co.

AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

STEP AP214
(.stp,.step)

STAAD.
Pro

Bentley Direct Link

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

Steel Detailing Neutral Format
(.sdf,.sdnf)

ISM

Direct Link

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

Staad ASCII file
(.std)

ISM

Steel
Smart
System

Applied
Science
International
, LLC

AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

StruCA
D

AceCAD
Software,
Inc.

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

IFC2X3 (.ifc)

Steel Detailing Neutral Format
(.sdf,.sdnf) [use SDNF version 2.0]

AutoCAD (.dwg)

AutoCAD (.dxf)

CIS/2 LPM6 analytical
(.stp,.p21,.step)

IFC2X3 (.ifc)

Steel Detailing Neutral
Format
(.sdf,.sdnf) [use
SDNF version 2.0]

Structu
reWorks

StructureWo
rks LLC.

AutoCAD (.dwg)

AutoCAD (.dxf)

IGES (.iges, .igs)

STEP AP203/AP214 (.stp,.step)

STEP AP214
(.stp,.step)

STRUDS SoftTech Direct Link Direct Link

Tekla
BIMsigh
t

Tekla Tekla BIMsight Project (.tbp) Tekla BIMsight Project
(.tbp) *

AutoCAD (.dwg)

Microstation (.dgn)

IFC2X3 (.ifc)
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Structures

IFCXML (.ifcXML)

IFCzip (.ifcZIP)

Trimble
LM80

Trimble AutoCAD (.dxf)

LM80 (.cnx, .txt)

AutoCAD (.dxf)

LM80 (.cnx, .txt)

Trimble
LM80
Desktop

Trimble AutoCAD (.dxf)

LM80 (.cnx, .txt)

AutoCAD (.dxf)

LM80 (.cnx, .txt)

TurboC
AD

IMSI Design AutoCAD (.dwg)

AutoCAD (.dxf)

Microstation (.dgn)

STEP AP203/AP214 (.stp,.step)

AutoCAD (.dwg)

AutoCAD (.dxf)

Microstation (.dgn)

STEP AP214
(.stp,.step)

UniCA
M

Unitechnik  Unitechnik (.cam)

Unigrap
hics

Siemens
PLM
Software

 IGES (.iges, .igs)

Vector
Works

Nemetschek IFC2X3 (.ifc)

IGES (.iges, .igs)

AutoCAD (.dwg)

AutoCAD (.dxf)

IFC2X3 (.ifc)

Volo
View

Autodesk AutoCAD (.dwg)

AutoCAD (.dxf)

AutoCAD (.dwg)

AutoCAD (.dxf)

Compatible formats on page 11See also
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5 Importing to and exporting from
Tekla Structures

Tekla Structures has several tools you can use to import and export physical and reference
models and the information they contain.

You can use import and export in Tekla Structures for several purposes:

• You can import 2D or 3D models created by other software, then detail or manipulate the
structural objects using Tekla Structures. Once the model is complete, you can export it,
and return it to the architect or engineer for review.

• You can create reports from the imported models from most of the formats.

• You can export Tekla Structures models for use in Analysis & Design (several formats).
Then you can import the Analysis & Design results back to the Tekla Structures model.

• Various model transfers can be completed for the engineering and contractor phase of
the project.

• You can import shapes from many formats. Shapes are used in defining items.

• You can export data for use in manufacturing information systems and in the fabrication
phase:

• You can export CNC data (Computer Numerical Control) for use by automated
cutting, drilling and welding CNC machinery.

• You can export to MIS (Manufacturing Information Systems) so that fabricators can
track project progress, for example.
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6 Conversion files

Conversion files map Tekla Structures profile, twin profile, and material names with names
used in other software. Conversion files are simple text files, containing the Tekla Structures
name in the first column, and the name used in the other software package in the second
column. Columns are separated by a space. All parametric profiles must be entered in the
profile conversion file.

You can use the same conversion file both when importing and exporting models, and you
can specify the location of conversion files in most of the import and export tools.

If you enter a conversion file name without a path, Tekla Structures searches for the file in
the current model folder. If you leave the box empty, Tekla Structures searches for the file
indicated by the advanced option XS_PROFDB in Tools --> Options --> Advanced
Options... --> File Locations . This is also the case, if the tool does not allow you to define
the path and conversion file.

Tekla Structures has several conversion files in the standard installation, and you can also
create your own. Standard conversion files are located in the \environments
\<environment>\profil folder. All conversion files have the .cnv extension.
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Twin profile conversion files on page 29

Creating conversion files on page 29

6.1 Twin profile conversion files
Tekla Structures contains separate conversion files for twin profiles, and it reads the twin
profile conversion file before the profile conversion file, so you must include the profiles from
the original model in the import.

The twin profile conversion file is a text file containing the profile prefix (characters only)
and the distance between the profiles in mm, separated by a space. Tekla Structures converts
all profiles with the specified prefix to twin profiles.

The twin profile conversion file could be named twin_profiles.cnv and it could
contain lines such as the one below:

DL 20
The distance between the profiles is the same for all profiles with the same profile prefix. For
example, profiles with the prefix DL will always have the same spacing. If you want different
spacing values, then you need to use a different profile prefix.

You also need to add the twin profile to the profile conversion file to get the DL profile
converted to L-profile:

L200*20 DL200/20-20

• Twin profile conversion cannot be used for profiles that start with a number. This means
that you cannot define double angles as 2L. Instead, you need to use DL as the prefix for
a twin profile, for example: DL200/20-20.

• Twin profile conversion does not work for FEM import. We recommend that each angle is
modeled separately rather than as twin profiles, as SP3D does not control the gaps
between members in the same way as Tekla Structures and there are, for example,
various conversion and mapping difficulties. Ii is easier to convert members that are
modeled as two members.

Conversion files on page 28

Creating conversion files on page 29

6.2 Creating conversion files

You can create your own conversion files if the ones that come with Tekla Structures
installation do not suit your needs.

To create a new conversion file:

See also

Limitations

See also
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1. Open an existing conversion file using any standard text editor that does not contain any
special characters. 

By default, conversion files are located in ...\ProgramData\Tekla
Structures\<version>\environments\<environment>\profil.

2. Save the file with another name. 

If the export/import tool allows you to define the path to the conversion file, you can
save the file where you like. If this is not the case, save the file in a location defined by
the advanced option XS_PROFDB in Tools --> Options --> Advanced Options --> File
Locations .

3. Modify the file: enter profile names recognized by Tekla Structures in the first column,
and the corresponding name recognized by the other software in the second column. 

While modifying, ensure that:

• You do not have blank material definitions (" ", empty quotation marks).

• You do not have spaces in the profile position strings. For example, enter "Hand_
Rail" not Hand Rail".

4. Save your changes.

• All the three files (profile, twin profile and material) are not needed if the
differences in the profile name is just concerning * X or x formats, because
these are normally handled automatically. For example, if you wanted to
import UC254x254x73 to be UC254*254*73, the lower case "x" is
automatically changed to "X" so the format of the conversion file would be
UC254*254*73 254X254X73.

• If you have problems importing the model, check any error messages in the
Tekla Structures log file, and check the conversion files.

Below are some examples of conversion files:

! Profile name conversion Tekla Structures -> SDNF
!
! If Converted-name does not exist, it will be the same
! as Tekla Structures-name.

! Tekla Structures-name Converted-name

C10X15.3 C10X15.3
C10X20 C10X20
C10X25 C10X25

Example
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C10X30 C10X30
C12X20.7 C12X20.7
C12X25 C12X25
C12X30 C12X30
C15X33.9 C15X33.9
C15X40 C15X40
C15X50 C15X50
C3X4.1 3X4.1
! Profile name conversion Tekla Structures -> DSTV
!
! If Converted-name does not exist, it will be the same
! as Tekla Structures-name.

! Tekla Structures-name Converted-name

C10X15.3  C10X15.3
C10X20    C10X20
C10X25    C10X25
C10X30    C10X30
C12X20.7  C12X20.7
C12X25    C12X25
Below there is first an example of an incorrect conversion file and then of a correct one,
errors are highlighted:

00100782 4 0 2 "brace" "Tread 4" 1 "TREAD4.5" "" 0.000000 0 0 
0.000000 1.000000 0.000000 16.250000 13.154267 3.857143
15.500000 13.154267 3.857143 0.000000 0.000000 0.000000
0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
0.000000 0 0 0 0 0 0 0 0 0 0 0 0
00100782 4 0 2 "brace" "Tread_4" 1 "TREAD4.5" "A36" 0.000000
0 0 0.000000 1.000000 0.000000 16.250000 13.154267 3.857143
15.500000 13.154267 3.857143 0.000000 0.000000 0.000000
0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
0.000000 0 0 0 0 0 0 0 0 0 0 0 0
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7 Reference models

A reference model is a file that helps you to build a Tekla Structures model. A reference
model is created in Tekla Structures or another software or modeling tool and imported to
Tekla Structures. For example, an architectural model, a plant design model, or a heating,
ventilating and air-conditioning (HVAC) model can be used as a reference model. Reference
models can also be simple 2D drawings that are imported and then used as a layout to
directly build the model on.

You can snap to reference model geometry. Tekla Structures loads the reference model from
the file each time you open your model. Tekla Structures does not save the reference model
when you save the current model, but it saves the link to the reference model. The filename
extension of a saved reference model properties file is .rmip.json. The values of Code,
Title, Phase and Description cannot be saved in the standard properties file.

The following file types are supported:

• AutoCAD files.dxf
• AutoCAD files .dwg (supported version ACAD2014 and earlier)

• MicroStation files.dgn, .prp
• Cadmatic files .3dd
• IFC files .ifc, .ifczip, .ifcxml
• Tekla Collaboration files .tczip
• IGES files .igs, .iges
• STEP files .stp, .STEP
• PDF files .pdf
• SketchUp files .skp (supported version SketchUp 2014 and earlier)

Some reference models are automatically subdivided or split into reference model objects.

Inserting a reference model on page 33

Modifying reference model details on page 37

Locking reference models on page 37

Viewing reference models on page 34

See also
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Detecting changes in a reference model on page 38

Reference model objects on page 39

Examining reference model contents on page 39

Examining reference model hierarchy and modifying reference model objects on page 40

7.1 Inserting a reference model

To insert a reference model in a Tekla Structures model:

1. Open a Tekla Structures model where you want to insert the reference model.

2. Open the Reference Models list by clicking the Model list button in the upper-right

corner of the Tekla Structures main view .

3. Click Add model.

4. If you have any previously created reference model properties files, load the desired file
by selecting the file from the list at the top.

5. Browse for the reference model file by clicking Browse next to the Files box. 

You can also drag reference models from Windows Explorer. You can insert several
models at a time.

6. Select a group for the model or enter the name of the group, if it is a new group. 

You can also drag a model to an existing group later on, or create a new group.

7. Select a Coordinate system, which determines whether the model is inserted relative to
model origin or work plane.

8. Select where you want to place the reference model. You can use coordinates or pick a
position for the reference model origin. 

The origin is displayed as a handle.

9. Set the scale of the reference model if it is different from the one in the Tekla Structures
model (for example, if it uses different measurement units). 

Set the scale for a DWG or a DXF file already in AutoCAD. When you define the
measurement unit for a DWG or a DXF file and save the file in AutoCAD, the unit is
recognized in Tekla Structures and the reference model is scaled correctly.

10. You can rotate the model around model Z axis by entering the desired value in the
Rotation box.

11. Click More to show more details and add the Code, Title, Phase and Description of the
reference model. 

The code could be a site number, project number, or accounting number. Write the
description according to the company conventions.

You can also modify all the details after you have inserted the model.
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12. Click Add model.

13. If the inserted reference model lies outside the work area and is not fully or at all visible
in the model view, Tekla Structures displays the "Objects outside the work area" warning
message. Click Expand to extend the work area to see the reference model in the model
view.

Do not import the same reference model to the Tekla Structures model several times. If
there are duplicate reference models, there are also duplicate GUIDs.

When you want to update the reference model, do not delete the old reference model from
an open Tekla Structures model and replace it with a new one, because then you would
lose the work done on reference objects in the old model. Use the change detection
functionality instead.

Modifying reference model details on page 37

7.2 Viewing reference models

There are many ways you can select what you want to show about the reference models and
how.

To: Do this:
Open the Reference Models list

• Click the Reference Models icon  in the
upper-right corner of the Tekla Structures main
view.

Hide and show reference models
• Click the eye icon  next to the model you

want to hide.

The icon changes to  and the reference
model is hidden in the 3D view.

• Click the eye icon again to show the model.

Hide and show a group of reference
models • Click the eye icon  next to the group you

want to hide. The group eye icon and the

reference model eye icons all change to ,
and all the reference models included in the
group are hidden in the Tekla Structures model.

• Click the eye icon again to show all the models in
the group.

See also
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To: Do this:
• If a group contains both hidden and visible

models, the eye icon for the group looks like this

Highlight the reference model in the
3D view

• Click the reference model in the Reference
Models list.

Show reference model details • Double-click the reference model in the
Reference Models list.

Show reference model object details 1. Double-click the reference model in the
Reference Models

2. Ensure that the Select assemblies selection

switch  (for assemblies) or Select objects in

assemblies  (for parts) is active.

3. Point the reference model, hold down Shift and
scroll to the hierarchy level where the desired
reference model object is located.

4. Point the object and double-click it to open the
reference model object details.

Rotate the reference model around
model Z axis.

Enter the desired value in the Rotation box.

Hide and show reference model
layers

1. Double-click the reference model in the
Reference Models list to open the details.

2. Click the small arrow on the Layers row to show
the list of layers.

3. You can show and hide individual layers or all
layers:

• To hide all layers, click the eye icon  on
the Layers row.

• To hide individual layers, click the eye icons

 of the individual layers.

• To hide several layers, holding down Ctrl,
click the desired layers and then click the eye
icon of one of the selected layers.

• If the Layers list contains both hidden and
visible layers, the eye icon for the Layers row

looks like this .
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To: Do this:
• If you hide all layers, the eye icon for the

Layers row changes to .

• If you hide individual layers, the eye icon for

the hidden layers changes to .

Detect changes in the reference
model

1. Double-click the reference model in the
Reference Models list to open the details.

2. Click the small arrow on the Change detection
row to open the Change detection section.

3. Browse for an older version of the reference
model and click the buttons to select what you
want to show (Inserted, Changed, Unchanged,
Deleted).

4. Click Apply.

Update all reference models • Open the Reference Models list and click the

Refresh button .

All models that are not up to date are reloaded. If
a reference model is not found, a warning sign

 is displayed.

Update a single reference model 1. Double-click the reference model in the
Reference Models list to open the details.

2. Click the Refresh button .

The model is reloaded. If the reference model is

not found, a warning sign  is displayed.

View user-defined attributes 1. Double-click the reference model in the
Reference Models list to open the details.

2. Click the small arrow on the User-defined
attributes row to show the list of user-defined
attributes.

3. The user-defined attributes that are specified for
reference models in the objects.inp file are
listed in the User-defined attributes list. Enter
or select a value from the list. By default, the
objects.inp is located in ..
\ProgramData\Tekla Structures
\<version>\environments\common
\inp. You may also have some objects.inp
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To: Do this:
files that you modify and keep in firm or project
folders. These files are read in certain order.

Modifying reference model details on page 37

Reference model objects on page 39

Examining reference model hierarchy and modifying reference model objects on page 40

Detecting changes in a reference model on page 38

Locking reference models on page 37

7.3 Modifying reference model details

After you have inserted a reference model, you can modify its details.

Limitation: Coordinates given in the Details area are always relative to model coordinates.
You can modify the coordinate system only if model coordinate system is used in the
reference model.

To modify reference model details:

1. In the Reference Models list, double-click the reference model.

2. Change the desired details: 

• Change Code, Title, Phase and Description of the reference model.

• Click the arrow on the Details row. In Details, you can change the reference model
File, the model Group, Origin, and Scale.

• Click the arrow on the User-defined attributes row, and enter values for the user-
defined attributes.

You may enter strings (texts), select dates or enter numeric information depending on
the type of the user-defined attribute. The reference model user-defined attributes
are defined in their own section in the objects.inp file. If you have several
objects.inp files, they are read in a specific reading order, for more information,
see Customizing user-defined attributes.

3. Click Modify. The changes that you made are implemented in the reference model.

Inserting a reference model on page 33

See also

See also
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7.4 Locking reference models

You can prevent reference models from moving and from detail updates.

To lock a reference model:

1. Move your mouse over the desired reference model in the Reference models list. 

The Lock icon is displayed.

2. Click the Lock icon. 

Now the reference model is locked. You can only add values for user-defined attributes
and work with layers, but you cannot modify the details in any other way or move the
model.

To unlock the reference model, click the Lock icon again.

Reference models on page 32

Modifying reference model details on page 37

7.5 Detecting changes in a reference model

Reference models are often updated, and sometimes the changes are not documented. You
can check the changes between the old and the new reference model in Tekla Structures by
using the Change detection feature.

Change detection works with the following file formats:

• .ifc
• .ifcxml
• .ifczip
• .tczip
To view changes in the reference model:

1. Double-click the reference model in the Reference Models list.

2. Open the Change detection list by clicking the arrow on the Change detection row.

3. Browse for a previous version of the reference model.

See also
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4. Ensure that both models are visible. Comparison is active only when both of the eye icons

are in visible state .

5. Select any of the check boxes for the following options: Changed, Unchanged, Inserted
and/or Deleted.

6. Click Update view. For example, select Deleted to show with red color the objects that
were deleted between the two versions.

Inserting a reference model on page 33

7.6 Examining reference model contents

You can examine the contents of a reference model. This is something you might want to do
after importing a reference model into Tekla Structures.

To examine the contents of a reference model:

1. Click Tools --> Inquire --> Object .

2. In your Tekla Structures model, click the reference model you want to examine. 

The contents of the reference model are listed in the Inquire Object dialog box.

Inserting a reference model on page 33

7.7 Reference model objects
Some types of reference models are automatically subdivided into reference model objects,
which is an individual part of an imported reference model. You can define user-defined
attributes separately for each reference model object and use them for reports and the view
and selection filters. They can also be moved to a Tekla Structures model that is currently
being worked on. Information included in a reference model object can be saved in the model
database.

The reference model objects are read-only.

See also

See also
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Whether the reference model supports splitting depends on the file format and file structure.
But, for example, .ifc and .dwg files that include any of the following objects, are
automatically split:

• block table

• polyface mesh

• polygon mesh

• proxy object (for example, ADT)

• ACIS objects (3DSolid, Body, Region)

The file formats .dgn, .prp, .skp, .step, and .iges are not subdivided.

Reference models on page 32

7.8 Examining reference model hierarchy and modifying reference
model objects
You can view the reference model hierarchy and check which objects are on which hierarchy
level. You can also add user-defined attributes to the reference model objects. The added
properties can be used for filtering, for example. Additionally, you can view the native
reference object attributes and properties.

To examine and modify reference model objects:

1. Ensure that the Select assemblies selection switch  (for assemblies) or Select

objects in assemblies selection switch  (for parts) is active.

2. Point the reference model, hold down Shift and scroll using the middle mouse button to
the hierarchy level were the reference object is. Notice that if the cursor is too close to a
grid, the hierarchy is not scrolled.

3. Do any of the following: 

• To inquire the native reference object properties and attributes, click the object,
right-click and select Inquire from the pop-up menu.

• To view or modify the user-defined attributes of a reference object, point the object
and double-click it to open the reference model object details.

There are many more commands available for the selected reference model object.
Check rest of the commands on the pop-up menu.

See also
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Below is an example of a reference model representing a sanitary system. When you want to
scroll the hierarchy, the selection switch Select assemblies or Select objects in assemblies
must be on. The 0 level IfcProject in the example is the upmost level.

Below you can see one of the reference objects on the 3 level, IfcBuildingStorey, of the same
reference model.

Reference models 41 Examining reference model hierarchy and modifying
reference model objects



The last level, level 4, shows the individual parts.

In the example below, one of the reference objects on the lowest level has been inquired.

Reference models 42 Examining reference model hierarchy and modifying
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7.9 Reference model assemblies
Imported IFC reference models can contain assemblies. You can select reference model
assemblies in the model view and view assembly level information in Tekla Structures.

• You can add user-defined attributes to reference model assemblies.

• You can use the Inquire command to view information on reference model assemblies.
For example, you can view GUIDs of child objects.
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• You can create reports to view information on reference model assemblies.

See also
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8 PDF

You can import a PDF as a reference model to your model. During import, Tekla Structures
converts the PDF into the DXF format. Only vector graphics are converted.

Importing a PDF to a model on page 45

8.1 Importing a PDF to a model

To import a PDF as a reference model:

1. Click File --> Insert PDF document... 

The Insert PDF Reference Model dialog box opens.

2. Click Browse....

3. Browse for the PDF and click Open.

4. Set the scale for the reference model.

5. Enter the page number that you want to import.

6. Click OK.

7. Pick a point to place the reference model. 

Tekla Structures converts the PDF into the DXF format. The conversion creates a DXF file
for every imported page. Tekla Structures saves the DXF files to the same folder where
the PDF is.

Only vector graphics are converted, not raster graphics.

See also

Limitations
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9 DGN

The DGN format has been used especially for data transfer between plant design programs. It
was developed by MicroStation. It is similar to DWG in that it is only a graphical data format.
It contains unique part IDs in the given model. It is possible to check for clashes between the
Tekla Structures model and a DGN reference model.

This format has the following limitations:

• GUID is not supported

• Change management is not possible with a DGN file.

Reference models on page 32

Inserting a reference model on page 33

Exporting to 3D DGN files on page 48

9.1 DGN import
You can import DGN models as reference models to Tekla Structures. You can view DGN
model objects in different reference model layers according to the level settings in the DGN
file. You can use DGN models for clash checking. Tekla Structures reference model import
supports V7 and V8 DGN formats.

A DGN file can contain one or more DGN models. A DGN model can be one of three types: a
design model, an extrusion model or a sheet model. Design models are most useful in Tekla
Structures as they contain appropriate structural data. If there are many model types
available in a DGN file, Tekla Structures selects the imported model type in the following
order:

1. Active model is imported if it is a design model.

2. Default model is imported if it is a design model.

3. If DGN file contains design models, the first one is imported.

4. If there are no design models in the DGN file, the first model regardless of model type is
imported.

See also
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You can view a log about DGN import on the Log file tab in MessageDialog ( Tools -->
Toolbars --> Message Panel ).

Inserting a reference model on page 33

Supported DGN objects on page 47

Supported DGN objects
Tekla Structures can display the following DGN objects in reference models:

Object Type no. Description
Cell 2 A collection of grouped entities with a common

insertion point/origin, scale and orientation in
2D/3D space.

Line 3

Line string 4 A series of interconnected lines.

Shape 6 Like a line string, but closed (first point = last
point).

Text node 7 A multi-line paragraph/block of text.

Curve 11 A parametric spline curve.

Complex chain 12 A chained collection of other entities (lines, line
strings, arcs, curves or b-spline curves).

Complex shape 14 Like a complex chain, but closed (first point =
last point).

Ellipse 15

Arc 16

Text 17 Supports TrueType fonts and text styles (bold,
underline, italic, etc).

3D surface 18 Like a 3D solid, but not capped on the ends.

3D solid 19 The solid created by projecting or rotating from a
boundary entity (line, line string, curve, arc or
ellipse).

Cone 23 Actually a truncated cone described by two
parallel circles; if the radius of both circles is the
same, a cylinder is produced.

B-spline surface 24 See description of b-spline curves, which also
applies here; additional data is provided by
surface boundary entities (type 25).

B-spline curve 27 Can be rational/non-rational, uniform/non-
uniform, open/closed; entity type 27 supplies
header data and additional data is provided by

See also
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Object Type no. Description
pole entities (type 21), knot entities (type 26) and
weight factor entities (type 28).

Shared cell definition 34 Similar to a DWG block definition; basically
defines a set of grouped entities.

Shared cell instance 35 Similar to a DWG block instance; given a
particular cell 'definition', numerous cell
'instances' can be created at differing locations,
scales and orientations.

Multiline 36 A set of parallel lines, which can be jointed (with
or without visible seams at the joints), and have
various types of end caps (rounded, square, etc).

Mesh 105 Supports indexed face loops, quad list, quad grid,
triangle grid and triangle list meshes.

Smart solid - Smart solids (solids created from embedded
Parasolid/ACIS data) can be imported into Tekla
Structures as wireframe outlines.

The following objects have specific limitations:

Object Type no. Description
Point string 22 Not supported. (A point string is a series of

points with associated orientations; point
strings are typically used for defining
walkthrough paths).

Dimension 33 Not supported.

Mesh 105 The point cloud mesh type is not currently
supported.

Smart solid - Smart solids (solids created from embedded
Parasolid/ACIS data) are currently supported
as wireframe outlines only; for this reason,
smart solids do not currently participate in
clash checking operations.

Inserting a reference model on page 33

DGN import on page 46

9.2 Exporting to 3D DGN files

You can export selected parts or the whole model to 3D DGN.

To export a 3D DGN file:

1. Open a Tekla Structures model.

Limitations

See also
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2. Click File --> Export --> 3D DGN... to open the Export 3D DGN dialog box.

3. In the Output file box, enter the name of the export file. 

If you want to replace an already existing file, click the ... button and browse for the file.

4. In the Export list, select All objects, or Selected objects and select the parts to export.

5. Click Create. 

Tekla Structures creates the <name>.dgn file in the current model folder.

If you have tubular parts in your model and you want to reduce the size of the DGN files or
the complex display in the rendered views, you can use the following advanced options to
control this:

You can also use the following advanced options to control DGN exports:

See also
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10 DWG and DXF

DWG is the native file format of AutoCAD and the standard file format for Autodesk
products. DWG is used for 2D and 3D CAD data that is supported by Tekla Structures.

DXF (Drawing eXchange Format) was developed by Autodesk for enabling data
interoperability between AutoCAD and other programs. As the file format does not contain
any form of part ID it is not possible to track changes between different physical objects
contained within different versions of a file. Clash checking is not possible with a DXF file in
Tekla Structures.

In DWG/DXF import Tekla Structures supports ACAD2012 or earlier.

To determine the AutoCAD version of the DWG file, open the file in a text editor. You will
find the version code in the first six bytes:

AC1027 = 2013

AC1024 = 2010, 2011, 2012

AC1021 = 2007, 2008, 2009

AC1018 = 2004, 2005, 2006

AC1015 = 2002, 2000i, 2000

AC1014 = 14

AC1012 = 13

AC1009 = 12, 11

AC1006 = 10

AC1004 = 9

AC1002 = 2

Importing a 2D or 3D DWG or DXF file on page 50

Exporting a model to a 3D DWG or DXF file on page 51

Exporting a drawing to a 2D DWG or DXF file on page 53

See also
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10.1 Importing a 2D or 3D DWG or DXF file

The DWG/DXF import tool imports 2D and 3D models that are in DXF or DWG format. You can
import the file as parts or reference lines.

To import DWG and DXF files:

1. Select File --> Import --> DWG/DXF...

2. Enter the name of the import file. 

Click Browse to browse for the file.

3. Enter the offset from X, Y and Z.

4. Enter the scale.

5. Select how to show the imported parts: 

• Reference lines displays parts in the model using their reference lines in the original
model.

• Parts displays the full profile of parts in the original model, based on the profile sizes
defined in the Beam profile and Plate profile boxes. You can only use metric profiles
with this option.

6. Select Use 2D import to import a two-dimensional representation of the original model. 

This is useful when have selected the Reference line option. Do not select Use 2D
import if you want to import the model in 3D.

7. Click Import.

Tekla Structures imports the file you specified.

When importing DWG profiles, note the following:

• The profile must be the only object in the DWG file. The file should not include any titles,
blocks or any other graphics.

• The profile must be a closed POLYLINE.

• Generating the polylines from an ADSK 3D model requires a number of steps to clean the
profile.

• The profile needs to be scaled up.

• The DWG/DXF files imported with the DWG/DXF tool do not show the surfaces of the
imported objects, only the construction lines or lines converted to part profiles that can
be used to create a model. If you want to show surfaces of the objects, import DWG and
DXF files by inserting them in a Tekla Structures model as a reference model.

Limitations
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10.2 Exporting a model to a 3D DWG or DXF file

You can export models to 3D DWG or 3D DXF file types. By default, Tekla Structures creates a
model.dwg file in the current model folder.

To create a 3D DWG or DXF export file:

1. Open a Tekla Structures model.

2. Select File --> Export --> 3D DWG/DXF... to open the Export 3D DWG/DXF dialog box.

3. Accept the default export file name, or enter another one. 

To replace an already existing export file, click the ... button and browse for the file.

4. Select whether to export as DWG or DXF.

5. In Export as, select the representation for the exported objects: 

• Faces exports parts as faces.

Exporting 3D DWG or DXF files as Faces uses more memory and may take longer, but
the end result is better.

• Lines exports parts as lines located in the center of the profile cross section. Suits
well for exporting to analysis software.

• Center lines exports parts as part center lines.

• Reference lines exports parts as reference lines, drawn between the creation points.
Suits well for exporting to analysis software.

If the model is large, or you have less memory to use, the Reference lines option is
faster, and the resulting file size is smaller.

6. Select the Part accuracy: 

• The options are High and Normal. High also exports chamfers in profile cross-
sections.

7. Select the Bolt accuracy: 

• High exports entire bolt assemblies, including washers.

• Normal only exports the bolt and nut.

• No bolts exports no bolts.

8. Select whether to include Cuts in the export. 

Yes exports cuts, No does not.

9. Select whether to include Inner contours: 

Yes includes the inner contours, No does not.

10. In the Export list, select what to export: 

• All objects exports the whole model.

• Selected objects exports the parts selected from the model.
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11. Click Create.

Tekla Structures creates the export file in the current model folder. The ID of each part is
exported as an attribute and written into the export file for each part.

• Bolt holes are not exported.

• Curved beams and polybeams are exported as single, continuous beams.

• The number of segments in the curved beams is as defined for the particular curved
beam.

Exporting a drawing to a 2D DWG or DXF file on page 53

10.3 Exporting a drawing to a 2D DWG or DXF file

You can export drawings to 2D DWG and DXF files from the Drawing List, using the Export...
command from the pop-up menu, or using the menu commands File --> Export -->
Drawings... and Drawing File --> Export... .

To export Tekla Structures drawings to DXF or DWG format from the Drawing List:

1. Click Drawings & Reports --> Drawing List....

2. Select from the list the drawings that you want to export.

3. Right-click and select Export... from the pop-up menu. 

The Export Drawings dialog box is displayed.

4. On the Export file tab, enter the export file name. 

If you are exporting several drawings, leave the file name box empty.

The drawings are exported by default to the \PlotFiles folder under the current
model folder. If you want to use another folder, enter the full path.

Tekla Structures uses one of the following advanced options to define the names for the
export files: XS_DRAWING_PLOT_FILE_NAME_A, 
XS_DRAWING_PLOT_FILE_NAME_C, XS_DRAWING_PLOT_FILE_NAME_G, 
XS_DRAWING_PLOT_FILE_NAME_W, or XS_DRAWING_PLOT_FILE_NAME_M.
The advanced option that is used depends on the drawing type.

5. Select the file type: DXF or DWG.

6. If you want to include a revision mark in the file name, select Include revision mark to
file name.

7. Set the layer options on the Layer options tab: 

• Select the layer rules file.

To add or modify layers, and to assign object groups to different layers, click Setup.

Limitations

See also
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• If you want to use advanced conversion to convert the type, color and weight of lines
and layers, select Use advanced line type and layer conversion.

• In the Conversion file box, enter the name of the file to be used in the conversion.

By default, Tekla Structures uses the LineTypeMapping.xml file in the ..
\Tekla Structures\<version>\environments\common\inp folder.

If you need to define your own line type mappings, you can use the file
LineTypeMapping.xml as a template when you create a conversion file of your
own.

• Select Include empty layers if you want to include empty layers in the export.

• Select Object color by layer to have different colors on different layers.

8. Set the other drawing export options on the Options tab: 

• Set Drawing scale and Line type scale.

• If you want to export the drawings so that the DWG/DXF content is grouped by
object, select Export objects as groups. When you do this, Tekla Structures makes a
new group for each object (part, mark, dimension line, etc.).

• Select Cut lines with text if you do not want to display continuous lines in exported
drawings, for example, to run the line through text or drawing marks.

• Select Export custom lines as split lines to ensure that custom line types have the
same appearance in the software you are exporting to and when printed. If Export
custom lines as split lines is selected, custom line types are exported as solid lines
that are split to several short lines. If Export custom lines as split lines is not
selected, custom line types are exported as defined in TeklaStructures.lin.

• Select Use paper space to export to both model space and paper space. The unscaled
contents of the drawing views are exported into model space. The drawing layout is
exported into paper space. The layout contains scaled viewports showing appropriate
areas of the model space.

When exporting to paper space, ensure that all objects in the view are inside the
view frame. Objects that are partially outside the drawing view frame are not
exported

9. Click Export.

Default line types in drawings on page 61

Defining customized line type mappings in drawing export on page 58

Example: Setting up layers and exporting to DWG on page 62

Layers in exported drawings on page 55

Creating layers for drawing export on page 55

Assigning objects to export layers on page 56

Copying export layer settings to another project on page 58

See also
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Layers in exported drawings

In drawing DWG/DXF export, you can define the layers to which different drawing objects
belong. The benefit of using layers in export is that if you do not want to show a certain layer
in the drawing, you can turn it off.

You can define the different layers using Tekla Structures selection filters.

You can use the LineTypeMapping.xml file to define the line type, line weight and line
color for objects on different layers. You can also add custom line types in the
TeklaStructures.lin file and use these when mapping Tekla Structures line types to
the line types in the exported DWG and DXF files.

You can export into layers of their own all object types that are listed in the Drawing Export
Layers dialog box.

The following objects cannot have layers in export because they cannot be identified as
separate objects that can have selection filters: clouds, hatches, neighbor parts, symbols in
drawings, section view titles, grid label texts, dimension labels, weld labels, bolt mark leader
lines, and part mark leader lines. For example, hatches are exported to the same layer with
the part that the hatch belongs to.

Example: Setting up layers and exporting to DWG on page 62

Creating layers for drawing export

You need to define the layers that are included in the exported DWG and DXF files.

To keep track on the layers that you have, create all the layers that you need for
the final DWG/DXF drawings at the same time.

To create a layer:

1. In the model, click File --> Export --> Drawings...

2. In the Export Drawings dialog box, go to the Layer options tab and click Setup... next
to the Layer rules box.

3. In the Drawing Export Layers dialog box, click Modify layers....

4. To add a layer, click Add. 

You can add as many layers as you need.

5. Click the row of the new layer in the Name column and enter a name for the layer.

6. Click the row of the new layer in the Color column and select a color for the new layer. 

See also
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7. Click OK.

Next you can assign objects to the new layer.

Assigning objects to export layers on page 56

Displaying catalog and mapping files of converted objects on page 78

Example: Setting up layers and exporting to DWG on page 62

Assigning objects to export layers

You need to define which objects you want to export in a certain layer in the DWG/DXF file.
You can do this by using a selection filter for identifying the desired objects among all
objects, and by creating a rule to export these objects in a certain layer.

Before creating the rule, first create the selection filter.

To create a layer rule and assign objects to an export layer:

1. Click File --> Export --> Drawings... to display the Export Drawings dialog box, and go
to the Layer options tab.

2. Click Setup....

3. Open an object group by clicking the plus sign next to the group name. 

For example, click the plus sign next to Model Object.

4. Right-click a rule in the list and select Add Next Level Rule.... 

For example, right-click Part.

5. Enter a name for the rule and select the related selection filter. 

See also
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6. Click OK.

7. Double-click the row under the rule you just created and select the desired layer for it in
the Select Layer dialog box.

8. Click OK. 

Tekla Structures maps the selected layer to the rule.

9. Save the created layer rule settings for later use by entering a name next to the Save as
button and clicking Save as.

The order of rules is important. Organize the rules by right-clicking the rule, and selecting
Move up or Move down. The objects are exported to the first matching layer. If there is no
matching layer, the objects are exported as Other object type.

Example: Creating a rule for exporting beam marks to their own layer

You can export all kinds of drawing objects to layers of their own. This example shows how
you can do that for beam marks. All kinds of marks can be exported separately to their own
layers: bolt marks, part marks, connection marks, neighbor part marks, reinforcement marks
and component marks.

First you need to create a selection filter selecting the beams and then you can define the
layer rule. Name the beam selection filter Beams.

To export beam marks to their own layers:
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1. Select File --> Export --> Drawings...

2. Go to the Layer options tab of the Export Drawings dialog box and click Setup... next to
the Layer rules box.

3. Under Mark in the Drawing Export Layers dialog box, select the layer rule of the mark
you want to define to its own layer (part, bolt, connection, neighbor part, or
reinforcement mark). 

Select Part mark.

4. Right-click Part mark and select Add Next Level Rule from the pop-up menu. 

This opens the Layer manager rules dialog box.

5. Enter a rule name (for example, BeamMark) and select a filter that you have created
(Beam). 

6. Click OK. 

Tekla Structures creates a new rule BeamMark. Now you can connect the new rule to a
layer you have created for beam marks and use when exporting drawings.

Assigning objects to export layers on page 56

Copying export layer settings to another project

If you want your layer settings to also be available in other projects, you can copy them to a
firm or project folder.

To copy the layer settings to another project:

1. Define the required rule and layer settings in the Drawing Export Layers dialog box
( File --> Export --> Drawings... --> Layer options --> Setup... ).

2. Enter a name for the layer rule settings file next to the Save as button and click Save as.

3. Copy the file <your_layer_rule>.ldb from the \attributes folder under the
current model folder to the firm or project folder.

Assigning objects to export layers on page 56

See also

See also
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Defining customized line type mappings in drawing export

You can use advanced conversion to convert the type, color and weight of lines and layers.
This way you will get the line types that you want to use in the target software, for example,
AutoCAD.

By default, Tekla Structures uses the file LineTypeMapping.xml in the folder ..
\Tekla Structures\<version>\environments\common\inp for the
conversion.

If you need to define your own line type mappings, you can use the file
LineTypeMapping.xml as a template.

When modifying the line type mappings file, use an editor that is capable of
validating XML in order to maintain a valid document structure.

To define your own line type mappings, do one of the following:

To Do this
Map according to line types
only

1. Open the mapping file in an XML editor.

2. Enter only the line type information.

For example, all lines in all layers with line type 
XKITLINE01 will be exported to DASHED.

3. Save the mapping file to the model folder.

Map according to line types
and layers

1. Open the mapping file in an XML editor.

2. Enter the line type and layer name.

Define the layers that the mapping will apply to in the 
LayerName attribute.

If you leave out the attribute LayerName, Tekla
Structures uses the line type mapping for any layer. If you
include the attribute LayerName, Tekla Structures uses
the line type mapping for that layer only.

For example, all lines on the layer BEAM with line type 
XKITLINE01 will be exported to DASHED. Tekla
Structures first searches for these kinds of mappings by
default.

3. Define the color of the line in the Color attribute. Enter
the color values in AutoCAD Color Index (ACI) codes
(numbers from 0 to 255).

4. Define the thickness of the line in the Weight attribute.
Enter the values in hundredths of millimeters.

5. Save the mapping file to the model folder.
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This is how the file LineTypeMapping.xml is composed:

The first section consists of XML and document type definition. Do not change
or remove this section.

The mappings that are available are defined here. You can use these mappings
as a template for your own mappings.
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In the first example, a new Mapping element is added, where XKITLINE00 lines in the 
Beam layer are converted to BORDER line type, color is converted to 10 and weight to 
1.00 mm:

In the second example, a new Mapping element is added, where XKITLINE02 lines in the 
Part layer are converted to HIDDEN2 line type, the layer name is converted to 
Part_Hidden, the color is converted to 8 and weight to 1.00 mm.

You can use the LineTypeMapping.xml file for exporting hidden lines to separate
layers. The hidden lines must then be defined to their own layers (here Part_Hidden).

For the export to succeed, ensure that the layer (here Part_Hidden) exists on
the list of available layers in the Modify Layers dialog box.

Default line types in drawings on page 61

Default line types in drawings
Default line types are available in Tekla Structures drawings. You can map default line types
to customized line types, which are defined in TeklaStructures.lin and further
exported to DWG/DXF files.

The table below describes which line type name corresponds to which line type appearance.

Line type name Line type appearance
XKITLINE00
XKITLINE01
XKITLINE02
XKITLINE03
XKITLINE04
XKITLINE05
XKITLINE06

Defining customized line type mappings in drawing export on page 58

Examples

See also

See also
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Example: Setting up layers and exporting to DWG
This example shows how to define layers and export line types on a certain layer to their own
sublayers in DWG export. The workflow consists of six tasks:

1. Example: Creating a selection filter for DWG export on page 62

2. Example: Creating layers for DWG export on page 63

3. Example: Creating a rule for DWG export on page 63

4. Example: Defining a custom line type for DWG export on page 64

5. Example: Defining line types and weights for layers in DWG export on page 65

6. Example: Exporting the drawing on page 67

Example: Creating a selection filter for DWG export

Start by creating a selection filter. This task is phase 1 in the workflow Example: Setting up
layers and exporting to DWG on page 62.

To create a selection filter:

1. In the model, click Edit --> Selection Filter... to open the Object Group - Selection
Filter dialog box.

2. Click New filter.

3. Add new filter rules.

a. Create a filter rule that select parts according to the name BEAM.

b. Create a filter rule that selects parts according to the material S* (as in steel).

4. Save the filter as steel-beam.
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Example: Creating layers for DWG export

After creating a selection filter, you can continue by creating layers that you want to have in
the exported DWG. This task is phase 2 in the workflow Example: Setting up layers and
exporting to DWG on page 62.

To create the layers you want to have in the exported DWG:

1. Click File --> Export --> Drawings and go to the Layer options tab.

2. Click Setup... and Modify layers.

3. Click Add to add a new layer. 

Create separate layers for solid lines (steel-beam-layer) and hidden lines
(steel-beam-layer-H) within steel beams.

4. Set the color for the layers. 

Set the solid lines to red and hidden lines to blue.

5. Click OK to accept the changes.
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Example: Creating a rule for DWG export

After creating layers, you can continue by creating a rule to export an object group into a
layer, and assign the layer to the created rule. This task is phase 3 in the workflow Example:
Setting up layers and exporting to DWG on page 62.

To create a rule to export an object group into a layer, and assign the layer to the created
rule:

1. Right-click a model object part rule and select Add Next Level Rule.

2. Enter a name for the rule (steel-beam-rule) and select the selection filter you
created for steel beams (steel-beam). 

3. Click OK.

4. To assign a layer to a rule, double-click the row under the steel-beam-rule and
select a layer, in this case steel-beam-layer.

5. Click OK. 

6. Save the layer rule settings with the name example1 using Save as. 

7. Close the dialog box by clicking OK.
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Example: Defining a custom line type for DWG export

After creating a rule, you can continue by defining a custom line type for continuous lines in
the exported DWG. In this example, there is no need to delete the existing line types. This is
phase 4 in the workflow Example: Setting up layers and exporting to DWG on page 62.

To define a custom line type:

1. Open the TeklaStructures.lin file in a text editor ( ..\ProgramData
\Tekla Structures\<version>\environments\common\inp ).

2. Add the following line type definition in the file: 

3. Save the file. Ensure that the file name extension does not change.

Example: Defining line types and weights for layers in DWG export

After defining a custom line type, you can continue by modifying the
LineTypeMapping.xml file and defining the line types and weights. This task is phase 5
in the workflow Example: Setting up layers and exporting to DWG on page 62.

To define the line types and weights:

1. Open the LineTypeMapping.xml file ( ..\ProgramData\Tekla
Structures\<version>\environments\common\inp ) in a text editor.

2. Add the line type mappings for the layers as shown inside the lower blue frame in the
image below. Do not touch the lines inside the upper red frame.

3. Save the file. Ensure that the file name extension does not change.
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The lines are on the steel-beam-layer layer.

The lines are drawn with XKITLINE00 (solid lines).

The lines are exported to CONTINUOUS lines in DWG. The line
color in DWG was already defined in the layer properties (red). The
line weight in DWG is 35.

The lines are on the steel-beam-layer layer.

The lines are drawn with XKITLINE02 (hidden lines).

The lines are exported to DASHED lines into a separate layer
called steel-beam-layer-H in DWG. The line color in DWG
was already defined in the layer properties (blue). The line weight
in DWG is 35.
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Example: Exporting the drawing

After you have defined all the layer settings, you can continue by exporting the drawing.
Before exporting the drawing, make sure that all the drawing properties are as you wish. This
task is phase 6 in the workflow Example: Setting up layers and exporting to DWG on page 62.

To export the drawing:

1. Open the drawing that you want to export.

2. Click Drawing File --> Export… to open the Export Drawings dialog box.

3. Enter a name for the file.

4. Set the Type to DWG.

5. Go to the Layer options tab page and load the layer rule settings that you saved earlier
with the name example1.

6. Select the following check boxes: Use advanced line type and layer conversion, Include
empty layers and Object color by layer.

7. Browse for the LineTypeMapping.xml file.

8. Go to the Options tab, set the scale for the export and select the Export objects as
groups check box and, if you want to, Cut lines with text and Export custom lines as
split lines.

9. Click Export.

Open the exported DWG with an applicable DWG viewer software. You can see that the solid
lines of the steel beam are on one layer and the hidden lines are on another layer. You can
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also see that columns do not match with the layer rules you defined, so they are handled
according to other rules.

Below are examples of how the selecting and not selecting Cut lines with text affects the
result.

In the following example, Cut lines with text is selected.

In the following example, Cut lines with text is not selected.
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11 S-Frame

The international version of the S-Frame analysis and design system is written by S-FRAME
Software Inc. Full product details can be found on their website. The product name is being
changed from S-Frame to S-Calc.

• S-Frame can export and import .dxf files. If Tekla Structures and S-Frame are installed
on the same computer, then a direct link can be used. A copy of the link can be requested
from S-FRAME Software Inc. Descriptions regarding the link can be found here: Building
information modeling (BIM) links.

• In some areas S-Frame used to be distributed by CSC, in which case the installation
points to different folders. The model name must not include spaces as this currently is
an issue as the analysis and design frame is not created if spaces are included.

11.1 The process of importing to and exporting from S-Frame

The Tekla API link allows you to write code to connect to an open model in Tekla and query or
manipulate the model. The link was established by using both the S-Frame and Tekla APIs. It
uses a library database to manage items between Tekla Structures and S-Frame.

A copy of the link and instructions on using the link can be requested from S-Frame Software
Inc.

The whole process involves the following steps: importing to S-Frame, displaying imported
items, and exporting from S-Frame. This process is described below.

Importing objects to S-Frame and displaying the objects

1. The S-Frame software checks to see if there is an open model in Tekla Structures using
the Tekla API.

2. If a connection can be established, the Tekla Structures model is queried for a list of
model objects, such as modeled members or panels.

3. The returned objects are iterated through, recognized types are processed, and equivalent
S-Frame objects are added or updated to a library database.

4. The IDs from Tekla Structures are stored so that items can be mapped back and forth
between Tekla Structures and S-Frame.
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5. Once the objects have been iterated through, the library database is queried, and the
updated or created objects referenced in the library are displayed in S-Frame display
window.

Exporting from S-Frame

1. The S-Frame is queried for objects that are displayed in the S-Frame display window.

2. The library is iterated through for types of known objects (members and panels) that can
be mapped back and forth between Tekla Structures and S-Frame.

3. Using the unique IDs stored in the import, the Tekla Structures model is queried to see if
items exist. If they do not, they will need to be created, and the library will be updated.

4. Items can then be added or updated to Tekla Structures to match what is in S-Frame.
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12 IFC

IFC stands for Industry Foundation Classes, the set of internationally standardized object
definitions for use in the construction industry. IFC is developed as an open standard by
buildingSMART.

IFC offers a high-level common language for the sharing of intelligent objects, such as
building elements, between disciplines across the building life cycle. The principal benefit of
IFC is the object description – not only does the IFC protocol preserve the full geometric
description in 3D, but it also knows its location and relationships, as well as all the properties
(or parameters) of each object.

IFC import on page 72

IFC export on page 83

12.1 IFC import
You can import IFC models as reference models to Tekla Structures. You can use imported IFC
models, for example, in clash checking, reporting and scheduling. You can convert imported
IFC objects into native Tekla Structures objects by using IFC object converter.

Tekla Structures supports the following IFC schemas:

• IFC2X2

• IFC2X3 (recommended)

The IFC import functionality has the IFC certification granted by buildingSMART international
http://www.buildingsmart.org/compliance/certified-software/.

See also
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The IFC import functionality in Tekla Structures supports all the sub-objects of the
IfcBuildingElement class and sub-objects of the IfcProduct class including:

• Architectural entities

• Structural entities

• Building services entities

IFC (.ifc) and ifcXML (.ifcXML) formats are supported. You can use compressed
(.ifcZIP) or uncompressed import files.

Inserting a reference model on page 33

Inserting a reference model on page 33

IFC object converter on page 73

IFC object converter
You can convert most linear IFC objects such as beams, columns, and braces into native Tekla
Structures objects. Also plates, slabs, footings and walls can be converted.

The purpose of converting IFC objects in Tekla Structures is to help in the creation of the
structural model and to avoid rework in an early modeling phase. For example, use an
architectural model as a basis for the structural model and for further detailing. If the
architect modifies the architectural model later, you cannot merge the changes between the
models.

In Tekla Structures reference model objects can be used in a way similar to the native
objects, for example, in clash detection, reporting and scheduling. There is no need to have
everything as native, because the reference model objects can also be used in many ways. For
example, reference model objects can be shown in drawings and they can be listed in reports
beside the data of native objects.

Converting IFC objects into native Tekla Structures objects on page 74

Limitations in IFC object conversion on page 75

Defining the settings for profile mapping of IFC objects on page 75

See also

See also
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Checking the profile and material of converted objects on page 76

Copying IFC object properties to the user-defined attributes of converted objects on page
77

Displaying catalog and mapping files of converted objects on page 78

Creating reports of converted IFC objects on page 78

Converting IFC objects into native Tekla Structures objects
Before converting IFC objects, check that the profiles and units in the IFC model are
compatible with the environment you are using.

To convert IFC objects into native Tekla Structures objects:

1. Select the IFC objects you want to convert. 

Ensure that the Select objects in assemblies or Select objects in components switch is
active when selecting the objects.

2. Click Tools --> Convert IFC objects .

3. Click Settings to open the IFC object converter settings dialog box.

4. Define the settings for conversion as required. 

• To create a report of the converted IFC objects automatically after the conversion,
select Create report after conversion.

• To convert B-rep objects into Tekla Structures objects, select Convert Brep object.

After conversion B-rep objects are either items or concrete items and they are added
to the shape catalog. The items belong to class 996.

• To set the reference lines of beams to top flange, select Set handles to top flange.

If Set handles to top flange is not selected, the reference lines of beams are located
in the middle of the beams.

• Define the settings for profile mapping.

See Defining the settings for profile mapping of IFC objects on page 75 to find out
more.

• If needed, copy properties from an IFC object property set.

See Copying IFC object properties to the user-defined attributes of c on page 77 to
find out more.

5. Click Check to check the profile and material of the objects that you want to convert. 

See Checking the profile and material of converted objects on page 76 to find out
more.

6. Click OK in the IFC object converter settings dialog box.

7. Click Convert.
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Tekla Structures creates native Tekla Structures objects. The Conversion Result Summary is
displayed in the Convert IFC objects dialog box showing the conversion result and possible
errors.

The original IFC reference model objects are also kept as such. We recommend that you
always check the results of the conversion, for example, by viewing the conversion report.

Limitations in IFC object conversion on page 75

Creating reports of converted IFC objects on page 78

Example: Converting IFC objects into Tekla Structures objects on page 80

Limitations in IFC object conversion

Tekla Structures is dependent on the quality of the IFC model, because it uses information
available in the model when converting objects.

Tekla Structures converts most linear IFC objects. The following limitations exist in IFC object
conversion:

• If the target IFC model does not comply with standard, it might not be converted as
expected.

• Only IFCBuildingElement and IFCDiscreteAccessory and their sub types are supported.

• Only SweptSolid, Brep, CSG and Clipping representations are supported.

• Multiple representations for one object are not supported.

• Profile offset is not supported.

• Profiles with more than 99 polygon points are not converted correctly.

• In rare cases, chamfers may be converted incorrectly.

Converting IFC objects into native Tekla Structures objects on page 74

Creating reports of converted IFC objects on page 78

Defining the settings for profile mapping of IFC objects

Tekla Structures checks IFC object profiles against the profiles in the Tekla Structures profile
catalog by comparing profile names or dimensions. You can choose which of the two
methods is primarily used in mapping.

You can define profile mapping settings for parametric and arbitrary profiles.

To define profile mapping settings:

1. Click Tools --> Convert IFC objects --> Settings to open the IFC object converter
settings dialog box.

2. Do one of the following: 

See also

See also
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• To map profiles primarily by comparing the profile names between the IFC model and
Tekla Structures profile catalog, select Profile name in the Primary profile mapping
area.

• To map profiles primarily by comparing the object dimensions, select Dimensions in
the Primary profile mapping area.

If IFC object converter cannot map profiles with the primary method, it applies the
secondary method.

3. If needed, enter tolerance values for dimension comparison. The unit of measurement is
based on the environment. 

The r value affects only rectangular hollow profiles and it is used to distinguish hot rolled
profiles from cold rolled profiles.

4. Click OK.

Parametric profile used in IFC model (Full data set):

1. If profile with same name is found from Tekla Structures Profile Catalog, it will be used.

2. Otherwise, Tekla Structures checks parameter values to find a corresponding profile. If
found, that will be used.

Arbitrary profile used in IFC model (Limited amount of data):

1. If the object is not a linear member, an object with profile will be created.

2. If the shape is detected and found from Tekla Structures catalog, that profile will be
used. The shape detection supports the standard types of hot rolled profiles.

3. Otherwise, a new profile is created.

B-rep geometry used in IFC model (Shape data only):

1. If corresponding item exits in Tekla Structures model, it is used.

2. Otherwise, a new item will be created and used.

Conversion logic
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Checking the profile and material of converted objects

Before you convert IFC objects into native Tekla Structures objects, you can check their
profile and material to ensure that the conversion will be successful.

IFC object converter checks the profile information for the boundary representation (B-rep)
geometry only.

To check the profile and material of converted objects:

1. Click Tools --> Convert IFC objects --> Settings --> Check. 

If there are any missing profiles or materials, Tekla Structures displays them on the
Missing Profiles and Missing Materials tabs in the Missing Mapping dialog box.

2. Select an appropriate option in the Tekla Structures profile and Tekla Structures material
lists to define a mapping for the missing profiles or materials. 

The mapping of profiles works for IFC data that has a profile name but does not include
enough information for conversion.

You can change your mappings later if needed.

3. Click Update Mapping Catalogs and Close.

You can also map profiles and materials by modifying the .txt files in any standard text
editor. The files are in the attributes folder under the model folder. The changes take
effect when you restart IFC object converter.

MappedMaterials-default.txt maps the materials and MappedProfiles-
default.txt maps the profiles. The maps are used in conversion only if the profiles are
not found from Tekla Structures catalogs.

Copying IFC object properties to the user-defined attributes of
converted objects
You can copy properties from the IFC object property sets to the user-defined attributes of
converted Tekla Structures objects.

To copy properties from an IFC object property set:

1. Go to Tools --> Convert IFC objects .

2. Click Settings. 

The IFC object converter settings dialog box opens.

3. Click Add to add rows.

4. Enter the name of the property to the Property cell.

5. Enter the name of the user-defined attribute to the UDA cell. 

The maximum length of the user-defined attribute name is 20 characters.
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6. Click Type to select the format of the attribute. 

The possible formats are string, integer or double.

7. Click OK to save the settings.

If you have selected the Create report after conversion check box, a report is created after
the conversion based on the converted objects.

When you add the user-defined attribute to the objects.inp file, ensure that the
attribute name is unique.

Enter the original name of the user-defined attribute, not the translation.

Displaying catalog and mapping files of converted objects
You can display the catalog and mapping files of converted objects in the .txt format.
When you do this, you can also modify the .txt files and, for example, add more profiles in
the catalogs manually if needed.

To display the catalog and mapping files of converted objects:

• Click Tools --> Convert IFC objects --> Settings --> Catalogs . 

Tekla Structures opens the profile and material catalogs and mapping files for profiles
and catalogs in .txt format. The files are available in the attributes subfolder of
the model folder.

Creating reports of converted IFC objects
You can create reports of the IFC objects that have been converted into native Tekla
Structures objects.

To create a report of the converted IFC objects, click Report in the Convert IFC objects
dialog box.

Tekla Structures creates a report of the converted IFC objects automatically after
the conversion when you have selected the check box next to the Create report
after conversion option in the IFC object convertor settings dialog box.

When you select an item in the report, the related object is selected in the model.

See also

See also
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The created report is in IFC-converted.txt in the Report folder under the model
folder.

If you need to modify the report template, modify IFC-converted.rpt in the ...
\environments\common\system\Mark folder.

Sometimes the input data in the IFC model is not adequate to successfully create the
converted object. The status of the converted object is reported in the Info box in the report
with the Class value.

Class value IFC object data Converted object description
990 Parametric profile with a name There is enough information in the IFC model

to convert the object successfully.

991 Parametric profile without a
name

Tekla Structures determines the name of the
object based on the object’s profile.

992 Arbitrary profile with a name The profile of the converted object may be
incorrectly rotated because there is no
parametrized profile data in the IFC model.

993 Arbitrary profile without a name The profile of the converted object may be
incorrectly rotated because there is no
parametrized profile data in the IFC model.

The profile name is set to UNKNOWN.
994 Brep piece with a name The profile may be an extrema box due to the

lack of profile data in the IFC model.

995 Brep piece without a name The profile may be an extrema box due to the
lack of profile data in the IFC model

The profile name is set to UNKNOWN.
996 Brep piece The object is converted using the Convert

Brep object option in converter settings.

The converted Brep object is either an item or
a concrete item and is added to the shape
catalog.

Below is a report of converted parts.

Limitations

Example
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Example: Converting IFC objects into Tekla Structures objects

In this example, you use an IFC model as a basis for your structural model. You will convert
the beams and columns into native Tekla Structures objects.

To convert the IFC model’s beams and columns into native Tekla Structures objects:

1. Hide irrelevant IFC layers.

a. Click the Reference Models icon.

See also
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b. In the Reference Models list, double-click the reference model to open the details.

c. Open the Layers list by clicking the down arrow on the right.

d. Hide the necessary layers by clicking the eye icon next to the layer. 

Tekla Structures shows only the layers you selected to show.

2. Select all visible IFC objects.

3. Click Tools --> Convert IFC objects . 

The Convert IFC objects dialog box opens.

4. Check the profiles and materials of the IFC objects.

a. Click Settings.

b. Click Check. 

Tekla Structures lists the missing profiles and materials.
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c. View the Missing Profiles and Missing Materials tabs. 

Tekla Structures lists a missing reference part material Concrete Block.

d. Select CONCRETE_UNDEFINED from the list. 

e. Click Update Mapping Catalogs and Close.

a. Click OK in the IFC object converter settings dialog box.

5. Click Convert. 

Tekla Structures converts the objects and opens the conversion report.

The Class for all the converted objects is 992. That means that the profile of the
converted object may be incorrectly rotated because there is no parametrized profile data
in the IFC model.

6. Check the conversion results. 

• Read the conversion report. Select objects in the conversion report to highlight them
in the model.

• Compare the converted objects with the IFC objects.

• Use the Inquire object command to view detailed information on objects.
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Below is an image of converted beams and columns.

Converting IFC objects into native Tekla Structures objects on page 74

12.2 IFC export
You can export Tekla Structures models as IFC models.

You can export all basic parts in the Tekla Structures model such as beams, columns, braces,
slabs, panels, plates, reinforcing bars, and bolts with nuts and washers.

The IFC export functionality in Tekla Structures supports the IFC2X3 schema. The IFC export
functionality has the IFC certification granted by buildingSMART international http://
www.buildingsmart.org/compliance/certified-software/.

See also
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IFC (.ifc) and ifcXML (.ifcXML) formats are supported. You can use compressed
(.ifcZIP) or uncompressed import files.

Defining the IFC entity for the exported model objects on page 85

Exporting a Tekla Structures model into an IFC file on page 86

Checking the exported IFC model on page 88

IFC Export type settings on page 88

IFC base quantities on page 89

Tekla Structures model objects and related IFC entities on page 89

Color of the exported IFC objects on page 90

Property sets in IFC export on page 91

Defining additional property sets using the Property Set Definitions tool on page 92

Property set configuration in XML on page 94

Defining the IFC data for the exported model on a project level
Before you export your model, you can define geographic coordinates and default spatial
hierarchy for the resulting IFC model.

To define the IFC data for the exported model on a project level:

1. Click File --> Project Properties...

2. Enter a name for the project if needed. 

The project name is the IFC project name in the exported IFC model.

3. Click User-defined attributes... in the Project Properties dialog box.

See also
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4. On the IFC export tab, enter values for spatial hierarchy in IFC site name, IFC building
name and IFC building storey name as needed. 

The spatial hierarchy entered in the Project’s user-defined attributes is default for model
objects in the project. You can enter specific IFC building name and IFC building storey
name values for model objects in the objects’ user-defined attributes.

5. On the Geo coordinates tab, enter values for geographic coordinates as needed.

6. Click OK.

7. Click OK.

Defining the IFC entity for the exported model objects on page 85

Exporting a Tekla Structures model into an IFC file on page 86

Defining the IFC entity for the exported model objects

Before you export Tekla Structures model objects, you can define the resulting IFC entities for
the exported model objects by using user-defined attributes.

To define IFC entities for exported model objects:

1. Double-click an object, for example a column, to open the part properties dialog box, and
click the User-defined attributes button.

2. On the Parameters tab, set Load bearing to Yes, if you want to define the user-defined
attribute LOAD_BEARING for the exported object. 

Yes is the default value. Set this option to No for all non-load bearing objects.

3. On the IFC export tab, select an option in the IFC entity list to define the IFC entity for
the exported model object. 

Below is an example list for entities available for a column:

For more information on how Tekla Structures model objects are mapped as IFC entities,
click the corresponding link in the See also list below.

See also
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4. Select Auto or Brep in the IFC export type list. 

If the object is exported incorrectly with the Auto option, select Brep instead, and export
again.

5. Enter names in the IFC building name and IFC building storey name text boxes to
define the spatial structure in the IFC model, if needed.

6. Click the OK button in the user-defined attributes dialog box.

7. Click the OK button in the part properties dialog box.

Tekla Structures model objects and related IFC entities on page 89

Defining the IFC data for the exported model on a project level on page 84

Exporting a Tekla Structures model into an IFC file

Before you start:

• Define the IFC entities for the Tekla Structures model objects. For more information, see
Defining the IFC entity for the exported model objects on page 85.

• Ensure that the work plane is in the desired location. Tekla Structures exports the IFC file
using the work plane origin. For more information, see Changing the coordinate system
of the exported IFC file on page 87.

To export a Tekla Structures model into an IFC file:

1. Select the model objects to export. 

If you want to export all, you do not have to select anything.

2. Click File > Export > IFC.

3. Browse for the Output file location and replace the name out with the desired file
name. 

IFC files are by default exported to the \IFC folder under the model folder. The length of
the file path is limited to 80 characters. You do not need to enter the file name
extension, it will be automatically added according to the File format.

4. Select the File format. 

The formats are IFC, IFC XML, zipped IFC, and zipped IFC XML.

5. Select the Export type. 

• Surface geometry is ideal for design coordination and viewer type of use.

• Coordination view 2.0 is recommended for software that has the Coordination view
2.0 import certificate, and for Tekla BIMsight when your model contains
reinforcement.

• Steel fabrication view is recommended for exporting detailed information on steel
objects for steel fabrication.

See also
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• For more information about the export types, see IFC Export type settings on page
88.

6. You can define additional property sets for IFC export: 

• To define a new property set, select <new> and click Edit.

• To use an additional property set created earlier, select the property set from the
Additional property sets list.

For more information about the additional property sets, see Defining additional
property sets using the Property Set Definitions tool on page 92.

7. Select either Selected objects or All objects to define the object selection for the export.

8. On the Advanced tab, select Assemblies, Bolts, Welds, Pour Objects, Reinforcing bars,
Surface treatments and Grids in the Object types area to export the corresponding
objects. 

When you select Pour Objects, cast in place concrete parts are exported as pour objects.

When you export Assemblies, you can exclude single part assemblies by selecting
Exclude single part assemblies.

9. Select Base quantities to include in the exported IFC model a Quantity takeoff add-on
view containing additional information on the entities in the exported IFC model. 

For more information bout the base quantities, see IFC base quantities on page 89.

10. Select either Property sets: Default or Property sets: Minimum. 

The option Minimum exports the minimum set of properties required by the
buildingSMART IFC standard. You can view the property sets by clicking View.

11. Select Layer names as part names to use part names, such as COLUMN and BEAM, as
layer names for exported objects. 

You can define part names in part properties.

12. Select Export flat and wide beams as plates to export flat and wide beams as plates. 

Select this if you have modeled plates as beams or columns with flat profiles. For
example, some system components use beams or columns instead of plates.

13. Select Use current view colors to export the objects using the colors defined in Object
Representation, not the class colors.

14. Click Export.

Changing the coordinate system of the exported IFC file

If you want to export the IFC file with another coordinate system than the 0,0,0 in Tekla
Structures, you can move the work plane and the IFC file will use that as the 0,0,0 for
localization.

1. Set the work plane to the desired location.

2. Export the IFC file.
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3. Click Export anyway in the warning message box that is displayed.

The exported IFC model now has the origin set according to the work plane. For more
information, see Export IFC model to project coordinates.

Exporting a Tekla Structures model into an IFC file on page 86

Checking the exported IFC model

To check the exported IFC model, insert the model as reference model to the original Tekla
Structures model.

Check the following things:

• Check the IFC model visually. Use different colors for the IFC model and the original
model. Use clip planes to check the model thoroughly.

• Compare the number of objects. If there are differences, check the export log.

• Check the modeling of unsuccessfully exported objects. For example, unnecessary cuts
may result in unsuccessful export. Consider remodeling the incorrect objects or set IFC
export type to Brep for the objects.

You can use Tekla BIMsight for viewing and checking the IFC model.

Defining the IFC entity for the exported model objects on page 85

Tekla BIMsight on page 244

IFC Export type settings

See the Export type settings below.

The Coordination view 2.0 settings are the following:

• Reinforcing bars as extrusion

• CSG support on

• Curved elements as RevolvedAreaSolid

• Bolts as B-rep

The Surface Geometry settings are the following:

• Reinforcing bars as B-rep

• No CSG

• Curved elements as B-rep

See also

See also
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• Bolts as B-rep

The Steel fabrication view settings are the following:

• Assembly presentation and base quantities

• Welds as IfcFastener

• Finish of the total piece as IfcCovering

• Vertical braces as IfcMember

• Bolt holes as voids

IFC base quantities

Additional Quantity takeoff add-on view is included to the exported IFC model if you set
Base quantities to Yes in the Tekla Structures IFC Export dialog box.

The Quantity takeoff add-on view contains the following information on the entities in the
exported IFC model:

 Beam Column Slab Wall
Width X X

Height X

Length X X X

Net area X

Outer surface area X X

Gross footprint area X

Net volume X X X X

Net weight X X X X

Tekla Structures model objects and related IFC entities

Tekla Structures maps model objects automatically as IFC entities when you export a model
into an IFC file. You can also map objects manually in user-defined attributes of objects.

The following table lists Tekla Structures model objects and the recommended related IFC
entities.

Tekla Structures object IFC entity
Beam IfcBeam, IfcMember

Column, Pile IfcColumn, IfcPile, IfcMember

Polybeam IfcBeam, IfcMember
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Tekla Structures object IFC entity
Curved beam IfcBeam, IfcMember

Pad footing, Strip footing IfcFooting

Slab IfcSlab

Panel IfcWall or IfcWallStandardCase

Contour plate IfcPlate, IfcDiscreteAccessory

Bolts, nuts and washers IfcMechanicalFastener

Bolt holes IfcOpeningElement

Vertical braces IfcMember

Railings IfcRailing

Assemblies, cast units IfcElementAssembly, IfcRailing, IfcRamp,
IfcRoof, IfcStair

Assembly sub-parts IfcDiscreteAccessory

Reinforcements IfcReinforcingBar

Pour objects IfcBuildingElementProxy

Surface treatment IfcCovering

Welds IfcFastener

IfcBuildingElementPart entity can also be used. IfcBuildingElement matches
beams, columns, etc., but not assemblies.

Polybeams are always exported as Brep.

Defining the IFC entity for the exported model objects on page 85

Color of the exported IFC objects

The setting Use current view colors on the Advanced tab of the Export to IFC dialog box
defines which colors are used in the exported IFC objects:

• If you select Use current view colors, the exported objects have the colors that you have
defined using color and transparency settings of Object groups defined in the Object
Representation dialog box.

• If you do not select Use current view colors, the exported objects use the color of the
classes set for the objects in the properties dialog box.

The classes have the following colors:

Class Color
1 light gray

See also
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Class Color
2 or 0 red

3 green

4 blue

5 turquoise

6 yellow

7 magenta

8 gray

9 rose

10 lime

11 aqua

12 pink

13 orange

14 light blue

Property sets in IFC export
Tekla Structures uses configuration files for defining which user-defined attributes and
template attributes are exported as property sets into IFC models. When you export to IFC,
you select one predefined configuration file as Export type that you use as a main property
set. In addition, you can define your own property set to add additional information to
exported IFC models.

The predefined configuration files are read-only and they are located in ..\ProgramData
\Tekla Structures\<version>\Environments\Common\inp.

• IfcPropertySetConfigurations_CV2.xml (Default property sets)/
IfcPropertySetConfigurations_CV2_1.xml (Minimum property sets)
contains the property sets for Export type Coordination view 2.0.

• IfcPropertySetConfigurations_SG.xml (Default property sets)/
IfcPropertySetConfigurations_CV2_1.xml (Minimum property sets)
contains the property sets for Export type Surface geometry.

• IfcPropertySetConfigurations_AISC.xml (Default property sets)/
IfcPropertySetConfigurations_AISC_1.xml (Minimum property sets)
contains the property sets for Export type Steel fabrication view.

The IfcPropertySetConfigurations_CV1.xsd file in the same folder is a
schema file that describes the structure of the XML file and is used for validation of the XML
file. This file is read when the software is started.
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The additional property sets you create using the Property Set Definitions tool are saved to
the \AdditionalPSets folder under the model folder by default. You can also read
additional property sets from the following folders:

• XS_SYSTEM
• XS_PROJECT
• XS_FIRM
If you use the above mentioned folders, please save the files in a folder called
\AdditionalPSets under the system, project or firm folder.

Defining additional property sets using the Property Set Definitions tool on page 92

Property set configuration in XML on page 94

Defining additional property sets using the Property Set Definitions tool

You can create additional property sets out of template attributes and user-defined
attributes, define property definitions for the attributes, and bind the property sets to IFC
entities for IFC export using the Property Set Definitions tool. Tekla Structures saves
additional property sets in configuration files. You can keep several configuration files in
several locations.

To create property sets, property definitions and bindings:

1. Select File --> Export --> IFC .

2. Select <new> in the Additional property sets list and click Edit. 

The Property Set Definitions dialog box opens.

3. Enter a name for the configuration file in the Name text box.

4. Enter a name for the property set next to the New button and click New. 

You can create several property sets in a configuration file.

5. Select the entity type you want to use in the Select entity types list. 

The Select attributes list shows the attributes that can be used for the selected entity
type and added to the current property set.

6. Add the desired attributes by selecting the check boxes next to the attribute names. 

The attribute is added to the List of all selected properties list on the right. This list
shows which attributes are exported and in which format:

• You can add new attributes by entering an attribute name in the Attribute box in
the Create/Modify property area and clicking the Add button.

• You can modify and remove attributes on the list by selecting the attributes on the
list and clicking Modify or Remove.

See also
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7. In Create/Modify property, you can select Property type for the selected attribute. 

Select Template attribute for user-defined attributes whose name contains more than
19 characters. For example, select Template attribute for 
ASSEMBLY.USERDEFINED.PLANS_STATUS.

8. In Create/Modify property, you can give a new Name for the selected attribute, and
select the Type of the attribute. The Type can be one of the following: String, Boolean,
Integer, Measurement, Real, or Time stamp.

9. If the type of the user-defined attribute is Measurement, you can select the
Measurement type: Length, Area, Volume, Mass, Positive length or Count.

10. If the type of the user-defined attribute is Measurement, you can also select the
Conversion factor and Accuracy. 

User-definable accuracy allows better IFC file size optimization.

11. Click Save to save your modifications.

You can later modify your property set by selecting the property set from the Additional
property sets list in the Export to IFC dialog box and clicking Edit.

Below is an example of the contents of the Property Set Definitions dialog box.Example
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Property set configuration in XML on page 94

Property set configuration in XML
We recommend you use the Property Set Definition tool for creating additional property
sets to ensure that the XML configuration files are valid.

A configuration file

• Includes the structure of property sets, and the data definitions for the properties inside
the property sets:

• Template attribute or UDA name. Template attributes are read from
content_attributes_global.lst and the user-defined attributes from the
environment database.

• Data type, such as String, Integer, Float, Timestamp, Boolean, Logical, or
planeanglemeasure.

See also
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• Unit type, such as length, area, volume, or mass.

• Unit value scaling of unitless UDA values. Conversion factor is added so that unitless
values can be converted to correspond to the global units used in the IFC files. Area
and volume units need these factors.

• Possibility to use default values.

• Possibility to ignore the set to export if template attribute or UDA does not have a
value.

• Includes property set binding rules to IFC entities:

• Binding to IFC entity type hierarchy including support for not only building elements
but also for bolts, reinforcing bars, and assemblies.

• Possibility to use limiting rules, such as Equal, NotEqual, LessThan, GreaterThan,
LessThanOrEqual, and GreaterThanOrEqual for numbers, and Equal and NotEqual for
texts.

You need to modify your additional property set configuration file using a suitable
editor, if you want to add these limiting rules.

• There can be any number of binding rules for any property set, but only one property
set definition for each ReferenceId.

• You can bind different property sets to different IFC entity types. For example, a plate
may have a different property set than a beam.

• If no value is found for a property in export, the export does not write the property set at
all. To avoid this, add optional=true for that property in the property set.

Below is an example of the contents of the
IfcPropertySetConfigurations_CV2.xml file.

Example
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13 CAD

Computer-aided design (CAD) means that you can create, modify, analyze, and optimize a
design using software. CAD software applications are available for generic design or
specialized use, such as for architectural or plant design. More complex forms of CAD are
solid modeling and parametric modeling, which allow objects to be created with real-world
characteristics. In parametric modeling, objects have meaningful relationships with each
other.

In Tekla Structures, the CAD import tool supports several different formats to import models,
and is able to import a maximum of 10,000 parts. If the number of parts exceeds this, Tekla
Structures displays a warning message, and does not import the model.

Conversion files on page 28

CAD model import settings on page 103

CAD model export settings on page 108

13.1 CAD import and export formats

You can import to and export from Tekla Structures the following file types using the CAD
import tool.

Option Import Export Imports from/Exports to
SDNF x x SDNF (Steel Detailing Neutral File) is

used in importing to and exporting
from several different CAD systems.

Calma x x Calma plant design system

HLI x x HLI (High Level Interface). IEZ AG
Speedikon software

Plantview x Plantview design system

See also
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Option Import Export Imports from/Exports to
SDNF (PDMS) x x Plant Design Management System.

Aveva 3D plant design software.

Data is exported to PDMS via SDNF link.
Tekla Structures writes the information
of finish field in the member class
attribute, whereas in SDNF export it
omits the class information.

XML x x ArchiCAD modeling system.

There are some limitations in the
export:

• Conversion files are not used.

• Holes, bolts and welds are not
exported.

PML x PML exports files in Intergraph’s
Parametric Modeling Language format.
The PML export can be used with
several Intergraph systems.

PDMS x Outdated format. We do not
recommend using this option.

SCIA x SCIA is used for SteelFab interface.

13.2 Importing an SDNF model

Before you start, check that the advanced option 
XS_SDNF_CONVERT_PL_PROFILE_TO_PLATE has not been set on the Export page of
the Advanced Options dialog box.

To import an SDNF file:

1. Select File --> Import --> CAD... . 

The Import Models dialog box is displayed.

2. Select Import CAD from the Type list.

3. Use the default name import model or enter a new name.

4. Click OK.

5. Select the model from the list.

6. Click Properties... to open a dialog box where you can define the settings for the import
file: 

• You can load the standard parameters for PDS and PDMS SDNF files with the Load
option.
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• On the Conversion tab, enter the conversion file names or browse for the conversion
files.

• On the Parameters tab, enter the name of the SDNF file you want to import in the
Input file box, or use the default name.

SDNF files normally have a *.dat extension. The version number for SDNF 3.0 files
can be found in the header if you open the file with a text editor.

• On the Parameters tab, set the file Type to SDNF, and set the origin coordinates in
the Origin boxes if you want the file in a specific location.

• Set the SDNF options on the SDNF page:

• In the Part Pos_No area enter a prefix and a start position number. This relates
to the Position number type setting.

• In SDNF version number, select the SDNF format type (2.0 or 3.0). SDNF 3.0 is
generally the format to select. However, with StruCAD it is better to share SDNF
2.0 files.

• Set Apply cuts and fittings to Yes (default) to apply cuts and fittings in the
import. These will only be included if contained within the SDNF file.

• Set Consider offsets to Yes to create offsets. In most cases you should select
Yes. No (default) positions part creation points at part end points.

• You can create a log file. If the import fails, examine the log file to find out why.
Check the log file even if the import seems to have succeeded. In the Create log
file, you can select Create to write a new log file, and delete the previous log file,
each time you import the model. If you select Append (default), the log file
information is added at the end of the existing log file.

• You can also select how the log file is displayed, the options being With an
external viewer (like Microsoft Notepad), Not viewed, and In a dialog box,
which creates a separate list dialog box in which the file can only be viewed.

• Enter the log file name or browse for an existing log file.

• The SDNF file contains identifiers that can be included in a part’s user-defined
attributes, or used as position numbers. In Position number type, select Part
position if you want the identifier to become the part’s position number. Do not
use the Part Pos_No fields with this option. Select Universal ID if you want the
identifier to become a user-defined attribute for the part. In most cases, you
would select Universal ID. To make user-defined attributes visible, you need to
add them to the objects.inp file. For file imports from PDS or PDMS then
the Universal ID option is the normal case

• If you wish to create a report of the import, enter the required information on the
Report tab.

• On the Advanced tab, you can set some advanced options. Usually there is no need
to change the defaults.

7. Click OK to go to the Import Model dialog box.

8. Select the import model name from the list and click Import. 
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You can also click the New or Properties buttons if you require to make some changes.

Tekla Structures displays the Import model info dialog box.

9. Select which version of parts to import.

10. Click Accept all. 

The Accept all option is generally used if importing a new model over an existing one. If
you have changed the model and want to re-import it, you can also reject all changes by
clicking Reject all, or accept or reject individual changes by clicking Select individual....

11. Tekla Structures displays the message Do you want to save the import model for
subsequent imports? Click Yes. 

Tekla Structures displays the import model in a model view.

12. Right-click the model view and select Fit work area to entire model to ensure that the
imported model is completely visible.

13. If parts are missing, check the View depth Up and Down values in the View Properties
dialog box and change them if necessary.

If you want to import information, which Tekla Structures parts do not have, you can use
the SDNF extension line in the SDNF file to be imported, and the REVISION_NUMBER
user-defined attribute in Tekla Structures.

CAD model import settings on page 103
See also
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13.3 Importing a Plantview model

To import a Plantview model:

1. Select File --> Import --> CAD... . 

The New Import Model dialog box is displayed.

2. Select Import CAD.

3. Use the default name import model or enter a new name.

4. Click OK.

5. Select the model from the list.

6. Click Properties... to open a dialog box where you can define the settings for the import
file type you selected: 

• On the Conversion tab, enter the conversion file names or browse for the conversion
files.

• On the Parameters tab, enter the name of the Plantview file you want to import in
the Input file box, or use Browse to locate the file.

• Set the file type to Plantview in the Type box, and set the origin coordinates in the
Origin boxes if you want the file in a specific location.

• Set the material grade in the Material box on the SDNF tab.

You can also click ... next to the box, and browse for the material grade in the Select
Material dialog box.

• If you wish to create a report of the import, enter the required information on the
Report tab.

• If you are importing the model for the first time, you do not need to change the
default values on the Advanced tab.

7. Click OK to go to the Import Model dialog box.

8. Click Import. 

Tekla Structures displays the Import model info dialog box.

9. Select which version of parts to import.

10. Click Accept all. 

If you have changed the model and want to re-import it, you can also reject all changes
by clicking Reject all, or accept or reject individual changes by clicking Select
individual....

11. Tekla Structures displays the message Do you want to save the import model for
subsequent imports? Click Yes. 

Tekla Structures displays the imported model in a model view.
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12. Right-click the model view and select Fit work area to entire model to ensure that the
imported model is completely visible.

13. If parts are missing, check the View depth Up and Down values in the View Properties
dialog box and change them if necessary.

CAD model import settings on page 103

13.4 Importing a SteelFab/SCIA model

To import a SteelFab/SCIA model:

1. Select File --> Import --> CAD... . 

The Import Models dialog box is displayed.

2. Select Import Steelfab/SCIA from the Type list.

3. Use the default name import model or enter a new name.

4. Click OK.

5. Select the model from the list.

6. Click Properties... to open a dialog box where you can define the settings for the import
file: 

• Enter the input file name.

• Enter the conversion file names.

• Set the origin coordinates in the Origin boxes if you want the file in a specific
location

• Set Import weldings to Yes to include welds in the model.

• Set Import holes to Yes to include holes in the model.

7. Click OK.

8. Click Import.

9. Select which version of parts to import.

10. Click Accept all.

11. If you have changed the model and want to re-import it, you can also reject all changes
by clicking Reject all, or accept or reject individual changes by clicking Select
individual....

12. Tekla Structures displays the message Do you want to save the import model for
subsequent imports? Click Yes. 

Tekla Structures displays the import model in a model view.

13. Right-click the model view and select Fit work area to entire model to ensure that the
imported model is completely visible.

See also
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14. If parts are missing, check the View depth Up and Down values in the View Properties
dialog box and change them if necessary.

CAD model import settings on page 103

13.5 CAD model import settings

The settings related to importing various types of models through the Import Model dialog
box are listed below. All of the tabs and settings are not available for all import types. The
import types are listed next to the settings, so that you can see which import type the
settings belong to. The Import Model dialog box is displayed when you click Properties in
the Import Models or New Import Model dialog box.

Option Description Import type
Profile conversion file

Material conversion
file

Twin profile conversion
file

Set the conversion files you want to use.

Conversion files map Tekla Structures profile and
material names with names used in other
software.

For SteelFab/SCIA, these options are located on
the Parameters tab.

CAD

FEM

CIS Model/
CIMSteel

Eureka LMP

MicasPlus

SteelFab/SCIA
Advanced tab

Action when object
status is (compared to)

Previous plan lists the objects in your model,
compared with the objects in the file to be
imported. They can be New, Modified, Deleted, or
Same.

Tekla Structures compares the state of imported
objects with those in your model. They can be Not
in model, Different, or Same.

Use the options under Not in model, Different,
and Same to specify the actions when importing
changed objects. The options are No action, Copy,
Modify, or Delete.

CAD

FEM

MicasPlus

Eureka LMP

CIS Model/
CIMSteel

Option Description Import type
Part Pos_No

Assembly Pos_No

Enter a prefix and a start position number.

For SDNF, this option is located on the SDNF tab.

FEM

See also

Conversion tab

Parts tab
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Option Description Import type
Input file or ASCII file
name

The file you want to import. You can also browse
for the file.

All

Type or

Model type

Set the input file or model type:

CAD: SDNF, Calma, HLI, Plantview, SDNF (PDMS),
XML

FEM: DSTV, SACS, Monorail, Staad, Stan 3d, Bus

CIS Model/CIMSteel: Design, Analysis, SP3D.

CAD

FEM

CIS Model/
CIMSteel

CIS version Select CIS/1 or CIS/2:

• CIS/1 imports files compatible with the
CIMsteel LPM4DEP1 schema declaration.

• CIS/2 imports files compatible with the
CIMsteel CIS/2
(STRUCTURAL_FRAME_SCHEMA) schema
declaration.

CIS Model/
CIMSteel

Input scope Import the Entire model or Selection only. CIS2 status
Part rotation Select Front or Top. MicasPlus
Origin X, Y, Z Set the origin coordinates to place the file in a

specific location.
CAD

FEM

CIS Model

Eureka LPM

MicasPlus

SteelFab/SCIA
Default yield stress
limit

Default material when
yield stress > = limit

Default material when
yield stress < limit

The Default material when yield stress < limit
setting is used for SACS import file. Define the
material to use if yield stress is less than the limit.

The setting Default material when yield stress
>= limit is used for SACS or DSTV import files. For
SACS, this field defines the material to use if yield
stress is greater than or equal to the limit. For
DSTV you can enter the material grade here, if it is
not included in the import file.

FEM

Combine members

Max length for
combining

To combine several elements in the FEM or CIS
model into one part in Tekla Structures, set
Combine members to Yes.

For example, if a beam in a file consist of more
than one element, and you select Yes, the
elements are combined to form one beam in the
Tekla Structures model.

FEM

CIS Model/
CIMSteel

Parameters tab
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Option Description Import type
If you use the value No, Tekla Structures creates a
beam for each element in the FEM or CIS model.

Max length for combining is only applied if you
set Combine members to Yes. Use this setting to
define the maximum length for combining parts.
Tekla Structures combines elements into one part
only if their combined length is less than the
value you enter here.

Ignore offsets CIS/1 and CIS/2 analysis models can include
member offsets, which means that nodes are not
exactly at the beam’s end points. With the default
Yes, Tekla Structures uses these offsets to locate
the physical members. With No, Tekla Structures
determines the location using the node locations.

CIS/CIMSteel

Ignore forces Use to define how forces are imported. With No,
Tekla Structures imports absolute values of
maximum forces to parts’ user-defined attributes
Shear, Tension and Moment. With Yes, Tekla
Structures does not import forces.

CIS/CIMSteel

Import GUID (design
model)

The part GUID is included in the import. CIS/CIMSteel

Create log file Select Create to write a new log file and delete
the previous log file each time you import the
model.

Select Append (default) to add the log file
information is at the end of the existing log file.

If you do not need a log file, select No.

In SDNF, this option is on the SDNF tab.

CAD (SDNF)

CIS2 status

Display log file Select With an external viewer to display the log
file in an external viewer, like Microsoft Notepad.

If you do not want to display the file, select Not
viewed.

Select In a dialog box to create a separate list
dialog box in which the file can only be viewed.

In SDNF, this option is on the SDNF tab.

CAD (SDNF)

CIS2 status

Import weldings Include weldings in the imported model. SteelFab/SCIA
Import bolt holes Include bolt holes in the imported model. SteelFab/SCIA

Option Description Import type
Create report Set to Yes to create a report. CAD

FEM

Report tab
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Option Description Import type
Display report Set to Yes to display the report. CAD

FEM
Report template Select the report template. CAD

FEM
Report file name Enter the report file name or browse for a report

file.
CAD

FEM

Option Description Import type
Part Pos_No Enter a prefix and a start position number.

This settings relates to the Position number type
setting.

CAD (SDNF)

SDNF version number Set the SDNF format type to 2.0 or 3.0. CAD (SDNF)
Apply cuts and fittings Set to Yes (default) to apply cuts and fittings in

the import.
CAD (SDNF)

Consider offsets Set to Yes to create offsets. In most cases you
should select Yes. No (default) positions part
creation points at part end points.

CAD (SDNF)

Log file name Enter the log file name or browse for an existing
log file.

CAD (SDNF)

Position number type The SDNF file contains identifiers that can be
included in a part’s user-defined attributes, or
used as part position numbers.

Select Part position if you want the identifier to
become the part’s position number. Do not use
the Pos_No option with this option.

Select Universal ID if you want the identifier to
become a user-defined attribute for the part.

For file imports from PDS or PDMS then the
Universal ID option is the normal case.

To make user-defined attributes visible in the
dialog boxes, you need to add them to the
objects.inp file.

CAD (SDNF)

Option Description Import type
Material Select the material grade. CAD (Plantview)

FEM (Staad)

Option Description Import type
Version Select the DSTV version. FEM (DSTV)

SDNF tab

Plantview tab

DSTV tab
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Option Description Import type
Import static elements

Import other elements

If the DSTV file to be imported contains a static
and a CAD model, you can choose which one to
import.

Answering Yes to Import static elements imports
the static model.

Answering Yes to Import other elements imports
the CAD model.

FEM (DSTV)

Option Description Import type
Scale Specify the scale of the import model. You can

import Stan 3d without specifying the scale as
long as both the Tekla Structures model and the
import model are in millimeters. If the Stan 3d file
is in millimeters, use the scale 1. If the Stan 3d
file is in meters, use the scale 1000.

FEM (Stan 3d)

Material Enter the material for the parts to import. FEM (Stan 3d)

Option Description Import type
Pos_No Indicate the Pos_No of the girders, columns,

braces and cantilevers you import.
FEM (Bus)

Material Enter the material for the parts to import. FEM (Bus)
Name Enter the name of the parts to import. FEM (Bus)
Class Enter the class of the parts to import. FEM (Bus)
Beams behind plane The value Yes aligns the tops of all beams at the

floor level.
FEM (Bus)

Option Description Import type
Action when object
status is (compared to)

Previous plan lists the objects in your model,
compared with the objects in the file to be
imported. They can be New, Modified, Deleted, or
Same.

Tekla Structures compares the state of imported
objects with those in your model. They can be Not
in model, Different, or Same.

Use the options under Not in model, Different,
and Same to specify the actions when importing
changed objects. The options are No action, Copy,
Modify, or Delete.

CAD

FEM

MicasPlus

Eureka LMP

CIS Model/
CIMSteel

Importing an SDNF model on page 98

Importing a Plantview model on page 101

Stan 3d

Bus tab

Advanced tab

See also

CAD 107 CAD model import settings



Importing a SteelFab/SCIA model on page 102

13.6 Exporting to CAD

You can export a CAD model in several formats.

To export a CAD model:

1. Open a Tekla Structures model.

2. Click File --> Export --> CAD... to open the CAD export dialog box.

3. Enter the paths to the required conversion files on the Conversion tab.

4. Go to the Parameters tab, and give a name to the export file in the Output file box. 

You can also browse for the file.

5. Select the export format from the Type list.

6. Use the Origin X, Y, Z boxes to specify the origin of the exported model.

7. In PML export, define PML-specific information on the PML tab.

8. In SDNF, SDNF (PDMS) and PDMS export, go to the SDNF tab, and define the necessary
information.

9. Select the parts in the model to export.

10. Click Apply and Create. 

Tekla Structures creates the export file in your current model folder.

CAD model export settings on page 108

CAD import and export formats on page 97

13.7 CAD model export settings

Settings related to exporting various types of models through the Export CAD dialog box are
listed below. FEM export settings are also described. All of the tabs and settings are not
available for all export types. The export types are listed next to the settings, so that you can

See also

CAD 108 Exporting to CAD



see which export type the setting belongs to. The Export CAD dialog box is displayed when
you select File --> Export --> CAD... .

Option Description Export type
Profile conversion
file

Material conversion
file

Twin profile
conversion file

Set the conversion files you want to use.

Conversion files map Tekla Structures profile and
material names with names used in other
software.

All

Option Description Export type
Output file The file name of the exported file. You can also

browse for the file.
All

Type Select the export format. All

Origin X, Y, Z Set the origin coordinates to place the exported
model in a specific location.

PML, SDNF, XML

Split members Splits a part in the Tekla Structures model into
several elements in the STAAD or DSTV model.

FEM

Combine segmented
members (MicroSAS)

Gives you the option to combine multiple parts to
form one part in the exported model.

For example, if you have divided a beam into
several elements and select the Yes option, Tekla
Structures combines the elements so that they
form one beam in the exported model. With the
option No every element of the beam in the model
forms individual beams.

FEM (MicroSAS)

Option Description Export type
Units (for PML only) Select the units for the export model. PML
Export cut parts Controls whether cuts are included in the export.

Yes exports part cuts.

When you use PML, enter the Tekla Structures
profile names in the conversion file. This makes
the other software consider parts as beams and
columns, not as plates, and reduces the export file
size.

PML

Option Description Export type
SDNF version number Select the SDNF version to be used in the export.

With StruCAD, use SDNF version 2.0.

SDNF

SDNF(PDMS)

PDMS

Conversion tab

Parameters tab

PML tab

SDNF tab
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Option Description Export type
Apply cuts and
fittings

Select Yes (default) applies cuts and fittings in the
export.

SDNF

SDNF(PDMS)

PDMS
Position number type The SDNF file contains identifiers, which can be

included in a part’s user-defined attributes, or as
position numbers. You have the following options:

• Part position

The identifier becomes the part’s position
number. Do not use the Part Pos_No fields
with this option.

• Assembly position

The identifier becomes the assembly’s position
number.

• Universal ID

The identifier becomes a user-defined
attribute for the part.

To make user-defined attributes visible, you need
to add them to the objects.inp file.

SDNF

SDNF(PDMS)

PDMS

Consider offsets To ignore the offset records during export, select
No, and to take them into account, select Yes.

This setting does not affect the actual start and
end point information, only the offset. Tekla
Structures writes the start and end points based
on the actual solid object, not on the reference
line.

SDNF

SDNF(PDMS)

PDMS

PDMS phase offset PDMS phase offset defines phase offset for
exported parts. For example, if the first phase in
Tekla Structures model is 1 and you enter 10 for
phase offset, Tekla Structures parts in another
software get the phase from 11 and up.

SDNF

SDNF(PDMS)

PDMS

Engineering firm Enter the name of the engineering company. SDNF

SDNF(PDMS)

PDMS
Client Enter the name of the client. SDNF

SDNF(PDMS)

PDMS
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Option Description Export type
Structure ID Enter a unique identification number for the

exported model.
SDNF

SDNF(PDMS)

PDMS
Project ID Enter a unique identification number for the

exported project.
SDNF

SDNF(PDMS)

PDMS
Revision number Enter an optional revision number. Tekla

Structures takes the revision number from the
user-defined attributes (REVISION_NUMBER) of
the model. If this field is blank, Tekla Structures
uses a revision number from the CAD export
dialog box (Revision Number).

SDNF

SDNF(PDMS)

PDMS

Issue code Tekla Structures writes an issue code in the
header section of the output file. For PDMS, this
value should always be "Tekla Structures".

SDNF

SDNF(PDMS)

PDMS
Design code Define the design code to be used in structural

design.
SDNF

SDNF(PDMS)

PDMS

Option Description Export type
Units Specify unit conversions (MM, M, IN, FT). For

example, for a Tekla Structures model created
using millimeters, select IN to convert all part
dimensions to inches in the output file.

XML

XML structure ID Unique identification number for the exported
model. You must always enter the identification
ID. Tekla Structures uses this value to identify the
model if you re-export it.

XML

XML structure name Unique name of the exported model. XML

Option Description Export type
Profile table Select the profile type. FEM (STAAD)
Parametric shapes
when possible

Use to define how Tekla Structures exports the
profiles PL, P, D, PD, SPD to Staad.

Yes exports the profiles as parametric shapes so
that STAAD can identify them correctly.

No exports all profiles as standard STAAD shapes.

FEM (STAAD)

XML tab

Staad tab
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Option Description Export type
Version Select the DSTV version to export. FEM (DSTV)
Element reference
with

Select CROSS-SECTION to export a static model
or MEMBER_LOCATION to export a CAD model.

FEM (DSTV)

Exporting to CAD on page 108

Exporting to a CIMSteel analysis model on page 135

Exporting to a CIMSteel design/manufacturing model on page 136

Exporting to STAAD on page 121

Exporting to DSTV on page 122

13.8 Re-importing a CAD model

Sometimes you have already imported a model, but because of some changes, you need to
re-import it.

The profile and material conversion files need to be the same as adopted in the original
model import.

The following instructions also apply to CIMsteel (cis/2) models.

To re-import a model:

1. Open Tekla Structures and a model where you have already imported an existing CAD
model.

2. Click File --> Import --> CAD .

3. Select the import type in the Type list. 

For CAD models, this will generally be for SDNF format files only.

4. Enter a new name for the imported model in the Name box. 

The total path and filename cannot be longer than 80 characters. If the total path is too
long, a message is displayed saying "File name and path is too long. Please, place the file
into another directory." Also, if you use the same name as in the original import, Tekla
Structures gives the warning message "Illegal name for import model."

5. Click the Properties button and ensure that the Profile material conversion files on the
Conversion tab are the same as adopted in the original model import.

6. Go to the Advanced tab and define the actions Tekla Structures takes when importing
changed objects: 

• The left-hand column, Previous plan, lists the state of the objects in your model,
compared with the state of objects in the file to be imported. They can be New,
Modified, Deleted, or Same.

DSTV tab

See also
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• The objects can be Not in model, Different, or Same.

• Use the list boxes in the rows under Not in model, Different, or Same to specify the
actions to take when importing changed objects. The options are No action, Copy,
Modify, or Delete.

You can select Delete only for Deleted objects. You can only use Delete to delete
objects that have been deleted from your model, not from the imported model.

• Normally, default settings would be used by most users.

7. Click OK or Apply.

8. Click OK in the Import Model dialog box to import the updated model.

9. Create reports on the Report tab to compare the various imports.

CAD model import settings on page 103

Creating import reports on page 113

13.9 Creating import reports

Some of the import tools give you the option to create a report of the import. By default,
Tekla Structures does not create reports when you import files.

With this import report you can compare different revisions from previous imports. You can
list the differences in profiles, material, part rotation, part position, paint, start connection
codes, end connection codes, phase, for example.

To create an import report:

1. Open the import tool, for example, CAD ( File --> Import --> CAD... ).

2. Go to the Report tab of the import dialog box.

3. In Create report, select Yes.

4. In Display report, select Yes to display the report file.

5. In Report template, enter the path of the report template, or use the browse button to
locate it. 

You can also leave the template name out, in which case the default import template is
used.

6. In Report file name, enter the path for the report file, or use the browse button to locate
it. 

You can also leave the report file name out, in which case the default import report file is
used.

7. Import the model. 

See also
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The model is imported and the report is displayed on the screen.

If you have not given the report any other name, the report is saved with the name 
import_revision_report.rpt in the model folder.
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14 FEM

FEM (Finite Element Method) is an analysis and calculation method used in structural
engineering. In this element method, the target is divided into appropriate finite elements
interconnected at points called nodes.

Tekla Structures FEM import and export tool support several formats and provide several
options for importing and exporting models.

FEM import and export file types on page 115

14.1 FEM import and export file types
You can import the following file types into Tekla Structures using the FEM import tool.

Option Software
DSTV DSTV format data (Deutsche Stahlbau-Verband). Several

different systems, for example, RSTAB static software and
Masterseries Analysis & Design system.

SACS SACS modeling and analysis software

S-Frame Analysis software, for example, FASTSOLVE.

Monorail Monorail system

STAAD STAAD format data (Structural Analysis And Design). STAAD
modeling and analysis system.

Stan 3d Stan 3d analysis software

Bus BUS 2.5 analysis software

You can export to the following formats: DSTV, MicroSAS, and STAAD.

See also
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14.2 DSTV
DSTV (Deutscher STahlbau-Verband) manufacturing format is the standard format used for
manufacturing steel components on numerically controlled (NC) machines. It also has an
Analysis & Design format that is used for transferring Analysis & Design models to the
physical 3D model.

Different programs produce different DSTV files. For example, the DSTV file produced by
RSTAB static software only contains a static model. Tekla Structures exports either the static
model (CROSS_SECTION), or the CAD model (MEMBER_LOCATION).

Importing a DSTV model on page 116

14.3 Importing a DSTV model

To import a DSTV model:

1. Select File --> Import --> FEM... . 

The New Import Model dialog box is displayed.

2. Select Import FEM...

3. Select import model (default) from the list or enter a new name.

4. Click OK.

5. Click Properties... to open a dialog box where you can define the settings for the import
file: 

• On the Conversion tab, enter the conversion file names or browse for the files.

• On the Parts tab, enter a prefix and a start position number for the imported parts in
the Part Pos_No and Assembly Pos_No boxes.

• On the Parameters tab, enter the name of the DSTV file you want to import in the
Input file box, or use the default name.

• On the Parameters tab, set the file type to DSTV in the Type box, and set the origin
coordinates in the Origin boxes if you want the file in a specific location.

• If you wish to create a report of the import, enter the required information on the
Report tab.

• Select the DSTV version on the DSTV tab.

For Masterseries, the DSTV99 format must be selected.

• Still on the DSTV tab, set Import static elements to Yes to import a static model. If
you set Import other elements to Yes, a CAD model is imported.

6. Click OK to go to the Import Model dialog box.

7. Select the model to import.

See also
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8. Click Import. 

Tekla Structures displays the Import model info dialog box.

9. Select which version of parts to import.

10. Click Accept all. 

If you have changed the model and want to re-import it, you can also reject all changes
by clicking Reject all, or accept or reject individual changes by clicking Select
individual....

11. Tekla Structures displays the message Do you want to save the import model for
subsequent imports? Click Yes. 

Tekla Structures displays the import model in a model view.

12. Right-click the model view and select Fit work area to entire model to ensure that the
imported model is completely visible.

13. If parts are missing, check the View depth Up and Down values in the View Properties
dialog box and change them if necessary.

CAD model import settings on page 103

14.4 Importing a STAAD model

This FEM import tool imports steel structures from the STAAD modeling and analysis system.

To make a STAAD input file compatible with the Tekla Structures STAAD import,
use the option Joint coordinate format (Single) to save the input file in STAAD.
This creates a line for each coordinate in the input file.

To import a STAAD model:

1. Select File --> Import --> FEM... . 

The New Import Model dialog box is displayed.

2. Select Import FEM.

3. Use the default name import model or enter a name for the import model.

4. Click OK.

5. Select the model.

6. Click Properties... to open a dialog box where you can define the settings for the import
file type you selected: 

• On the Conversion tab, enter the conversion file names or browse for the conversion
files.

See also
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• On the Parameters tab, enter the name of the STAAD file you want to import in the
Input file box.

• Set the file type to STAAD in the Type box, and set the origin coordinates in the
Origin boxes if you want the file in a specific location.

• Set the material grade in the Material box on the Staad tab.

You can also click ... next to the box, and browse for the material grade in the Select
Material dialog box.

• If you wish to create a report of the import, enter the required information on the
Report tab.

• If you are importing the model for the first time, you do not need to change the
default values on the Advanced tab.

7. Click OK to go to the Import Model dialog box.

8. Click Import. 

Tekla Structures displays the Import model info dialog box.

9. Select which version of parts to import.

10. Click Accept all. 

If you have changed the model and want to re-import it, you can also reject all changes
by clicking Reject all, or accept or reject individual changes by clicking Select
individual....

11. Tekla Structures displays the message Do you want to save the import model for
subsequent imports? Click Yes. 

Tekla Structures displays the import model in a model view.

12. Right-click the model view and select Fit work area to entire model to ensure that the
imported model is completely visible.

13. If parts are missing, check the View depth Up and Down values in the View Properties
dialog box and change them if necessary.

FEM import is one way to import STAAD data. Direct link to STAAD.Pro analysis and design
application is another, more versatile way to import.

STAAD table type specifications on page 118

CAD model import settings on page 103

STAAD.Pro on page 259

See also
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STAAD table type specifications
Tekla Structures supports the following STAAD table type specifications:

• ST (single section from the standard built-in tables)

• ST PIPE (parametric)

• ST TUBE (parametric)

• RA (single angle with reverse Y_Z axes)

• D (double channel)

• LD (long leg, double angle)

• SD (short leg, double angle)

• TC (beams with top cover plates)

• BC (beams with bottom cover plates)

• TB (beams with top and bottom cover plates)

You can import the types CM and T, user-provided steel table types (UPT), and other non-
standard profiles, if you have defined them in the profile conversion file. You must use the
underscore character in the STAAD name, for example, UPT_1_W10X49. Tekla Structures
automatically converts twin profiles in this import routine.

Importing a STAAD model on page 117

14.5 Importing a Stan 3d model

To import a Stan 3d model:

1. Select File --> Import --> FEM... . 

The Import Model dialog box is displayed.

2. Select Import FEM.

3. Use the default import file name import model or enter another name.

4. Click OK.

5. Select the model to import.

6. Click Properties... to open a dialog box where you can define the settings for the import
file type you selected: 

• On the Conversion tab, enter the conversion file names or browse for the conversion
files.

• On the Parameters tab, enter the name of the file you want to import in the Input
file box.

See also
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• Set the file type to Stan 3d in the Type box, and set the origin coordinates in the
Origin boxes if you want the file in a specific location.

• If you wish to create a report of the import, enter the required information on the
Report tab.

• If you are importing the model for the first time, you do not need to change the
default values on the Advanced tab.

7. Click OK to go to the Import Model dialog box.

8. Click Import.

Tekla Structures displays the Import model info dialog box.

9. Select which version of parts to import.

10. Click Accept all.

If you have changed the model and want to re-import it, you can also reject all changes
by clicking Reject all, or accept or reject individual changes by clicking Select
individual....

11. Tekla Structures displays the message Do you want to save the import model for
subsequent imports? Click Yes.

Tekla Structures displays the import model in a model view.

12. Right-click the model view and select Fit work area to entire model to ensure that the
imported model is completely visible.

13. If parts are missing, check the View depth Up and Down values in the View Properties
dialog box and change them if necessary.

CAD model import settings on page 103

14.6 Importing a Bus model

The Bus import tool imports basic steel structures from the BUS 2.5 analysis software input
file.

To import a Bus model:

1. Select File --> Import --> FEM... .

The Import Model dialog box is displayed.

2. Select Import FEM.

3. Use the default name import model or enter another name.

4. Click OK.

5. Select the model.

6. Click Properties... to open a dialog box where you can define the settings for the import
file type you selected:

See also
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• On the Conversion tab, enter the conversion file names or browse for the conversion
files.

• On the Parameters tab, enter the name of the Bus file you want to import in the
Input file box.

• Set the file type to Bus in the Type box, and set the origin coordinates in the Origin
boxes if you want the file in a specific location.

• On the Bus tab, enter the position number, material, name, and class of the parts to
import. Use Beams behind plane to indicate the position of girders and cantilevers.
The option Yes aligns the tops of all beams at the floor level.

• If you wish to create a report of the import, enter the required information on the
Report tab.

• If you are importing the model for the first time, you do not need to change the
default values on the Advanced tab.

7. Click OK to go to the Import Model dialog box.

8. Click Import. 

Tekla Structures displays the Import model info dialog box.

9. Select which version of parts to import.

10. Click Accept all. 

If you have changed the model and want to re-import it, you can also reject all changes
by clicking Reject all, or accept or reject individual changes by clicking Select
individual....

11. Tekla Structures displays the message Do you want to save the import model for
subsequent imports? Click Yes. 

Tekla Structures displays the import model in a model view.

12. Right-click the model view and select Fit work area to entire model to ensure that the
imported model is completely visible.

13. If parts are missing, check the View depth Up and Down values in the View Properties
dialog box and change them if necessary.

CAD model import settings on page 103

14.7 Exporting to STAAD

To export to STAAD:

1. Open a Tekla Structures model.

2. Click File --> Export --> FEM... . 

The FEM export dialog box is displayed.

See also
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3. Go to the Conversion tab and enter the names of the conversion files, or browse for the
files.

4. Go to the Parameters tab, and enter the name of the output file, or browse for the file.

5. Select Staad in the Type list.

6. Set Split members to Yes to split a part in the Tekla Structures model into several
elements in the STAAD model.

7. Go to the Staad tab and select an option from Profile type list.

8. Use the setting Parametric shapes when possible to define how Tekla Structures exports
the profiles PL, P, D, PD, SPD to Staad. 

• Yes exports the profiles as parametric shapes so that STAAD can identify them
correctly.

• No exports all profiles as standard STAAD shapes.

Tekla Structures creates the export file in the current model folder.

Example of a plate PL10*200 when exported as parametric shape (Yes):

13 PRI YD 200.000000 ZD 10.000000.

Example of the same plate exported as a standard shape (No):

13 TABLE ST PL10*200

FEM export is one way to export STAAD data. Direct link to STAAD.Pro analysis and design
application is another, more versatile way to export.

STAAD.Pro on page 259

14.8 Exporting to DSTV

To export to DSTV:

1. Open a Tekla Structures model.

2. Click File --> Export --> FEM... . 

The FEM export dialog box is displayed.

3. Go to the Conversion tab and enter the names of the conversion files, or browse for the
files.

4. Go to the Parameters tab, and enter the name of the output file, or browse for the file.

5. Select DSTV in the Type list.

Example

See also
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6. Set Split members to Yes to split a part in the Tekla Structures model into several
elements in the DSTV model.

7. Go to the DSTV tab and select the DSTV version from the Version list.

8. In Element reference with, select whether you want to export into a static model
CROSS_SECTION, or into a CAD model MEMBER_LOCATION.

Supported DSTV entities on page 123

Supported DSTV entities

The DSTV entities are listed below. Tekla Structures supports those marked with an asterisk
(*). See the DSTV standard "Stahlbau - Teil 1. März 2000" for more information.

Static data:

vertex (*)

polyline

substructure (*)

node (*)

element (*)

element_eccentricity (*)

raster

boundary_condition

elastic_support

nodal_reaction

element_reaction

General data:

material (*)

cross_section (*)

CAD data:

member (*)

member_location (*)

construction-data

cutout

hole

Exporting to DSTV on page 122

See also

See also
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15 ASCII

ASCII stands for American Standard Code for Information Interchange. Some plant design
systems export ASCII files, for example, ModelDraft, PDS and PDMS.

You can import and export profiles and plates created as beams using the ASCII format.

Importing in the ASCII format on page 124

Exporting to the ASCII format on page 124

ASCII file description on page 125

15.1 Importing in the ASCII format

To import a Tekla Structures model in ASCII format:

1. Create a new model in Tekla Structures.

2. Create a new 3D view.

3. Copy the ASCII file to the model folder.

4. Name the file import.asc.

5. Click File --> Import --> ASCII . 

Tekla Structures displays the main parts created from the ASCII file in the model.

ASCII on page 124

Exporting to the ASCII format on page 124

ASCII file description on page 125

See also

See also
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15.2 Exporting to the ASCII format

To export a Tekla Structures model to the ASCII format:

1. Open the Tekla Structures model you want to export.

2. Select the parts in the model you want to export.

3. Click File --> Export --> ASCII . 

Tekla Structures creates a model.asc file in the current model folder.

ASCII on page 124

Importing in the ASCII format on page 124

ASCII file description on page 125

15.3 ASCII file description

In an import.asc file each part is described by 8 lines. These lines are repeated for each
part to be transferred. Units are always in millimeters, blanks are used as separators.

Below is an example of a beam part description:

Line Description
Line 1 4169 HEA300 1 = ID profile type

• ID 4169: Unique ID (integer).

• PROFILE HEA300: Profile name (string).

• TYPE 1: Profile type (integer)

The available profile types are:

0 = free cross section (can be used for special profiles which are not in the
database)

1 = I profiles

2 = Welded hollow core profiles (HK, HQ)

See also
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Line Description
3 = U profiles

4 = L profiles

5 = Round bars

6 = Round tubes

7 = Rectangular hollow core sections (RHS, P)

8 = T profiles

9 = Rectangular bars (FL, PL)

10 = Z profiles

11 = C profiles

12 = Omega profiles

13 = Sigma profiles

14 = Rail profile

16 = Reinforcement bars (DH)

Line 2 The contents of line 2 depend on the part profile.

• Polygon plates:

N_POINTS COORDINATES

N_POINTS: For profiles of type 0.

COORDINATES: Number of the corner points (integer).

The X and Y coordinates of the plate corners (floating). Rotation direction is
clockwise. Coordinates follow the global coordinate system. Z coordinates are
taken from the center line in the plate thickness direction.

Note that the line 2 can be divided into several rows in the file.

• Profiles:

For profile types 1-16, the line includes the physical dimensions of the cross
section.

HEIGHT S W1 T1 W2 T2: 290.000000 8.500000 300.000000
14.000000 300.000000 14.000000
• HEIGHT 290.000000: Height of the cross section

• S 8.500000: Web thickness.

• W1 300.000000: Width of the upper flange.

• T1 14.000000: Thickness of the upper flange.

• W2 300.000000: Width of the lower flange.

• T2 14.000000: Thickness of the lower flange.
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Line Description
Line 3 A/6 BEAM = mark name

• MARK A/6: Position mark of the part (string).

• NAME BEAM: Part name (string).

Line 4 S235JR S235JR = material

Material of the part (string).

Line 5 0.000000 = rotation

Rotation angle (in degrees) around the local x-axis of the beam.

Line 6 16.500000 24000.000000 4855.000000 = X1 Y1 Z1

Coordinates of the beam start point. Z coordinates are center-line coordinates.

Line 7 6000.000000 24000.000000 4855.000000 = X2 Y2 Z2

Coordinates of the beam end point. Z-coordinates are center-line coordinates.

Line 8 16.500000 24000.000000 5855.000000 = X3 Y3 Z3

Direction vector showing the direction of the local z-axis.

ASCII on page 124

Importing in the ASCII format on page 124

Exporting to the ASCII format on page 124

See also
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16 Attribute import

You can import user-defined attribute (UDA) values to a model from a text file. For example,
you can import a list of manufactured or checked assemblies.

You can import the attribute values to Tekla Structures model objects, drawings or some
reference model objects by selecting an area in the model, or the whole model.

The imported file can be:

• Exported from other software.

• Created manually using any standard text editor, for example, Microsoft Notepad.

• A simple Tekla Structures report containing the part IDs and user-defined attributes.

Importing attributes on page 128

Input files in attribute import on page 129

Examples of input files used in attribute import on page 130

Data file used in attribute import on page 131

Attribute import settings on page 132

16.1 Importing attributes

To import user-defined attribute (UDA) values from a text file:

1. Copy the text file that you want to import to the current model folder.

2. If you want to import user-defined attributes to a selected area in the Tekla Structures
model, select an area in the model.

3. Click File --> Import --> Attributes... to open the Import Attribute dialog box.

4. Click the browse button next to the Input file box to locate the file to be imported.

5. Select the delimiter used in the text file.

6. Select an option in the Input scope, Create log file and Display log file boxes.

See also
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7. Click Create to import the file.

Attribute import on page 128

Input files in attribute import on page 129

Examples of input files used in attribute import on page 130

Data file used in attribute import on page 131

Attribute import settings on page 132

16.2 Input files in attribute import

Input files used in the import of user-defined attribute (UDA) values are text files, which are
delimited by a comma, tab, semi-colon, space or a user-defined delimiter. The input files
contain the names and values of the user-defined attributes to be imported to the Tekla
Structures model.

In the input file, the column headings must contain the names of properties and user-defined
attributes in model objects and drawings. The remaining lines contain the values of the
properties and user-defined attributes.

You must include at least one key field as a column heading. Key fields are drawing or model
object properties. Tekla Structures uses the key fields to identify the model objects or
drawings to which the user-defined attributes are assigned.

The key fields for model objects are:

Key field Example Action
GUID ID4FEAFC88-0

000-0004-313
3-3430383030
31

Tekla Structures assigns the user-defined attributes on
this line in the input file to the model object that has a 
GUID value of 
ID4FEAFC88-0000-0004-3133-34303830303
1.

ASSEMBLY_PO
S
or

MARK

A3 Tekla Structures assigns the user-defined attributes on
this line in the input file to the assembly that has an 
ASSEMBLY_POS value of A3.

Repeat this line for each assembly you want to include.

PHASE 2 Tekla Structures assigns the user-defined attributes on
this line in the input file to the assembly that has a 
PHASE value of 2.

You must also use ASSEMBLY_POS as a key field with
this option.

The key fields for drawing objects are:

See also
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Key field Example Action
TYPE NAME A D4 Tekla Structures assigns the user-defined attributes on this line in

the input file to the drawing that has a TYPE value of A and a 
MARK value of D4.

Use both key fields in the input file.

ID 134 Tekla Structures assigns the user-defined attributes in this line in
the input file to the drawing object that has an ID value of 134.

If you want to use user-defined attributes of other value types than the string in the input
file, you need to define them in the import_macro_data_types.dat file, located in
the ..\Tekla Structures\<version>\environments\common\system
folder.

If you use Microsoft Excel to create the input file, save the file with the Save as
command to Text (Tab-delimited) (*.txt) format.

Attribute import on page 128

Importing attributes on page 128

Examples of input files used in attribute import on page 130

Data file used in attribute import on page 131

Attribute import settings on page 132

Examples of input files used in attribute import

ASSEMBLY_POS and PHASE are the key fields. Tekla Structures adds several user-defined
attributes to the assemblies with values that match those listed in the ASSEMBLY_POS and 
PHASE columns.

For example, an assembly with the ASSEMBLY_POS (assembly number) of B5 in phase 1
gets the following user-defined attributes:

STATUS: 3

USER_PHASE: 6

USER_ISSUE: 3/25/2012

See also

Example input
file for parts
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The input file contains several entries for B1. In this case, Tekla Structures writes the message
Duplicate entry in input file in the log file and does not overwrite the user-defined
attributes that are listed earlier in the file with those that are listed later. For example, at the
end of the attribute import, B1 will have the following user-defined attributes:

STATUS: 7

USER_PHASE: 3

USER_ISSUE: 3/25/2012

This input file is tab-delimited. You can also use a comma, semi-colon, space or a user-
defined delimiter.

TYPE and NAME are the key fields. Tekla Structures adds a value for the user-defined
attribute User field 4 to drawings with values that match those listed in the TYPE
and NAME columns.

For example, a drawing with the TYPE A (assembly drawing) and NAME B.2 gets the value 4
in the User field 4.

Attribute import on page 128

Importing attributes on page 128

Input files in attribute import on page 129

Data file used in attribute import on page 131

Attribute import settings on page 132

Example input
file for drawings

See also
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Data file used in attribute import
If you want to use user-defined attributes of other value types besides string in the attribute
import input file, you need to define them in the import_macro_data_types.dat
file, located in the ..\Tekla Structures\<version>\environments
\common\system folder.

Theimport_macro_data_types.dat file is a simple text file listing the user-defined
attributes that you can include in an input file.

You can modify the file using any standard text editor, for example, Microsoft Notepad.

You can:

• Change any of the user-defined attributes that are not key fields.

• Add user-defined attributes as INT, STRING, FLOAT, or DATE value types.

The file contains the following columns:

VARIABLE_NAME, VARIABLE_TYPE, CONVERSION_FACTOR, COMMENT

Tekla Structures uses CONVERSION_FACTOR to convert imperial values to metric
values. Tekla Structures only uses this value in Imperial environments. We recommend that
you check the FLOAT values to avoid conversion factor errors.

Tekla Structures treats lines starting with double forward slash characters // as comments
and ignores them when reading the file.

Attribute import on page 128

Importing attributes on page 128

Input files in attribute import on page 129

Examples of input files used in attribute import on page 130

Attribute import settings on page 132

16.3 Attribute import settings

Use the options in the Import Attribute dialog box to define the input scope and log file
properties when importing user-defined attribute (UDA) values from a text file to a model.

Option Description
Input file
delimeters

Select the delimeter used in the input file.

Input scope • Default, Entire model

Tekla Structures assigns the user-defined attribute values of objects in
the input file to matching objects in the model.

See also
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Option Description
• Selection only

Tekla Structures only assigns the user-defined attribute values of
objects in the input file to matching objects in the selected area of the
model.

Use this option to import user-defined attributes to models. Do not use
it for drawings.

• Reference models

Tekla Structures assigns the user-defined attribute values of objects in
the input file to matching objects in reference models.

Create log file • Create

Creates a new log file named attribute_import.log in the
current model folder each time you import the user-defined attributes.
Any previous attribute import log files are overwritten.

• Append

Adds log entries to the attribute_import.log file in the
current model folder each time you import the user-defined attributes.
If the log file does not exist, Tekla Structures creates it.

• No

Does not create a log file.

Display log file • No

The log file is not displayed.

• On dialog

Tekla Structures displays the log file in a separate window. Click an
object ID in the log file to highlight the part in the model.

Attribute import on page 128

Importing attributes on page 128

Input files in attribute import on page 129

Examples of input files used in attribute import on page 130

Data file used in attribute import on page 131

See also
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17 CIS and CIMSteel

The CIS (CIMsteel Integration Standards) is one of the results of the Eureka CIMsteel project.
The current version CIS/2 is an extended and enhanced second-generation release of the CIS.
It was developed to facilitate a more integrated method of working through the sharing and
management of information within, and between, companies involved in the planning,
design, analysis and construction of steel framed buildings and structures.

There is one limitation: multi-material objects cannot be defined, because the standard
concentrates on steel objects.

CAD model import settings on page 103

17.1 Importing a CIMSteel model

To import a CIS (CIMSteel) model:

1. Select File --> Import --> CIMSteel... . 

The Import Model dialog box is displayed.

2. Select Import CIS model from the Type list.

3. Use the default name import model or enter a new name.

4. Click OK.

5. Select the model from the list.

6. Click Properties... to open a dialog box where you can define the settings for the import
file type you selected.

7. On the Parameters tab, enter the following information: 

• Select the Model type, which can be Analysis, Design or SP3D.

• Select CIS/1 or CIS/2 from the CIS version list.

• Enter the name of the model file in the Input file box.

You can also browse for the file.

• Set the origin coordinates to place the file in a specific location.

See also
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• To combine several elements in the CIS model into one part in Tekla Structures, set
Combine members to Yes.

• Use Max length for combining to define the maximum length for combining parts
(the maximum length of the combined parts together).

• Set Ignore offsets Yes if you want Tekla Structures to use member offsets to locate
the physical members.

• In Ignore forces, indicate how forces are imported.

• To also import part GUIDS, set Import GUID (design model) to Yes.

8. On the Conversion tab, enter the conversion file names or browse for the conversion
files.

9. Click OK to go to the Import Model dialog box.

10. Click Import. 

Tekla Structures displays the Import model info dialog box.

11. Select which version of parts to import.

12. Click Accept all. 

If you have changed the model and want to re-import it, you can also reject all changes
by clicking Reject all, or accept or reject individual changes by clicking Select
individual....

13. Tekla Structures displays the message Do you want to save the import model for
subsequent imports? Click Yes. 

Tekla Structures displays the import model in a model view.

14. Right-click the model view and select Fit work area to entire model to ensure that the
imported model is completely visible.

15. If parts are missing, check the View depth Up and Down values in the View Properties
dialog box and change them if necessary.

CAD model import settings on page 103

17.2 Exporting to a CIMSteel analysis model

To export to a CIMsteel analysis model:

1. Open a Tekla Structures model that you want to export.

2. Select the objects to export using the appropriate selection switches or filters.

3. Click File --> Export --> CIMSteel --> Analysis model... .

4. Select the CIS version from the CIS version list. 

• CIS/1 generates a file that is compatible with the CIMsteel LPM4DEP1 schema
declaration.

See also
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• CIS/2 generates a file compatible with the CIMSteel CIS/2
(STRUCTURAL_FRAME_SCHEMA) schema declaration.

5. Enter a name for the export file in the Step file box or accept the default. 

You can enter the path or browse for it. If you do not enter a path, Tekla Structures
creates the export file in the current model folder.

6. If required, enter the a name and organization to identify who created the export file.

7. From the Flavor list, select one of the following standards to apply to the export: UK,
EUROPEAN, or US.

8. Set units to metric or imperial in the Linear units (CIS/2 only) box. 

Imperial is only available for CIS/2. CIS/1 is always exported in metric units.

9. Enter coordinate values in Origin X, Y, and Z boxes if you want to export the model to a
specific location. 

The origin comes from the origin in Tekla Structures.

10. To split a part in the Tekla Structures model into several elements in the CIMsteel model,
set Split members to Yes. 

For example, three columns may be connected to a beam in a model, so that one column
is in the middle and the others are at each end of the beam. With the Yes option the
beam is split into two equal elements in the CIMsteel model. With the No option there
will be one beam, a single linear element, and two nodes (a node at each end) in the
CIMsteel model.

11. Click Apply and Create. 

Tekla Structures exports the CIMSteel analysis model to the current model folder, or to
another folder you specified, using the name you specified.

17.3 Exporting to a CIMSteel design/manufacturing model

To export to a CIS/2 CIMsteel design/manufacturing model:

1. Open a Tekla Structures model that you want to export.

2. Select the parts that you want to export.

3. Click File --> Export --> CIMSteel --> Design/manufacturing Model... .

4. Go to the Parameters tab and specify the required information: 

• Select the LPM version: LPM4 or LPM5.

• Enter name for the export file in the Output file box or accept the default.

You can enter the path or browse for it. If you do not enter a path, Tekla Structures
creates the export file in the current model folder.
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• Select the model type from the CIS/2 model type list. The options are
manufacturing, design, and SP3D.

• Set units to metric or imperial in the Linear units (CIS/2 only) box.

With Imperial units Tekla Structures writes all of the designations for nuts, bolts, and
washers in fractional inches.

• Enter a name for the structure in the Structure name field.

• Enter the path to the profile and material conversion files or browse for them.

If you leave the profile and material conversion file paths empty, Tekla Structures
uses the conversion files in the current profile folder for the conversion.

• To export globally unique IDs instead of internal ID numbers, set Export Globally
unique ID to Yes.

• If you want to export concrete parts, set Export concrete to Yes.

5. Go to the Standards tab, and select the appropriate profile, material, and bolt standard
organization, name and year. 

If you do not enter the standard organization or the name, Tekla Structures places an
empty entry ("") in the export file.If you do not give the year, Tekla Structures uses 1999
as the default value.

6. If you are exporting to a manufacturing model, go to the Manufacturing tab, and specify
the required information: 

• Set Include NC files to Yes to include information on NC files in the export.

• In NC file directory, specify the path (relative to the current model folder) to the
folder where the NC files are located.

7. If you are exporting to a design model, go to the Design model tab, and set Export
design connections to Yes to export design connections.

8. Click Apply and Create. 

Tekla Structures exports the CIMSteel design or manufacturing model to the current
model folder, or to another folder you specified, using the name you specified.

CIMSteel conversion files on page 137

CIMSteel conversion files

Here are examples of the contents of the conversion files used in CIMSteel conversion.

This example shows part of the profile conversion file prfexp_cis.cnv:

! US Imperial Flavor
! Profile name conversion Tekla Structures -> CIS
!

See also

Example 1
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! If Converted-name does not exist, it will be
! the same as Tekla Structures-name.
! Tekla Structures-name Converted-name
!
!American Sections - Imperial
!W - Wide Flange Beams
W44X335 S\SECT\US\W44X335\ASTM_A6\1994
W44X290 S\SECT\US\W44X290\ASTM_A6\1994
W44X262 S\SECT\US\W44X262\ASTM_A6\1994
Converted-name contains the following information, and items are separated by a backslash
(\):

• S (fixed value)

• SECT (fixed value)

• Name of the standardization organization

• Standard name of the profile shape

• Name of the standard

• Year of the standard

If the conversion file does not contain the relevant profile type, the Tekla Structures name of
the profile is used. Tekla Structures also uses the standardization organization, standard
name and year of standard defaults given on the Standards tab.

This example shows part of the material conversion file matexp_cis.cnv:

! US Imperial Flavor
! Material name conversion Tekla Structures -> CIS
!
! If Converted-name does not exist, it will be
! the same as Tekla Structures-name.
! Tekla Structures-name Converted-name

# Carbon Structural Steel (ASTM_A36\1994)
GRADE32 S\MAT\US\GRADE32\ASTM_A36-94\1994
GRADE36 S\MAT\US\GRADE36\ASTM_A36-94\1994
#High Strength Carbon Manganese Steel (ASTM_A529\1994
GRADE42 S\MAT\US\GRADE42\ASTM_A529-94A\1994)
Converted-name contains the following information, and items are separated by a backslash
(\):

Example 2
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• S (fixed value)

• MAT (fixed value)

• Name of the standardization organization

• Standard name of the material

• Name of the standard

• Year of the standard

Converted-name contains the following information about bolts, nuts, and washers,
separated by two colon characters (::):

• Name of the standards organization

• Name of the standard

• Year of the standard

• Standard name of the bolt, washer, or nut

Tekla Structures names for bolts, washers, and nuts are constructed from their fastener
standard, fastener type and size.

If the conversion file does not contain an equivalent profile name, Tekla Structures uses the
name of the material.

Exporting to a CIMSteel design/manufacturing model on page 136

Conversion files on page 28

See also
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18MIS

You can export model data to Manufacturing Information Systems (MIS). The MIS export
supports the following formats:

• DSTV

• FabTrol / KISS

• EJE

• EPC

• Steel 2000

We recommend using the FabTrol reports instead of the MIS export for exporting FabTrol
data. The FabTrol reports are available for the Steel Detailing role in the US imperial and
US metric environments. If you do not use a suitable environment you may also contact
your local support for the FabTrol files.

Exporting an MIS list on page 140

Information on MIS file types on page 141

18.1 Exporting an MIS list

To export an MIS list to a file:

1. Click File --> Export --> MIS... . 

The Export MIS dialog box opens.

2. Select the file type from the MIS type list.

3. If you selected Fabtrol/KISS or Steel 2000, define the additional options: 

See also
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• Fabtrol/KISS

Enter the customer name in the Customer name box.

Select the Full material list check box to add labor-related information to the list
(for example, holes, welds, cambers, preliminary marks).

• Steel 2000

Select the Export only shop bolts check box to include only workshop bolts in the
list file.

4. Enter a name for the list file in the MIS list file box. 

By default, the list file is saved in the model folder.

You can select the folder where you want to save the list file by clicking Browse....

5. Click Create all or Create selected to export the MIS list file.

Information on MIS file types on page 141

18.2 Information on MIS file types
See below for information on MIS file types.

• DSTV

The exported file contains the MIS information written in the DSTV format.

• EJE

US Imperial version only.

Structural Material Manager internally stores all dimensions in sixteenths. Its External
Data Interface writes all dimensions, such as widths and lengths, except for Beam and
Channel descriptions, in sixteenths of an inch.

As an example the length 12'-8 7/8 is equivalent to 2446 sixteenths, which is calculated
as (feet * 192) + (inches * 16) + (eighths * 2) = (12 * 192 + 8 * 16 + 7 *2).

• EPC

The EPC (Estimating and Production Control) module of SDS/2 requires multinumbering
to be active.

See also
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19 FabTrol XML

You can import fabrication status information for parts to a Tekla Structures model from an
XML file written by FabTrol.

FabTrol is a Material Resource and Planning (MRP) system commonly used by steel
fabricators to manage estimating, inventory and production. Data can be written to FabTrol
via a KISS format export or directly via the text based reports from Tekla Structures for
tracking of the assembly status through the project lifecycle. The tracking information
entered in FabTrol can then be re-imported back to Tekla Structures via the FabTrol XML
import for colorization of the model. This is performed by storing the data in a preset
collection of user-defined attributes (UDAs). Import of the FabTrol XML is possible in all
configurations of Tekla Structures (including Project Viewer) but data can only be saved into
the UDAs in modeling or management configurations.

You need to have the XMLTrans.trn file in the ..\ProgramData\Tekla
Structures\<version>\environments\<environment>\system folder.
This file maps the FabTrol XML names to Tekla Structures UDA names.

Importing a FabTrol XML file on page 142

19.1 Importing a FabTrol XML file

To import a FabTrol XML file:

1. Click File --> Import --> FabTrol XML... .

2. Click the browse button next to the Input file box to locate the XML file.

3. Select an appropriate option from the Create log file list: 

• Select Create to write a new log file and delete the previous log file each time you
import the XML file.

• Select Append to add the log file information is at the end of the existing log file.

• If you do not need a log file, select No.

4. Select an appropriate option from the Display log file list: 

• If you do not want to display the log file, select No.

See also
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• To display the log file, select On dialog.

5. Click Create to import the status information.

FabTrol XML on page 142See also
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20 NC files

NC (Numerical Control) refers to a method where machine tool operations are controlled
with a computer. The NC data controls the motion of CNC (computer numerical control)
machine tools. During the manufacturing process a machine tool or machining center drills,
cuts, punches or shapes the piece of material.

After you have finished detailing a Tekla Structures model, you can export the NC data as NC
files from Tekla Structures to be used by CNC machine tools. Tekla Structures transforms the
part length, hole positions, bevels, notches, and cuts into sets of coordinates that the
machine tools can use to create the part in a shop. In addition to the CNC machine tools, the
NC files can also be used by MIS and ERP software solutions.

Tekla Structures produces NC files in DSTV format. Tekla Structures can also produce NC files
in DXF format by converting DSTV files to DXF files.

The data for the NC files comes from the Tekla Structures model. We recommend that you
complete detailing and create drawings before producing the NC files.

Creating NC files in DSTV format on page 145

DSTV file description on page 144

Creating NC files in DXF format on page 162

20.1 DSTV file description
Tekla Structures produces NC files in DSTV format. DSTV format is an industrial standard
defined by the German Steel Construction Association (Deutsche Stahlbau-Verband).

A DSTV file is a text file in ASCII format. In most cases each part has its own DSTV file.

The DSTV file is divided into blocks that describe the content of the file.

DSTV block Description
ST Start of the file

EN End of the file

BO Hole

See also

Blocks
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DSTV block Description
SI Hardstamp

AK External contour

IK Internal contour

PU Powder

KO Mark

KA Bending

Profile types are named according to the DSTV standard.

DSTV profile type Description
I I profiles

U U and C profiles

L L profiles

M Rectangular tubes

R Round bars and tubes

B Plate profiles

CC CC profiles

T T profiles

SO Z profiles and all the other types of profile

Single letters in the DSTV file describe the part faces.

Letter Part face
v front

o top

u bottom

h behind

NC files on page 144

Creating NC files in DSTV format on page 145

20.2 Creating NC files in DSTV format
Tekla Structures produces NC files in DSTV format. You can also produce MIS (Manufacturing
Information System) list files according to the DSTV standard.

Profile types

Part faces

See also
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By default, Tekla Structures creates the NC files in the current model folder. In most cases
each part has its own NC file.

The DSTV standard does not support curved beams, and therefore Tekla Structures
does not create NC files for curved beams. Use polybeams instead of curved
beams.

To create NC files in DSTV format:

1. Click File --> Export --> Create NC Files... to open the NC Files dialog box.

2. Click a row that contains the NC file settings you want to use, and select the
corresponding check box in the Create column. 

Tekla Structures will create the NC files using the settings you have selected.

3. To modify the selected NC file settings, click Edit... to open the NC File Settings dialog
box. 

If you want to add new NC file settings, click Add....

4. If needed, modify the settings on the Files and part selection, Holes and cuts and Hard
stamp tabs. 

You can enter a unique name for the settings. Tekla Structures saves the settings in
the ..\attributes folder under the current model folder.

5. Click OK to save your NC file settings and to close the NC File Settings dialog box.

6. In the NC Files dialog box, use the All parts or Selected parts options to select whether
to create the NC files for all parts or only for the selected parts. 

If you use the Selected parts option, the parts need to be selected in the model.

7. Click Create. 

Tekla Structures creates .nc1 files for the parts using the selected NC file settings. By
default, the NC files are created in the current model folder. The filename consists of a
position number and the extension .nc1.

8. If all expected parts are not exported, check that the parts which were not exported pass
all the profile type, size, hole and other limits set in the NC file settings.

Defining the destination folder for NC files on page 146

Selecting the type of NC files to be created on page 148

Defining the selection criteria for parts in an NC file on page 148

Defining holes and cuts for an NC file on page 151

Creating hard stamps to an NC file on page 154

Fittings and line cuts in NC files on page 163

See also

NC files 146 Creating NC files in DSTV format



Defining the destination folder for NC files

By default, Tekla Structures creates the NC files in the current model folder. You can change
the destination folder, if needed.

To define the destination folder for NC files:

1. Click File --> Export --> Create NC Files... to open the NC Files dialog box.

2. Click a row that contains the NC file settings you want to use.

3. Click Edit... to open the NC File Settings dialog box for the selected settings.

4. Go to the Files and part selection tab.

5. Next to the File location box, click the Browse... button and browse for the location
where you want to save the NC file and click OK.

6. If needed, add a revision mark to the NC file name by selecting the Include revision
mark to file name check box. 

The file name then includes a number indicating the revision of the file, for example,
P176.nc1 becomes P176_1.nc1.

7. Click OK to close the NC File Settings dialog box.

You can enter a folder name or a relative path directly in the File location box.

When you use relative paths, use the advanced option XS_MIS_FILE_DIRECTORY to
control where the NC files and also the MIS files are created.

The following table shows where the NC files are created with different values entered in the
File location box when XS_MIS_FILE_DIRECTORY is set to C:\NC.

Relative path in File location NC files are created in
 C:\NC
.\ C:\NC\ModelName
.\MyFiles C:\NC\ModelName\MyFiles
C:\TEMP C:\TEMP

The following table shows where the NC files are created with different values entered in the
File location box, when XS_MIS_FILE_DIRECTORY is not set.

Relative path in File location NC files are created in
 model folder
.\ model folder
.\MyFiles model folder\MyFiles
C:\TEMP C:\TEMP

Creating NC files in DSTV format on page 145

Selecting the type of NC files to be created on page 148

Relative paths

See also
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Selection criteria settings in NC files on page 149

Selecting the type of NC files to be created
You can select whether the NC files include information in DSTV or in MIS format.

To select the type of NC files to be created:

1. Click File --> Export --> Create NC Files... to open the NC Files dialog box.

2. Click a row that contains the NC file settings you want to use.

3. Click Edit... to open the NC File Settings dialog box for the selected settings.

4. Go to the Files and part selection tab.

5. In the Create what list, select the type of files you want to create. 

Option Description
NC files Only DSTV files are created.

Part list Only an MIS list file (.xsr file) is created.

NC files and part list Both the DSTV files and an MIS list file are created.

Combined NC files and part list DSTV files are embedded in an MIS list file (.xsr
file).

6. If you create an MIS list file, enter a name for the list in the Part list file name box.

7. If you create an MIS list file, click the Browse... button next to the Part list file location
box and browse for the location where you want to save the list and click OK.

8. Click OK to close the NC File Settings dialog box.

Defining the destination folder for NC files on page 146

Defining the selection criteria for parts in an NC file on page 148

Defining the selection criteria for parts in an NC file
The selection criteria determine the part types and maximum sizes the machine tool is meant
to or able to process.

To define the selection criteria for parts:

1. Click File --> Export --> Create NC Files... to open the NC Files dialog box.

2. Click a row that contains the NC file settings you want to use.

3. Click Edit... to open the NC File Settings dialog box for the selected settings.

4. Go to the Files and part selection tab and to the Selection criteria for parts area.

5. Define Maximum size, Profile type and Maximum size of holes.

See also
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6. Click OK to close the NC File Settings dialog box.

Selection criteria settings in NC files on page 149

Defining the destination folder for NC files on page 146

Selecting the type of NC files to be created on page 148

Defining holes and cuts for an NC file on page 151

Creating hard stamps to an NC file on page 154

Selection criteria settings in NC files
Use the Files and part selection tab to define the selection criteria for parts in NC files.

The Maximum size options define the maximum length, width, and height of the parts the
machine tool can handle. Larger parts are sent to other machines.

All the profiles which are set to Yes in the Profile type list can be handled by the machine
tool.

Profile types are named according to the DSTV standard.

DSTV profile type Description
I I profiles

U U and C profiles

L L profiles

M Rectangular tubes

R Round bars and tubes

B Plate profiles

CC CC profiles

T T profiles

SO Z profiles and all the other types of profile

By default, Tekla Structures unwraps round tubes as plate profiles and uses the plate profile
type B in the NC file header data. To change this, use the advanced option 
XS_TUBE_UNWRAP_USE_PLATE_PROFILE_TYPE_IN_NC.

The DSTV standard does not support curved beams, and therefore Tekla Structures
does not create NC files for curved beams. Use polybeams instead of curved
beams.

See also

Maximum size

Profile type
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The Maximum size of holes options define how large holes the machine tool is able to drill.
The NC file is not created if a part contains larger holes or its material is thicker than the
specified values. The hole size is connected to material thickness or plate thickness.

Each row contains the maximum hole diameter and the material thickness. Both conditions
have to be met for the NC file to be created. For example, a row with the values 60 45
means that when the material thickness is 45 mm or smaller, and the hole diameter is 60 mm
or smaller, the NC file is created. You can add as many rows as needed.

The following example shows how the Maximum size of holes can be defined. In this
example, we have the following situation:

• Three plates of different thickness.

• Two bolt groups with equal sizes, and one bolt group with a larger size.

Maximum size of holes are defined as follows:

Test1 creates a folder under the model folder for the plates that meet the following
criteria:

• Hole diameter: 22
• Plate thickness: 10
Test2 creates a folder under the model folder for the plates that meet the following
criteria:

• Hole diameter: 22
• Plate thickness: 20
When you create NC files for the plates, the folder Test1 includes the plate PL350*10
and the folder Test2 includes the plate PL350*20. The plate PL350*15 is not included
in any folder, because the hole size criterion is not met.

The order in which you enter the criteria is important: enter the most exclusive
criteria first. If you define the criteria in a different order, the results will also be
different.

Defining the selection criteria for parts in an NC file on page 148

Maximum size of
holes

Example

See also
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Defining holes and cuts for an NC file

To define the holes and cuts for an NC file:

1. Click File --> Export --> Create NC Files... to open the NC Files dialog box.

2. Click a row that contains the NC file settings you want to use.

3. Click Edit... to open the NC File Settings dialog box for the selected settings.

4. Go to the Holes and cuts tab.

5. Define the needed properties.

6. Click OK to close the NC File Settings dialog box.

Hole and cut settings in NC files on page 151

Defining the selection criteria for parts in an NC file on page 148

Creating hard stamps to an NC file on page 154

Hole and cut settings in NC files
Use the Holes and cuts tab to define the hole settings in NC files.

The Inner corners shape options define the shape of, for example, web notches or flange
cuts at the beam end.

The examples in the table below show how the different inner corner shape options affect
the part in the NC file. The original part in the model has flanges cut entirely and the web is
notched:

Option Example Description
0 Radius

The inner corners are shaped like holes with a
given radius. A separate BO block is not
written to the NC file.

See also

Inner corner
shape
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Option Example Description
1 Tangential

The inner corner is rounded according to the
value in the Radius box.

2 Square

The corner is as it is in the model.

3 Drilled hole

A drilled hole is added to the inner corner.
The hole radius is the same as the value in
the Radius box. Holes are written as a
separate BO block to the NC file.

4 Tangential drilled hole

A drilled hole is added tangentially to the
inner corner. The hole radius is the same as
the value in the Radius box. Holes are
written as a separate BO block to the NC file.

The inner corner shape also affects cuts on the flange.
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The inner corner shape is not applied to rectangular openings, which are in the
middle of a part:

The inner corner shape does not apply to those inner contours which are already rounded in
the model. The model values remain intact.

The Distance from flange within which web is not cut option defines the height of the
flange clearance area. The clearance check only affects the I, U, C, and L DSTV profile types.

If a cut in a part is located closer to the flange than the clearance in the model, the cut
points inside that clearance are moved to the border of the clearance area when the NC file
is written.

Model NC file
The part how it is modeled.

The cut goes closer to the top flange than the defined
flange clearance in the NC file settings.

The part how it is written in the NC files.

The dimension shows the clearance. The top of the
original cut is moved so that the clearance area is left
free. The bottom of the cut is not moved.

The Machine slot as options define the how slotted holes are created.

Option Description
Ignore slots Slotted holes are not created in the NC file.

A single hole in the center of the slot Drills a single hole in the center of the slotted hole.

Four small holes, one at each corner Drills four smaller holes, one at each corner.

Distance from
flange within

which web is not
cut

Machine slots as
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Option Description
Internal contours Flame-cuts the slots as internal contours.

Slots Leaves slots as they are.

The Maximum diameter for holes to be drilled option defines the maximum hole diameter.
Holes and slotted holes that are larger than the maximum hole diameter are manufactured as
internal contours.

Defining holes and cuts for an NC file on page 151

Creating hard stamps to an NC file
NC files can include hard stamps for the workshop. Hard stamps are text marks that contain
information about parts and assemblies, for example, project and lot number, phase, or part
and assembly position.

To create hard stamps to an NC file:

1. Click File --> Export --> Create NC Files... to open the NC Files dialog box.

2. Click a row that contains the NC file settings you want to use.

3. Click Edit... to open the NC File Settings dialog box for the selected settings.

4. Go to the Hard stamp tab.

5. Select the Create hard stamp check box.

6. In the Available elements list, select the contents to be included in the hard stamp.

7. Click OK to close the NC File Settings dialog box.

Hard stamps can be created for both the main part and the secondary parts. By default, Tekla
Structures creates hard stamps only for the main part. Set the advanced option 
XS_SECONDARY_PART_HARDSTAMP to TRUE to also create hard stamps for secondary
parts.

This example shows a hard stamp that contains the elements Phase, Part position, Material,
and Text.

Hard stamp settings in NC files on page 154

Defining the selection criteria for parts in an NC file on page 148

Defining holes and cuts for an NC file on page 151

Maximum
diameter for

holes to be
drilled

See also

Example

See also
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Hard stamp settings in NC files
Use the Hard stamp tab to define the properties of hard stamps for NC files.

The Elements list defines which elements are included in hard stamps and the order in which
the elements appear in the hard stamp.

Element Description
Project number Adds the project number to the hard stamp.

Lot number Adds the lot number to the hard stamp.

Phase Adds the phase number to the hard stamp.

Part position Prefix and position number of the part.

Assembly position Prefix and position number of the assembly.

Material The material of the part.

Finish The type of finish.

User-defined attribute Adds a user-defined attribute (user fields 1-4) to the mark.

Text Opens a dialog box where you can add user-defined text to the
hard stamp.

If you include part position and/or assembly position in the hard stamp, they affect the NC
filename:

• Part position: P1.nc1, P2.nc1
• Assembly position: A1.nc1, A2.nc1
• Assembly and part position: A1-P1.nc1, A2-P2.nc1

The Position along the part and Position in depth of part options define the position of
hard stamps on parts.

These options move the hard stamp on the same face it is created, but they cannot move the
stamp to a different face. If the face is, for example, the bottom flange, you can move the
stamp to a different place on bottom flange, but not to the top flange.

Profile Default face
I profile Bottom flange (u)

U and C profiles Back side of web (h)

L profiles Back (h) or Bottom (u)

Rectangular tubes Bottom flange (u)

Round bars Bottom flange (u)

Circular tubes Front (v)

T profiles Back side of web (h)

Hard stamp
content

Hard stamp
placing
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Profile Default face
Plate profiles Front (v)

If you set the advanced option XS_HARD_STAMP_BY_ORIENTATION_MARK to any
value, the default face is changed from bottom (u) to top (o) for L profiles, rectangular tubes
and round bars.

Creating hard stamps to an NC file on page 154

20.3 Customizing NC file header information
You can customize the order in which information is displayed in an NC file, and add
additional information on individual parts in the NC file header.

To customize NC file header information:

1. Click File --> Export --> Create NC Files...

2. Click the Header... button in the NC Files dialog box.

3. In the NC File Header Information dialog box, arrange the file header information
options in the desired order by selecting the option and using the Move up and Move
down buttons.

4. If needed, add additional information on individual parts. 

See also
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You can enter text in the Text info on piece 1 - 4 boxes, and enter desired template
attributes in double angle brackets, for example <<WEIGHT>> to display the weight of
the part

5. Click OK.

6. Create the NC files.

7. If you want to restore the default file header information, click the Default button in the
NC File Header Information dialog box.

Creating NC files in DSTV format on page 145See also
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20.4 Pop-marks in NC files

Pop-marks are small holes that help the shop assemble individual parts to form an assembly.
Tekla Structures can write the pop-mark information in NC files to help position parts that
will be manually welded to the assembly main part. Pop-marks are usually made using a
drilling machine that drills a small hole in the surface of the material.

Tekla Structures only creates pop-marks for parts for which you have defined pop-mark
settings. You can save the pop-mark settings in a .ncp file, which Tekla Structures saves by
default in the ..\attributes folder under the current model folder.

Pop-marking affects numbering.

For example, if two parts have different pop-marks, or one part has pop-marks and
the other one does not, Tekla Structures gives the parts different numbers.

Tekla Structures displays thick red lines for each pop-mark pair in the model view which was
last updated.

If needed, pop-marks can also be displayed in drawings. In drawings, select the on/off check
box in the part properties to display the pop-marks.

Creating pop-marks in NC files on page 158

Creating pop-marks in NC files

To create pop-marks in an NC file:

1. Click File --> Export --> Create NC Files .

See also
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2. In the NC Files dialog box, select the parts for which you want to create the pop-marks
by selecting the corresponding check boxes in the Pop-marks column.

3. Click the Pop-marks... button in the NC Files dialog box. 

The Pop-Mark Settings dialog box appears.

4. Click Add to add a new row.

5. To define which parts are pop-marked and where the pop-marks are created, click each
item in a row. 

The order of the rows in the Pop-Mark Settings dialog box is important. Enter
the most limiting definition first, and the most generic one last.

a. In the Main part profile type list, select the main part profile type that is pop-
marked. The list contains profiles according to the DSTV standard.

b. In the Main part name column, enter the name for the main part profiles. You can
enter several part names separated by commas, for example, COLUMN, BEAM. 

You can use wildcards (* ? [ ] ). For example, HE* matches all parts with a profile
name that begins with the characters "HE".

c. In the Sec part profile type list, select the secondary part profile type.

d. In the Secondary part name column, enter the name for the secondary part profiles.
You can enter several part names separated by commas. 

You can use wildcards (* ? [ ] ).

e. In the Pop-mark location list, select how the secondary part is projected onto the
main part. 

• Left side: The left side of the secondary part is marked on the main part. The left
side is the side of the secondary part that is closest to the start point of the main
part.

• Right side: The right side of the secondary part is marked on the main part.

• Both sides: Combines Left side and Right side.

• Center: Center of the secondary part.

• Left side holes: Marks the main part with the position of holes in the secondary
part, on the left side of the secondary part.

• Right side holes: Marks the main part with the position of holes in the secondary
part, on the right side of the secondary part.

• Both side holes: Combines Left side holes and Right side holes.

• Middle line: Marks two points on the middle line of the secondary part x axis.

f. In the Move to flange list, select to which part of the main part flange the pop-
marks are moved.
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g. In the Edge distance column, enter the minimum distance from a pop-mark to the
edge of the main part. Tekla Structures does not create pop-marks inside this
distance. 

If a pop-mark is inside the defined edge distance, Tekla Structures moves it, unless
you have set Pop-mark location to Center.

h. In the Secondary pop-marks list, select whether pop-marks are created to the
secondary parts.

6. To display pop-marks in a model view, go to the Pop-marking options tab and select
Show pop-marks in the model.

7. Click OK.

8. Select the parts in the model.

9. Click Create in the NC Files dialog box.

Pop-marks are written in the BO block in the DSTV file as 0 mm diameter holes.

Tekla Structures marks the center point of all round secondary profiles on a main part, and
does not create pop-marks closer than 10 mm to the main part edge.

Tekla Structures projects the hole location in the secondary plates onto a main part.

Pop-marks in NC files on page 157

20.5 Contour marking in NC files
Tekla Structures can generate contour marking in NC files. This means that information on
the layout and the parts that are welded together can be added to the NC files and passed on
to the machine tool.

Tekla Structures only creates contour markings for parts for which you have defined contour
marking settings. You can save the contour marking settings in a .ncs file, which Tekla
Structures saves by default in the ..\attributes folder under the current model folder.

You can add contour marking to both the main and the secondary parts.

Examples

See also
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Contour marking affects numbering.

For example, if two parts have different contour markings, or one part has contour
markings and the other one does not, Tekla Structures gives the parts different numbers.

Creating contour marking in NC files on page 161

Creating contour marking in NC files

To create contour marking in an NC file:

1. Click File --> Export --> Create NC Files .

2. In the NC Files dialog box, select the parts for which you want to create the contour
marks by selecting the corresponding check boxes in the Contour marking column.

3. Click the Contour marking button in the NC Files dialog box. 

The Contour marking settings dialog box appears.

4. Click Add to add a new row.

5. To define which parts are contour marked and how they are contour marked, click each
item on a row.

a. In the Main part profile type list, select the main part profile type that is contour
marked. The list contains profiles according to the DSTV standard.

b. In the Main part name column, enter the name for the main part profiles. You can
enter several part names separated by commas, for example, COLUMN, BEAM. 

You can use wildcards (* ? [ ] ). For example, HE* matches all parts with a profile
name that begins with the characters "HE".

c. In the Sec part profile type list, select the secondary part profile type.

d. In the Secondary part name column, enter the name for the secondary part profiles.
You can enter several part names separated by commas. 

You can use wildcards (* ? [ ] ).

e. In the Secondary contour marking list, select whether the secondary parts are
contour marked.

f. In the Punch or powder list, select how the part is contour marked. 

• Punch: The part is punched.

• Powder: The part is marked with powder.

• Both: Both techniques are used.

g. In the Hard stamp list, select whether hard stamps are created.

See also
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h. Select whether you want to mark parts that are welded on site in Mark parts welded
on site.

6. Click OK.

7. Select to create files for all parts or selected parts.

8. Click Create in the NC Files dialog box.

Contour marking is written in the PU and KO blocks in the DSTV file.

Tekla Structures displays contour marking as thick magenta lines in the model view.

Contour marking in NC files on page 160

20.6 Creating NC files in DXF format
You can also create NC files in DXF format by converting DSTV files to DXF files. Before
running a DXF conversion, you must first create the NC files in DSTV format.

To convert DSTV files to DXF files:

1. Create the NC files in the DSTV format.

2. Click Tools --> Macros .

3. In the Macros dialog box, select Convert_DSTV2DXF.

4. Click Run to open the Convert DSTV Files to DXF dialog box.

5. Browse to the folder that contains the NC files you want to convert to DXF files.

6. Select the NC files and click Open. 

See also
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Tekla Structures automatically creates an NC_dxf folder in the model folder and the
DXF files are created there.

If you want to check the converted DXF files, select Yes in the dialog box that appears
after the DXF files have been created. The DXF files open in Tekla DWG Viewer.

The macro has been designed for simple plates. Therefore it may not give
correct conversion results for beams, columns and bent polybeams.

Alternatively, you can use a separate Tekla Structures program dstv2dxf.exe to convert
the DSTV files to DXF format. The program is located in the ..\Tekla Structures
\<version>\nt\dstv2dxf folder. Only one side of a part (front, top, back or bottom)
is written to the file, and therefore this export format is most suited to plates.

To start the conversion:

1. Create a folder for the NC files, for example c:\ dstv2dxf.

Do not use spaces is the folder path. You should not save the files, for example, in the
Tekla Structures folder under the Program Files folder, because the folder path contains
spaces.

2. Copy all files from C:\Program Files\Tekla Structures\<version>\nt
\dstv2dxf to the folder you created (C:\dstv2dxf).

3. Save the NC files in the in the folder you created (C:\dstv2dxf).

4. Double-click a suitable dstv2dxf_conversion.bat file.

The program converts the files to DXF format in the same folder.

If you need to adjust the conversion settings, modify the settings in an appropriate
dstv2dxf.def file and restart the conversion.

For more information on settings, see the DEF File Description.pdf document in
the same folder.

Creating NC files in DSTV format on page 145

20.7 Fittings and line cuts in NC files

When creating NC files in DSTV format, the method you use to cut the end of the beam
affects the beam length in the NC file:

• Fittings affect the length of the beam in the NC file.

• Line cuts do not affect the length of the beam in the NC file.

Creating NC files
using

dstv2dxf.exe
program

See also

NC files 163 Fittings and line cuts in NC files



When you cut the beam end, use the fitting method to make sure that the beam length is
correct in the NC file.

The overall length of a beam will be the fitted net length of the beam. This means that Tekla
Structures always takes the fitting into account when calculating beam length. For lines,
polygons, or part cuts, the cut does not affect beam length, but the overall length in the NC
file will be the gross (initially modeled) length of the beam.

If you want to use the shortest possible length in an NC file, use the advanced option 
XS_DSTV_NET_LENGTH.

If you want to include both net and gross length into NC file header data, use the advanced
option XS_DSTV_PRINT_NET_AND_GROSS_LENGTH.

Creating NC files in DSTV format on page 145

XS_DSTV_NET_LENGTH

XS_DSTV_PRINT_NET_AND_GROSS_LENGTH

20.8 Creating tube NC files

To be able to create NC files for tubular hollow sections, you need to first use the specific
tube components to create the tube-to-tube and tube-to-plate connections:

• Tube-Chamfer (1)

• Tube-CrossingSaddle (1)

• Tube-MitreSaddle+Hole (1)

• Tube-Saddle+Hole (1)

• Tube-SlottedHole (1)

After using the components, you can create an NC file for data export. The tube NC file
creation results into an XML file which includes the model data.

To create tube NC files:

1. Click File --> Export --> Create Tube NC Files... to open the Tube NC Files dialog box.

2. Enter a name for the export file, and browse for the location where you want to save the
file.

3. Select whether you want to create the file for selected parts or for all parts.

4. Click Create. 

Tekla Structures creates an XML file and a log file in the location you defined.

Shortest length

Net and gross
length

See also
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To get the correct tube NC export results, note the following limitations:

• Part cuts and polygon cuts are not supported, and they will not be exported.

• Line cuts and fittings created manually or by other components will be
exported as simple chamfers.

• Holes created by bolts are not supported, and they will not be exported.

Tube-Chamfer (1)

Tube-CrossingSaddle (1)

Tube-MitreSaddle+Hole (1)

Tube-Saddle+Hole (1)

Tube-SlottedHole (1)

See also
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21 HMS

HMS stands for Hollowcore Manufacturing System and it is developed in the Netherlands.
You can export data of hollow core slabs from Tekla Structures to HMS. HMS uses the data in
manufacturing processes.

Exporting to the HMS format on page 166

HMS Export: Project data tab on page 167

HMS Export: Slab scope tab on page 168

HMS Export: Slab data tab on page 167

21.1 Exporting to the HMS format
You can export model data of hollow core slabs to a HMS format. The result is a .sot file.

To export to the HMS format:

1. Select the model objects that you want to include in the export.

2. Click File --> Export --> HMS... . 

The HMS Export dialog box opens.

3. Define the export properties as required.

4. Click the browse button.

5. Browse to the folder where you want to save the file.

6. Enter a name for the file.

7. Click Save.

8. Select the Add revision to file name check box and select the revision number if
required. 

The revision number is added to the HMS export file as follows:

hms_export_file{revision}.sot

See also
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9. Select the Open log file after export check box if you want to see the log after export. 

HMS Export creates the log file in the file export folder.

10. Click Export to create the HMS export file.

HMS Export: Project data tab on page 167

HMS Export: Slab scope tab on page 168

HMS Export: Slab data tab on page 167

21.2 HMS Export: Project data tab

You can include project data, such as customer name and site address, in the HMS export
file.

The Project data tab contains the following options for determining how to export project
data:

• Empty

The item is not included in the HMS export file.

• Text

Enter the text in the box next to the item.

• Project UDA

The data comes from the project’s user-defined attributes.

• Project Object, Project Address, Project Info

The data comes from the project information.

Exporting to the HMS format on page 166

21.3 HMS Export: Slab data tab

You can include information on slabs in the HMS export file.

The following options are available in the Slab data tab:

Option Description
Position Number Assigned Control Number (ACN) is the only option.

Slab Remarks, Element Type
& End Label

The options are:

• Empty

The item is not included in the HMS export file.

See also

See also
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Option Description
• Text

Enter the text in the box next to the item.

• UDA

The data comes from the project’s user-defined attributes

Slab Name The options are:

• Profile

Select to export the whole profile name.

• Thickness

Select to export only the profile height.

Slab Mark The options are:

• Assembly position

Select to export the complete cast unit position.

• Assembly serial number

Select to export the cast unit serial number only.

Slab Weight Units Select the weight unit.

Live/dead load Enter the default live/dead load to be exported.

For hollow core slab calculation, you can define a default live
load/ dead load (KN/m2) for slabs.

If you do not define this data here, you must enter the default
values for each slab in HMS software later.

Exporting to the HMS format on page 166

21.4 HMS Export: Slab scope tab

You can include information on steel parts in the HMS export file.

The following options are available in the Steel parts tab:

Option Description
Exclude parts Enter the class of the model object in the Class list

box to exclude the data.

Hook Points, Electric boxes, Weld plate
and Solid fill

Enter the class of the model object in the Class list
box to include the data.

Filled area Enter the class of the model object in the Class list
to export as filled area.

Export Hook Box Select to include hook data.

See also
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Option Description
Exclude strands from export Select to exclude strands from export.

Export inner cores Select to include detailed information on hollow
cores.

Include full cut to contour Select to include full cut in the contour block (CO).
If not selected, the full cut is written as an
individual cut (SP).

Export HP name Select to export hook point names. If you do not
select this option, only the XY coordinates are
exported.

The hollow core slab in the model. It will be exported to HMS.

Include full cut to contour check box is selected:

Example
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Include full cut to contour check box is not selected:

Exporting to the HMS format on page 166See also
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22 ELiPLAN

Elematic ELiPLAN is a software for resource planning, scheduling, and management for
precast concrete fabricators.

ELiPLAN import and export automates the data transfer between Tekla Structures and
ELiPLAN. The data transfer consists of four parts:

1. Exporting ELiPLAN data file from Tekla Structures.

2. Importing ELiPLAN data file into ELiPLAN.

3. Exporting ELiPLAN status data file from ELiPLAN.

4. Importing ELiPLAN status data file into Tekla Structures.

The import of an ELiPLAN data file into ELiPLAN supports the incremental approach, which
means that ELiPLAN is able to create, update, and delete parts in its database. This means
that precast detailers can export the most up-to-date data files whenever the Tekla
Structures model has been changed.

Similar incremental support is included in the import of an ELiPLAN status data file to Tekla
Structures. To keep the status and schedule data up to date in a Tekla Structures model, we
recommend you update the status data regularly.

The format and contents of the ELiPLAN status data file imported to Tekla Structures
differs from the data file that is exported from Tekla Structures to ELiPLAN.

Importing an ELiPLAN status data file on page 171

Exporting an ELiPLAN data file on page 172

See also
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22.1 Importing an ELiPLAN status data file
If you have a status data file that has been created in ELiPLAN, you can import it to your
Tekla Structures model.

To import status and scheduling information from ELiPLAN to Tekla Structures:

1. Click File --> Import --> EliPlan... to open the Import Eliplan status data dialog box.

2. Click the browse button next to the Import file name box to locate the file to be
imported.

3. Click Create. 

Tekla Structures updates the status and schedule data for parts in the Tekla Structures
model. When the data is read, a log file is displayed.

The log file shows the parts whose data is updated correctly. It also provides information
on possible problems that may have occurred. When you select a row in the log file, Tekla
Structures automatically selects the corresponding part in the model. The overall status
information is shown at the end of the log file.

Tekla Structures stores the actual status data in the user-defined attributes of the parts. To
view the data, open the part properties dialog box, click the User-defined attributes...
button and go to the EliPlan tab.

ELiPLAN on page 171

Exporting an ELiPLAN data file on page 172

22.2 Exporting an ELiPLAN data file

To export ELiPLAN data from Tekla Structures:

1. If needed, add ELiPLAN information to the parts’ ELiPLAN user-defined attributes.

2. Click File --> Export --> EliPlan... to open the Export EliPlan file dialog box.

3. Define the ELiPLAN export properties on the Parameters, Plotter data and Data content
tabs.

4. Set Scope of export to All.

5. Click Create. 

By default, a file called eliplan.eli is created in the current model folder, in a .
\EP_files subfolder.

ELiPLAN user-defined attributes on page 173

ELiPLAN export: Parameters tab on page 174

ELiPLAN export: Plotter data tab on page 176

See also

See also
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ELiPLAN export: Data content tab on page 176

ELiPLAN user-defined attributes
In addition to normal model data, you can add additional information in the user-defined
attributes of the parts. The additional information can be transferred from Tekla Structures
and used in ELiPLAN.

The product type affects how ELiPLAN considers the part dimensions length, length2, deltaL,
width, height, and thickness.

To set the product type, select a suitable product type option from the list. If needed, you can
override the product type value set in the dialog box:

• You can enter a value for the user-defined attribute EP_TYPE in the objects.inp
file.

• You can enter a value for the user attribute EP_TYPE in the Profile Catalog.

In the Profile Catalog the attribute value is given as a number. The values are as follows:

• Slab = 1

• Beam = 2

• Column = 3

• Wall = 4

• Sandwich wall = 5

• Stair = 6

You have alternative ways to give the product code. The ELiPLAN export tries to define the
product code in the following order:

Product type

Product code
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1. You can enter a value for the product code in the ELiPLAN user-defined attributes dialog
box.

2. You can enter a value for the user-defined attribute EP_CODE of the cast unit main part
in the objects.inp file.

3. You can enter a value for user attribute EP_CODE in the Profile Catalog.

4. You can use the data conversion file to convert parametric profile names to a product
code.

5. You can use the main part name as a product code.

Precast parts are erected in a certain sequence. Use the sequence to help the scheduling of
the production in ELiPLAN. You can give the estimated erection sequence by giving the
sequence number for parts.

Set this option to Yes when the designer or detailer has finished the part and the part is
ready for production. The default is No, which means that the data is transferred to ELiPLAN
for preliminary planning only, and the part is not sent for production until the attribute is set
to Yes and a new file is transferred to ELiPLAN.

The Eliplan status data is meant to be read-only information and used to visualize the data
in a Tekla Structures model.

Exporting an ELiPLAN data file on page 172

ELiPLAN export: Parameters tab on page 174

ELiPLAN export: Plotter data tab on page 176

ELiPLAN export: Data content tab on page 176

ELiPLAN export: Parameters tab
Use the Parameters tab to control the ELiPLAN export properties.

Option Description
Scope of export Select whether all parts or only selected parts are exported.

Because of the incremental import of ELiPLAN, you need to select
the same parts, and some additional parts again, if needed, when
exporting the next time. Otherwise ELiPLAN assumes that the
parts missing from the subsequent file have been deleted in the
Tekla Structures model.

We recommend you to always use the All option. Use the
Selected option only in special cases or when you are exporting
parts for the first time.

Erection
sequence

Ready for
production

Eliplan status
data

See also
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Option Description
Export version number Select whether IDs or GUIDs are used in the export.

The use of GUID depends on the ELiPLAN version. You need to
check with Elematic that the latest version of ELiPLAN is in use to
benefit from the GUID transfer capabilities.

The default is ID. All versions of ELiPLAN support the use of ID.

Output file name The name and location of the export file created. The default
name is eliplan.eli. You can import this file into ELiPLAN.

The eliplan.eli file includes, among other things, material
information. The accessory code, which is the material
description, is in the #Materials section.

The accessory code is based on the material type as follows:

• For concrete material the default accessory code is same as
the material name.

• For mesh, reinforcing bars, or strands the default accessory
code is grade|size.

• For embedded material the default accessory code is name|
size|material.

Data conversion file With this file you can convert the parametric profile names into
the ELiPLAN product codes, and the material descriptions into the
ELiPLAN accessory codes. The default file name is
eliplan_export.dat and this file can be located in your
model, XS_FIRM or XS_PROJECT folder.

The data conversion file eliplan_export.dat contains
string pairs separated with one or more tabs. The string on the
left side is the profile name or Tekla Structures material
description and the string on the right side is the corresponding
ELiPLAN data.

Note that the ELiPLAN codes depend on the fabricator and the
codes that are valid for one fabricator are likely not valid for
other fabricators.

List of classes to be ignored A list of classes to be excluded from the export. This contains the
class numbers used for concrete parts. Separate the classes with
a space.

List of classes to be ignored
(Material)

A list of classes to be excluded from the export. This contains the
class numbers used for materials. Separate the classes with a
space.

List of classes to be ignored
(Concrete)

A list of classes to be excluded from the export. This contains the
class numbers used for secondary concrete parts. Separate the
classes with a space.

Create log file Select whether a log file is created.
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Option Description
Log file name The name and location of the created log file.

Exporting an ELiPLAN data file on page 172

ELiPLAN user-defined attributes on page 173

ELiPLAN export: Plotter data tab on page 176

ELiPLAN export: Data content tab on page 176

ELiPLAN export: Plotter data tab
Use the Plotter data tab to control the ELiPLAN export properties.

Option Description
Export of cutout data Select how to export cutout data. The options are:

• All: Exports all data.

• Full depth cuts only: Exports data only on the cuts that go
through the whole part.

• None: Does not export any cutout data.

Overlapping cutouts are combined in the export file.

Export of embed data Select how to export data of embeds. The options are:

• Yes: Exports data on embeds.

• No: Does not export any data on embeds.

Exclude cut parts by Use to exclude cut parts from export based on the cut part
properties.

You can define one or more values for the selected property.

Exporting an ELiPLAN data file on page 172

ELiPLAN user-defined attributes on page 173

ELiPLAN export: Parameters tab on page 174

ELiPLAN export: Data content tab on page 176

ELiPLAN export: Data content tab
Use the Data content tab to control the ELiPLAN export properties.

See also

See also
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Option Description
Export material data Select whether to include or exclude the detailed material

data (receipt) of parts.

If you have no use for material data in ELiPLAN (you have no
material handling module in ELiPLAN), select No to exclude
the data from the file and to reduce the file size.

Note that once you have transferred the file with the material
data (Yes) you should never switch off (No) the export of
material data in subsequent exports. If you do this, the
receipt is also cleared in the ELiPLAN database and all
modifications are lost.

Export rebar bending data Select whether to include or exclude the detailed rebar
bending information.

If you do not need this data in ELiPLAN, select No to exclude
the data from the file and to reduce the file size.

Note that once you have transferred the file with the rebar
bending data (Yes) you should never switch off (No) the
export of rebar bending data in subsequent exports.

Unit for rebar length Select the unit for the length of reinforcing bars.

No. of digits after decimal
point

Select the number of digits after the decimal point.

The default is 2 digits after the decimal point.

Tag for lifters Use to identify lifting loops by their name. Enter the name of
the lifting loop.

When lifting loops are identified, the plotter instruction type
is changed from WPL to LL.

Position number type Select whether to export the cast unit position number, or the
assigned control number (ACN).

Remove numbering separator Select whether a position number separator is used in
numbering. The default is No.

Exporting an ELiPLAN data file on page 172

ELiPLAN user-defined attributes on page 173

ELiPLAN export: Parameters tab on page 174

ELiPLAN export: Plotter data tab on page 176

See also
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23 BVBS

You can export reinforcement geometry to BVBS (Bundesvereinigung Bausoftware) format.
The result is a text file in ASCII format. The supported version of the BVBS format is 2.0 year
2000.

You can export bent reinforcing bars, reinforcing bar groups and polygonal or rectangle non-
bent meshes. The export of hooks is also supported.

Exporting to the BVBS format on page 178

23.1 Exporting to the BVBS format

You can export reinforcement geometry to the BVBS format. The result is an ASCII file.

Before you start, make sure that numbering is up to date.

To export reinforcement to BVBS format:

1. Click File --> Export --> BVBS... .

2. On the Parameters tab:

a. Use the Model objects to be exported list to select which reinforcement you want
to export.

b. Select how to export drawing data. 

• Select a source for the drawing name in Drawing name source.

• To use a fixed drawing name in the export, select Fixed text in Drawing name
source and enter the required name in the Fixed drawing name box. Enter the
drawing revision number in the Rev box.

c. Select how the reinforcement is exported. 

See also
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• To export information on all reinforcement in one file, select Single file. To

browse for the file, click the  button.

• To export information on reinforcement in each cast unit in a separate file, select
One file per each cast unit.

d. Select the BVBS elements to be exported by selecting the appropriate check boxes in
BVBS elements to be exported.

3. On the Advanced tab:

a. Select an option in the Try to make meshes of rebars list to define if the export tries
to automatically form meshes of single reinforcing bars or bars of a reinforcing bar
group and export them as a mesh instead of separate 2D bars. 

In order to form a mesh the reinforcing bars need to belong to same part, be straight,
be in same plane, and to have equal filtering attribute values.

b. If you selected Yes, group rebars by UDA, enter UDA name for grouping.

c. In Exporting of mesh bar data (@X..@Y..), select an option to control whether the
detailed data of mesh bars is included in the exported data of the mesh.

d. If you select Yes in Export stepped bars as separate items, all tapered reinforcing
bar groups are exported as multiple separate bar items even when they have regular
spacing and could be exported as one single stepped bar item.

e. Use Sort items to define the order of the items in the output file.

f. With Private data block you can control whether the private data block is exported
and select the data items for this additional block. 

Data fields can be any report properties, user-defined attributes, or object properties.

Click the New button to add new predefined items to the list. Enter information
about the data item.

4. On the Checking tab:

a. Select whether you want to enter the required minimum and maximum cutting
length of the reinforcing bars.

5. Click Export.

BVBS Export: Parameters tab on page 182

BVBS Export: Advanced tab on page 180

BVBS Export: Checking tab on page 183

See also
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Reinforcing bar length calculation in BVBS

The length of the reinforcing bar is calculated according to the BVBS specification. The
length also depends on the bending angle. Lengths L1 and L2 are exported.

If you set the advanced option 
XS_USE_USER_DEFINED_REBAR_LENGTH_AND_WEIGHT to TRUE, the user-defined
length value is exported as the overall length for the reinforcing bar.

Note that the BVBS format specifications define that the overall length of the bar is ignored
if the data contains actual geometry data. Some other software applications may still use the
overall length values in the BVBS file for calculating quantities. The exported overall length
in Tekla Structures is the same length as shown in reports.

BVBS on page 178

Exporting to the BVBS format on page 178

23.2 BVBS Export: Advanced tab
Use the Advanced tab to control the BVBS export properties.

See also
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Option Description
Try to make meshes of rebars Select whether the export tries to automatically form meshes

of a single reinforcing bar or of a group reinforcing bars and
export them as a mesh instead of separate 2D bars.

In order to form a mesh the reinforcing bars need to belong
to the same part, be straight, be on the same plane, and have
equal filtering attribute values.

UDA name for grouping If you selected Yes, group rebars by UDA, enter the UDA
name for grouping.

Exporting of mesh bar data
(@X..@Y..)

Use this option to control whether the detailed data on mesh
bars is included in the exported data of the mesh. The
appropriate option depends on the needs and capabilities of
the receiving system. The data is needed if it will be used, for
example, for mesh fabrication.

• Custom and cut catalog meshes only

Detailed bar data is included only for custom meshes and
catalog meshes that have additional cuts, openings or
skewed edges.

• All meshes

Detailed bar data is written for all meshes.

• None meshes

Detailed bar data is not written to any of the meshes.

Export stepped bars as separate
items

If you select Yes, all tapered reinforcing bar groups are
exported as multiple separate reinforcing bar items even if
they have regular spacing and could be exported as one single
stepped reinforcing bar item.

Sort items Use this option to define the order of the items in the output
file(s).

Private data block With Private data block you can control whether the private
data block is exported and select the data items for this
additional block. Data fields can be any report properties,
user-defined attributes, or object properties.

Click the New button to add new predefined items to the list.
Enter information about the data item.

• Name in list

The text shown in the Private data block list.

• Field identifier

The field code which separates the individual data fields
in the private data block. It can be any lower case letter.
Typically, it is a good practice to use a different value for
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Option Description
each data item but this is not required. The receiving
system may also be able to read only certain data fields.

• Property or UDA name

The value defines which data will be inquired from the
reinforcement object. Note that a non-existing property
will be not exported.

• Property data type

The value has to match the actual selected property.

Exporting to the BVBS format on page 178

BVBS Export: Parameters tab on page 182

BVBS Export: Checking tab on page 183

23.3 BVBS Export: Parameters tab
Use the Parameters tab to control the BVBS export properties.

Option Description
Model objects to be exported Select which reinforcing bars or meshes are exported.

• Reinforcement of all cast units in the model

Exports reinforcing bars or meshes in all cast units in the
model. If there are cast units that do not have reinforcing
bars or meshes, no empty files are created.

• Reinforcement of selected cast units

Exports reinforcing bars or meshes in the cast units you
have selected in the model.

• Selected reinforcement only

Exports the reinforcing bars or meshes you have selected in
the model. When you select this option, you can export only
to a single file.

• Reinforcement of all cast units in the model (totals by
all positions)

Exports reinforcing bars or meshes in all the cast units that
have the same cast unit position as any of the selected cast
unit positions.

For example, if a cast unit with the cast unit position 
W-120 is selected, the reinforcing bars or meshes in all the

See also
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Option Description
cast units that have position W-120 are exported even
though not all of them were selected.

Excluding reinforcement by
filter

Exclude reinforcing bars or meshes by selecting any of the
selection filters. Reinforcing bars or meshes that match the
filter are excluded.

Drawing name source Define the drawing name used in the export.

Fixed drawing name Enter a name to be used for the drawing in the export.

This option is available only when you have selected the option
Fixed text in Drawing name source.

Rev Drawing revision (index).

This option is available only when you have selected the option
Fixed text in Drawing name source.

Single file Export all BVBS information into one file. Enter the file name in
the box or click the ... button to browse for the file.

One file per each cast unit Export each cast unit to its own file.

The files are created under the folder that you define in the
Folder name box, or you can browse for the folder using the ...
button.

Use the File naming template list to select how the created
files are named.

BVBS elements to be exported Select which item types are exported.

If you select Lattice girders (BFGT), enter the class numbers
used in the model for the lattice girder bars in the Class
numbers for girder box. The lattice girder may contain two or
three chord bars and one or two diagonal zig-zag bars. The
lattice girder is exported as one item in the BVBS file.

Exporting to the BVBS format on page 178

BVBS Export: Advanced tab on page 180

BVBS Export: Checking tab on page 183

23.4 BVBS Export: Checking tab
Use the Checking tab to control the BVBS export properties.

See also
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Option Description
Check cutting length Select whether you want to run an additional check for the

minimum and maximum cutting length of the reinforcing
bars.

When you select the Check cutting length check box, and
the cutting length of the exported reinforcing bar is less
than the minimum cutting length or greater than the
maximum cutting length, a warning is written to the export
log file.

The log file entry contains the ID number of the reinforcing
bar. You can locate the reinforcing bar in the model by
selecting the appropriate row in the log file. Note that the
reinforcing bar is still exported normally and only the
additional warning is given.

Exporting to the BVBS format on page 178

BVBS Export: Parameters tab on page 182

BVBS Export: Advanced tab on page 180

See also
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24 Unitechnik

You can export the 3D geometry of the cast units to the Unitechnik format. The result is a
text file in ASCII format. Supported versions of the Unitechnik format are:

• 6.1.0 beta

• 6.0.0 14.6.2005

• 5.2b 11.9.2000

• 5.0c 30.10.1997

You can export cast units consisting of concrete, steel and surface materials. Exporting of
reinforcing bars (bent and not-bent), reinforcing bar groups and meshes with hooks is also
supported. You can also export braced girders, solid, sandwich and double walls.

Exported cast unit:Example
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Hole

Steel embed

Reinforcing bars

Insulation plate (green)

Exporting to the Unitechnik format on page 187

Unitechnik export: Main tab on page 187

Unitechnik export: TS configuration tab on page 191

Unitechnik export: Embeds tab on page 201

Unitechnik export: Reinforcement tab on page 206

Unitechnik export: Reinf. checking tab on page 213

Unitechnik export: Reinf. data specification tab on page 214

Unitechnik export: Data specification tab on page 215

Unitechnik export: Line attributes tab on page 216

Unitechnik export: Pallet tab on page 219

Unitechnik export: Log files tab on page 220

See also
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24.1 Exporting to the Unitechnik format

You can export the 3D geometry of the cast units to the Unitechnik format. The result is a
text file in ASCII format.

To export to the Unitechnik format:

1. Update numbering. 

Export Unitechnik reads and exports data from the numbering series of parts. It is
important that all exported parts are numbered correctly. Incorrectly numbered parts are
not exported.

2. Click File --> Export --> Unitechnik... to open the Export Unitechnik dialog box.

3. Define the Unitechnik export properties on the different tabs.

4. Click Create. 

By default, output files are created in the current model folder. The number of output
files depends on the options selected in the Create from list on the Main tab, and the
total number of selected parts, cast units, or assemblies

Cast units whose cast unit type is cast-in-place are not exported.

Unitechnik on page 185

Unitechnik export: Main tab on page 187

Unitechnik export: TS configuration tab on page 191

Unitechnik export: Embeds tab on page 201

Unitechnik export: Reinforcement tab on page 206

Unitechnik export: Reinf. checking tab on page 213

Unitechnik export: Reinf. data specification tab on page 214

Unitechnik export: Data specification tab on page 215

Unitechnik export: Line attributes tab on page 216

Unitechnik export: Pallet tab on page 219

Unitechnik export: Log files tab on page 220

24.2 Unitechnik export: Main tab
Use the Main tab to control the Unitechnik export properties.

Limitations

See also
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Option Description
Unitechnik version Select the Unitechnik version.

Create from Select which parts or cast units are exported.

• Selected cast units

Only cast units that have one or more parts selected in the
model are exported. Each cast unit has one output file.

• All parts

All cast units are exported. Each cast unit has one output
file.

• Selected parts (separately)

Only the selected concrete parts (also embeds and insulation
parts belonging to the selected part) are exported. Each part
has one output file.

• Selected parts (cast united)

Selected parts belonging to one cast unit are grouped and
exported together in one output file.

• Selected assemblies

All selected assemblies are exported. One assembly equals
one cast unit and has one output file. Selection of
subassemblies is also allowed.

• By CU id

Each cast unit has its own output file.

• By CU pos

Identical cast units share an output file.

Parts excluded from export
(classes)

If you do not want to export some parts, enter the classes of the
parts. Parts with classes in this list will not be exported.

Directory path Define where the export files are saved. The default folder is
\UT_Files under the current model folder.

File name Select the name of the output file and file name extension.

• Cast_unit_number is the assembly position number of the
main part of the cast unit.

• Cast_unit_pos is the assembly position of the main part of
the cast unit.

• Ass_control_number is the assembly control number. To
generate the assembly control numbers, click Drawings &
Reports --> Numbering --> Assign Control Numbers... .

• user_extension is the file name extension defined with the
Ext file name property.
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Option Description
• Factory indicates the factory in which the cast unit will be

produced.

• ID_user_extension is the ID number, which is 10 characters
long. If the ID number is not 10 characters long, zeros are
added in front of the ID number to make it 10 characters
long. For example, id number 456999 will be 
0000456999.

• (number) is the amount of characters that the property can
contain. For example, (5) means that the property can
contain only 5 characters. If there are less than 5 characters,
zeros are added in front of the property. If there are more
than 5 characters, characters at the beginning of the number
series are deleted.

Ext file name The file name extension, if File name is set to an option
containing .user_extension.

File mask The format (length) of the output file name and file name
extension. Numbers represent the length of the output string. If
the name is longer than the selected option, it is cut.

Open folder after export Select whether the folder where the output file is saved is
opened after the export.

Output file structure Structure of the exported file (slab date and layer part).

• Multiple layers

One SLABDATE block with N layers. Each cast unit has its
own LAYER block. Embeds, reinforcement and insulations
belong to one concrete part, and they are exported to the
related LAYER block.

• 1 slabdate block, 1 part

Each cast unit has its own SLABDATE block, no LAYER
blocks.
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Option Description

• N slabdate blocks, n parts

Cast units with equal geometry are collected in one 
SLABDATE block. No LAYER or LOT blocks are defined.
Embeds, reinforcement and insulation belonging to a cast
unit with the same geometry are collected and exported in
one SLABDATE block.

• 1 slabdate block, n parts

All similar wall shells are defined within one SLABDATE
block instead of being defined in a separate SLABDATE
block per wall shell. The option is useful when exporting
special embeds.

1st exported layer Select which part is exported in the first LAYER. This option
allows to define which wall shell is positioned on the pallet first.

The options are:

• Main part (of cast unit)

• Biggest part

• Heaviest part
Consider layer split
thicknesses

Select how the layers of the cast unit are exported. These options
are available when you have set Output file structure to
Multiple layers.

• No

The cast unit is exported as one volume.
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Option Description
• Yes

The different layers set on the Unitechnik user-defined
attributes of a part are taken into consideration, and the cast
unit is exported in two or three layers.

Blank symbol in exported
file

Select the blank symbol to be used in the export file.

An example with "_" symbol:

An example with " " symbol:
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24.3 Unitechnik export: TS configuration tab
Use the TS configuration tab to control the Unitechnik export properties.

See also
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Option Description
Rotation Select the scanning direction. Unitechnik export uses scanning layers to

obtain the geometry of all parts in a cast unit.

The scanning direction depends on the plane of the cast unit main part.
A floor panel is scanned from bottom to top side. A wall panel and a
column are scanned from one side to the other side. The position and
direction of a basic shape of the exported cast unit depends on the
rotation.

No

Floor: Bottom to top

Wall: Front to rear side

Column: Side to side

180

Floor: Top to bottom

Wall: Rear to front side

Column: From one side to the opposite side

 +90 around X

Floor: Left to right side

Wall: Top to bottom

Column: Side to side
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Option Description

 -90 around X

Floor: Right to left side

Wall: Bottom to top

Column: From one side to the opposite side

-90 around Y

Floor: Rear to front side

Wall: Right to left side

Column: Top to bottom
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Option Description
 Examples of rotation:

• Wrong scanning plane (from the right side to the left side):
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Option Description
• Correct scanning plane (from back to front side):

Extra rotation Select the rotation around the z coordinate. The z coordinate has the
same direction, but the x and y directions are changed.

To show the actual coordinate system, set Draw pallet axis to Yes on
the Pallet tab.

• No

No extra rotation.

• Swap X/Y

Swap x and y axis.

• X=max(X_dim,Y_dim) main part

X axis goes through the longer side of the main part.

• X=min(X_dim,Y_dim) main part

X axis goes through the shorter side of the main part.

• X=max(X_dim,Y_dim) cast unit

X axis goes through the longer side of the cast unit.
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Option Description
• X=min(X_dim,Y_dim) cast unit

X axis goes through the shorter side of the cast unit.

• +90 around Z

Rotates x and y axis around the z axis by 90 degrees.

• - 90 around Z

Rotates x and y axis around the z axis by -90 degrees.

• 180 around Z

Rotates x and y axis around the z axis by 180 degrees.

The following example shows the coordinate system with no rotation
and no extra rotation settings. Panel 1 has the z axis set parallel to the
shorter side. It is incorrect in the Unitechnik format, so the coordinate
system has to be rotated. Panel 2 shows a rotation by 90 degrees around
the z axis.

Scan position The number of the scanning layers depends on the selected scan
position. Each object of the cast unit is scanned in one direction.

Select the position in which all parts are scanned. Each part is scanned
separately. Scanning plane is parallel to the basic shape plane.

• Bottom and top

Two scanning planes at the start and at the end of the bounding box
of the scanning part.
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Option Description
• Bottom only

One scanning plane at the start of the bounding box of the scanning
part.

• Top only

One scanning plane at the end of the bounding box of the scanning
part.

• Middle only

One scanning plane at the middle of bounding box of the scanning
part.

To move the position of the exact scanning plane, use the boxes below
to define start offset and end offset.

Merge
CONTOUR layers

You can export one scanned layer only. With two scanned layers, they
have to be merged into one layer.

• Intersection

Creates polygon intersection of two contour geometries.
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Option Description
a. First scanned layer

b. Second scanned layer

c. Layer

• Union

Creates polygon union of two contour geometries.

Merge CUTOUT
layers

The same as Contour export, but for holes only.

Extend contour
and add
formwork

Select whether to extend the contour by embeds which are outside the
element.

Name for
additional
formwork
(embed)

Define a name for the embed.

Geometry
export

Select whether the geometry of the exported part is represented as
polygons or lines.

Polygons exported:
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Option Description
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Option Description
 Lines exported:

Draw scanned
geometry

The exported geometry can be shown with Draw scanned geometry.
This property shows the inside lines of the exported reinforcing bars.

Select whether you want to check if the geometry of the exported parts
is correct. It shows the lines representing the exported rectangle of the
basic shape, the exported geometry of parts, cuts, embeds, and
reinforcement. Embeds are projected to the plane of the basic shape. The
reinforcement lines are positioned inside each reinforcing bar.
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Option Description

1. Basic shape

2. Geometry of the main element

3. Cut geometry

4. Embed geometry

Double wall
turned

Select whether the first shell of a double wall on the pallet is turned.
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24.4 Unitechnik export: Embeds tab
Use the Embeds tab to control the Unitechnik export properties.

Option Description
Normal embeds Select which parts are considered as embeds. Embedded parts are

exported in the MOUNPART block.

If the embed block consists of several parts, it is useful to weld all
embeds into one block and then connect the created block with a
concrete part to a cast unit. Subassemblies are also supported.

• Selected + steel

All classes listed in the Embeds classes box are considered as
embeds. All steel parts are also considered as embeds.

• Selected

Classes listed in the Embeds classes box are only considered as
embeds.

• No export

Ignores the Embeds classes box and exports all steel parts as
standard parts.

Embeds classes Enter the classes for embeds.

Export assemblies Select how embeds and steel blocks are exported.

Embeds are exported as parts. All embedded welds and assembly
relations are ignored.

Welded embeds and the assembly block are exported as one part.

Only the main part of the embedded block or embedded assembly is
exported.
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Option Description

The main part of the embedded block extended in the x direction to
cover all the parts of the embedded block is exported.

Only the bounding box around the main part of the embedded block
or embedded assembly is exported.

Def export code Define how the insertion point and the direction for embeds is
calculated. Possible values are 1, 2, 3, 11, 12, 21, 22, 23, 31 and
32.

Cut outer assemblies Select how the embedded parts that are outside the concrete
element are exported.

All parts in the embed are exported.

Only the embedded parts that are inside of the concrete element are
exported. Embedded parts that are outside the concrete element are
ignored. If an embedded part is partly inside a concrete element, the
exported geometry of the embedded part is changed to cut.

Same as the previous option, but only embedded parts with class
defined in Cut outer only classes are taken into account.

Cut outer only classes Enter the classes of parts whose geometry is changed to cut when
you have selected the last option in the Cut outer assemblies list.

Special assemblies
export / Special export
assembly file name

The options affect the exported geometry of the embeds. The real
geometry is replaced by the geometry defined in text files. The
default name of the text file is spec_assemblies_def.txt
and is searched for in the model folder. Use Special export
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Option Description
assembly file name to define the name and the location of the text
file.

Required structure of the text file is:

• Name(text) Number_of_lines_defined(number)
• S(representing single line)

Start_coors(number number)
End_coors(number number)

• S(representing single line)
Start_coors(number number)
End_coors(number number)

Example of the file:

The geometry of all embeds (from example with names Quicky,
QuickyS, E-Doze) are replaced by geometry defined in the text file.
In the following example, the part number 1 (the name is Beam)
was not found in the text file so the geometry is exact. On the
opposite side the part number 2 (the name is Quicky) was found, so
the geometry is replaced.
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Option Description
Embed Z position Select the embed z position.

Alternatively, you can use the spec_assemblies_def.txt
file to set the position of the embeds.

For example:

Insulation classes Define the insulation classes. Parts with classes in this list will be
exported as insulation parts. All parts considered insulation are
exported in the MOUNPART block.

Electric tubes classes Define the electric tubes classes. Parts with classes in this list will
be exported as MOUNPART with lines geometry.

Opening embed classes Define the opening embed classes. Parts with classes in this list will
be exported as normal embeds in the MOUNPART block. The
geometry will not be considered in the CONTOUR and CUTOUT
blocks of the concrete part.

Opening cutout classes Define the opening cutout classes. Parts with classes in this list will
be exported only in regard to their geometry in the CUTOUT block
of the concrete part. They will not be exported in the MOUNPART
block.

Type of mounting part You can define the type of mounting part in the MOUNPART block
using a user-defined attribute.

Reference number You can define the reference number of a mounting part in the 
MOUNPART block using a user-defined attribute.

Export insulation Select whether insulation parts are exported in the MOUNPART
block as embeds or in the SLABDATE block as concrete panels.

Export surface Select whether surfaces are exported in the MOUNPART block as
embeds or in the SLABDATE block as concrete panels.

Mountpart name Enter the installation identification for the MOUNPART block.
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24.5 Unitechnik export: Reinforcement tab
Use the Reinforcement tab to control the Unitechnik export properties.

You can export single reinforcing bars, groups of straight and bent reinforcing bars, and
rectangular or polygonal or bent meshes. The reinforcing bar group, or rectangular or
polygonal mesh is divided into several single reinforcing bars. All reinforcing bars are
exported in the RODSTOCK block.

Option Description
Rebars export When set to Yes, straight reinforcing bars are exported. Hooks are

supported.

Bent rebars export When set to Yes, bent reinforcing bars are exported. Hooks are
supported.

Meshes export When set to Yes, polygonal or rectangular meshes are exported.
Hooks are supported.

Bent meshes export When set to Yes, bent meshes are exported.

Braced girder export When set to Yes, reinforcing bars or steel rods representing braced
girders are exported separately in the BRGIRDER block.

When set to No and Rebars export is set to Yes, straight reinforcing
bars representing braced girders are exported as reinforcing bars
and steel rods are exported as mounted parts.

Braced girder classes Enter the class of reinforcing bars, steel rods or profiles representing
braced girders. For example, 15 17 5 means that parts with class
15, 17, or 5 are considered braced girders. If the Braced girder
export and Braced girder classes boxes are not used, the braced
girders will be exported incorrectly as reinforcement or embeds.

Braced girder type Select the string value of girder type field in the BRGIRDER block
in the exported file.

• Empty

No string is exported.

• Name

The name of the braced girder type is exported. If the name of
the top part of a braced girder is empty, the names of the rods
are checked.
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Option Description
• UDA

You can export the user-defined attribute values for a braced
girder type (type), braced girder article number
(art_number), or braced girder fabricator name
(fabricator).

The UDAs can be added to the braced girder if the parts have
been created using the system component Braced girder (88)
or Braced girder (89) and you have entered the needed values
on the dialog boxes of the components.

• User defined text

The value you enter in the box next to this option is exported.

Reinforcement export
type

Define the structure of the exported file for reinforcement.

Plant with lying robot only

All embeds without modifications are exported.

Fabrication of welded rebars

If Export type is set to Fabrication of welded rebars, a single
reinforcing bar is exported in one STEELMAT block, all reinforcing
bars of one group are exported together in one STEELMAT block,
and all reinforcing bars of one mesh are also exported together in
one STEELMAT block.

The structure of the output file (one SLABDATE is shown only):
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Option Description

 Collect reinforcement

The structure of the output file is the same as for Fabrication of
welded rebars. This option allows you to collect mesh, single
reinforcing bars and reinforcing bar groups into groups exported in
one STEELMAT block. The groups are collected based on the
Collect based on field. You can also collect meshes which belong to
different cast units.
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Option Description
1 (orange color): The mesh belongs to the bottom panel of the cast
unit, mesh name is MESH1.

2 (blue color): Two single bars, the name is MESH1.

3 (green color): One reinforcing bar group belongs to the top panel,
the name is MESH1.

If Reinforcement export type is set to Collect reinforcement and
Collect based on is set to Name, all three different reinforcement
types are collected into one mesh, which is exported in one 
STEELMAT block.

Meshes as MOUNPART

Meshes are exported in the MOUNPART block.

Collect based on Select how meshes are collected. Meshes with one bar are exported
as a single reinforcing bar.

• Name

Meshes, single reinforcing bars and reinforcing bar groups with
the same name are collected into meshes. Meshes, single
reinforcing bars and reinforcing bar groups with the same name
equals one mesh in the exported file.

• Class

Meshes, single reinforcing bars and reinforcing bar groups with
the same class number are collected into meshes. Meshes, single
reinforcing bars and reinforcing bar groups with one class
number equal one mesh in the exported file.

• Grade

Meshes, single reinforcing bars and reinforcing bar groups with
the same grade are collected into meshes.

• UDA

Meshes, single reinforcing bars and reinforcing bar groups with
the same user-defined attribute are collected into meshes.

The value you enter in the box next to this option is the UDA
value.

Collect if distance is
lower then

Define the maximum distance between the meshes to be collected.
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Option Description
Reinforcing bars length Select how the reinforcing bar length is calculated.

• Lines in the middle
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Option Description
 • Lines at the edge
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Option Description
 • GetValue(Length)

Reinforcing bars diameter Select how the reinforcing bar diameter is exported.

This selection affects the results of the Rebar length option.

Reinforcement types Select the reinforcing bar type in a mesh to be exported.

1 and 2 are for the rods in the bottom layer.

5 and 6 are for the rods in the top layer.

4 is for other or inclined rods.

8 is for loose bars.

Classes for loose rebars
type 8

Enter the classes of loose reinforcing bars to be collected. The bars
are a part of a mesh and are exported as reinforcing bar type 8.

Rebar direction angle
limit

Select whether the reinforcing bars are sorted according to their
angle direction.

• No

The reinforcing bars are not sorted.

• From 0 to 180

The reinforcing bars are exported as they are read from Tekla
Structures and sorted according to their x and y position.
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Option Description
• From 0 to 180 ordered

The reinforcing bars are sorted according to the direction angle
of the reinforcing bar: the reinforcing bars with lower angles are
first.

• From 180 to 0 ordered

The reinforcing bars are sorted according to the direction angle
of the reinforcing bar: the reinforcing bars with higher angles
are first.

Add mesh stabilizing
wires

Select whether to add wires to the reinforcement mesh to stabilize
the mesh. Use for meshes with large openings.

Stabilization wire max
spacing

Enter a value to define the maximum spacing of the wires that
stabilize the reinforcement mesh.

Meshes sort Select whether meshes are sorted.

Meshes offset Select whether the mesh has an offset defined in the STEELMAT
block. If the option is set to Yes, the value for X and Y direction is
set to zero. If the option is set to No, the X and Y values are
exported according to modeled situation.
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24.6 Unitechnik export: Reinf. checking tab
Use the Reinf. checking tab to control the Unitechnik export properties.

Option Description
Rebar diameter limitation Minimum and maximum diameter for the reinforcing bars to be

exported.

See also
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Option Description
Rebar length limitation Minimum and maximum length for the reinforcing bars to be

exported.

Export others Select whether the reinforcing bars that do not meet the above
limitations are exported as loose reinforcing bars of type 4 or 8, or
whether the diameter and length limitations are ignored.

Unitechnik on page 185

Exporting to the Unitechnik format on page 187

Unitechnik export: Main tab on page 187

Unitechnik export: TS configuration tab on page 191

Unitechnik export: Embeds tab on page 201

Unitechnik export: Reinforcement tab on page 206

Unitechnik export: Data specification tab on page 215

Unitechnik export: Line attributes tab on page 216

Unitechnik export: Pallet tab on page 219

Unitechnik export: Log files tab on page 220

24.7 Unitechnik export: Reinf. data specification tab
Use the Reinf. data specification tab to control the Unitechnik export properties.

Option Description
Article number rebar Select which property you want to export as a reinforcing bar article

number in the STEELMAT block.

Article number mesh Select which property you want to export as a mesh article number
in the STEELMAT block.

Meshes designation Select what information you want to export about the meshes in 
STEELMAT block.

Info text Information fields (1-2) in the STEELMAT or CAGE blocks are
filled with the selected data.

Unitechnik on page 185

Exporting to the Unitechnik format on page 187

Unitechnik export: Main tab on page 187

Unitechnik export: TS configuration tab on page 191

Unitechnik export: Embeds tab on page 201

Unitechnik export: Reinforcement tab on page 206

See also

See also

Unitechnik 214 Unitechnik export: Reinf. data specification tab
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24.8 Unitechnik export: Data specification tab
Use the Data specification tab to control the Unitechnik export properties.

Option Description
Name of order Order fields in the HEADER block are filled with the selected data.

Name of component Component fields in the HEADER block are filled with the selected
data.

Drawing number Drawing number fields in the HEADER block are filled with the
selected data.

Product code Product code fields in the HEADER block are filled with the
selected data.

Project line3 text Project information fields (3rd line) in the HEADER block are filled
with the selected data.

Project line4 text Project information fields (4rd line) in the HEADER block are filled
with the selected data.

File creator You can select to export the Tekla Structures version information or
user-defined text in the HEADER block.

Slab number Slab number field in the SLABDATE blocks is filled with the
selected data.

Transport unit number,
Transport sequence
number

Define a value for the transport unit and sequence numbers in the 
SLABDATE blocks.

Info 1 text (60) - Info 4
text (60)

Information fields (1-4) in the SLABDATE and MOUNPART blocks
are filled with the selected data.
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Unitechnik export: Reinf. data specification tab on page 214
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24.9 Unitechnik export: Line attributes tab
Use the Line attributes tab to control the Unitechnik export properties. Sometimes line
attribute values that are exported in the Unitechnik files are not suitable for the particular
situation. For example, to preserve lightness in the model, you might have fewer chamfers in
the model than there will be in the actual structure. For this reason, you might want to
override some line attributes in the export so that the model remains light, but the exported
Unitechnik files are correct. You can do this by using the options on the Line attributes tab.

Option Description
Export line attributes for
contour

Select whether the line attribute values are used for contours
(Export line attributes for contour) or for holes (Export line
attributes for cutouts) in the export.

• None

Line attribute values are not used.

• All lines

Line attribute values are used for all lines.

• Outmost lines only

Line attribute values are used only for the outermost lines in the
part:

This option is available only for contours.

Border line overriding You can enter up to six border line modifications in the line
attribute export.

No border lines are overridden.
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Option Description

Vertical outermost border lines at the start are overridden.

Horizontal outermost border lines at the bottom are overridden.

Vertical outermost border lines at the end are overridden.

Horizontal outermost border lines at the top are overridden.

Vertical outermost border lines are overridden.

Horizontal outermost border lines are overridden.

Horizontal and vertical outermost border lines are overridden.
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Option Description
 

All inclined outermost border lines are overridden.

All outermost border lines are overridden.

All vertical border lines, except the outermost border lines are
overridden.

All horizontal border lines, except the outermost border lines are
overridden.

All vertical and horizontal border lines except the outermost border
lines are overridden.

All border lines except outermost border lines are overridden.

All border lines except the horizontal and vertical outermost border
lines are overridden.
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Option Description

All border lines are overridden.

Orig. attr, New attr. Define the original attribute (Orig. attr) and the attribute that will
be used in the export (New attr.).

In the example below the horizontal outermost border line at the
top would get a line attribute value 0033 originally, but the value
will be overridden, and the line attribute value in the Unitechnik file
will be 0040.

Export line attributes for
cutouts

Select whether the line attributes are exported for holes.
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24.10 Unitechnik export: Pallet tab
Use the Pallet tab to control the Unitechnik export properties.

See also
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Option Description
Draw pallet axis Select whether to show the coordinate system. The axes are

displayed with dotted lines.

Wall to pallet checking Select whether the export checks the wall size against the pallet
size.

If you select the Yes, if exceeded, do not export option, the Pallet
width, Pallet length and Max. cast unit thickness options cannot
be empty.

Pallet width Define the pallet width.

With the help of pallet width and length the Wall to pallet
checking option can check if a wall element is too big and does not
fit to a pallet. If the wall element does not fit to a pallet, the wall
element is turned.

Pallet length Define the pallet length.

Max cast unit thickness Define the maximum cast unit thickness.

To avoid collision with the drying chamber, the maximum thickness
of a cast unit should be smaller than the maximum opening of the
drying chamber.
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24.11 Unitechnik export: Log files tab
Use the Log files tab to control the Unitechnik export properties.

Option Description
Log file directory path Define the path for a log file. If the path is empty, then the log file

is saved in the same location as the export files.

See also
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Option Description
Create main Log file Select whether to create a one main log file.

Create Log file for each
file

Select whether a log file is created separately for each export file.

Write history to log file
and UDA

Create a log file containing the history of the exported parts. The
information is also written to the UDA UT_export_history of
the main part. The following data is gathered: export time, part
information, export path and file, and who has performed the
export.

Show error dialog boxes Select whether an error message is shown when exported parts are
not numbered correctly or when the embedded parts have no parent
part.

Unitechnik on page 185

Exporting to the Unitechnik format on page 187

Unitechnik export: Main tab on page 187

Unitechnik export: TS configuration tab on page 191

Unitechnik export: Embeds tab on page 201

Unitechnik export: Reinforcement tab on page 206

Unitechnik export: Reinf. checking tab on page 213

Unitechnik export: Reinf. data specification tab on page 214

Unitechnik export: Data specification tab on page 215

Unitechnik export: Line attributes tab on page 216

Unitechnik export: Pallet tab on page 219

See also
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25 Layout Manager

Use Layout Manager to import and export layout data between Tekla Structures and a field
layout device. Layout Manager enables you to use accurate model data on the construction
site.

The image below illustrates the phases in the field layout workflow.

First define layout points and layout lines in your model, and
organize them in suitable groups in Layout Manager. We
recommend that you first set up the groups in Layout
Manager, then model the points and lines and organize them
in the groups. The points and lines are used in a layout device
on the construction site to position parts correctly.

Once you have defined the layout data, you can export the
data from Layout Manager to a field layout device in three
different export formats: point file (.txt), job file (.cnx),
and field link file (.tfl).

You can check and measure the positions of the exported
layout points (design points) on the site using a field layout
device. The layout device helps you to position the parts
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correctly on the site, as the points along the part boundaries
can be placed to the correct locations.

To place the part boundaries correctly, measure the as-built
positions of the parts on the site and create measured points
along the part boundaries.

When you have measured the as-built positions and created
measured points, you can import the points to Tekla Structures.
You can first preview the points in Layout Manager.
Finally, you can view the measured points in the model.

To import and export directly with a handheld mobile device such as Trimble® LM80, you
need to connect your computer to the device. Your computer needs to have software that
enables it to communicate with a mobile device. For information on how to connect your
computer to Trimble layout devices, see the Trimble website.

Creating a group in Layout Manager on page 223

Creating a layout point on page 225

Creating a layout line on page 226

Viewing groups, layout points and layout lines on page 227

Exporting from Layout Manager on page 227

Importing to Layout Manager on page 230

25.1 Creating a group in Layout Manager
You can create groups in Layout Manager to organize layout points and layout lines
suitably.

To create a group in Layout Manager:

1. Click Tools --> Layout Manager... .

2. Right-click Layout Manager Object Group and select Add Group. 

You may want to set up several groups so that you can organize the points and lines into
groups as they are modeled.

3. If needed, click the group to rename it. 

A group name can have 18 characters.

Layout Manager may show an Unassigned group in the tree structure. The Unassigned
group shows layout points and layout lines that have inadequate group information. Such
points and lines have usually been created in an earlier Layout Manager version.

See also
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Defining numbering settings for groups in Layout Manager on page 224

Defining a local coordinate system for a group in Layout Manager on page 224

Defining numbering settings for groups in Layout Manager
You can define that all groups in Layout Manager have the same numbering settings. When
you change the settings, the changed settings are used in all the groups you create after the
change. The settings in the existing groups are not changed.

To define numbering settings for groups:

1. Click Tools --> Layout Manager... .

2. Click Settings > Group.

3. Define the numbering settings.

a. Enter the prefix in the Prefix box.

b. Enter the starting number in the Starting number box.

c. Enter the maximum length of the number in the Number max length box.

d. Enter a delimiter to separate the prefix and the number in the Delimiter box: a
hyphen or an empty space.

e. Select from the Fill leading space list whether the leading space in front of the
number is filled with zeroes or not, for example, PFX 00001 or PFX 1

4. Click OK.

5. To apply the numbering settings to the points and lines in a group, right-click the group
and select Auto Naming.

You can modify the numbering settings of an individual group if you do not want to use
the default settings. Select the group and change the settings in the property pane. To
restore the default settings, click Reset.

Creating a group in Layout Manager on page 223

Defining a local coordinate system for a group in Layout Manager
You can define a local coordinate system for each group. Local coordinate systems may be
relative to a municipal monument or to the local project site datum. In many cases, models
may already be properly placed so that no local coordinate system needs to be defined.

To define a local coordinate system for a group:

1. Click Tools --> Layout Manager... .

See also

See also
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2. Select a group.

3. Define the coordinates using the Group local coordinate system options in the property
pane.

a. Click the Pick button next to the Location box and pick the origin in the model.

b. Click the Pick button next to the Axis X box and set the x direction in the model.

c. Click the Pick button next to the Axis Y box and set the y direction in the model.

4. Click Set.

You can set the work plane using a command in View --> Set Work Plane . When you
have set the work plane, select a group in Layout Manager. Click the Pick button next to
the Use current work plane option under Group local coordinate system and click Set.

Creating a group in Layout Manager on page 223

25.2 Creating a layout point
Use the Layout Point tool in the Component Catalog to create layout points. The layout
points that you create in the model are design points that you can export to a layout device.

Before you start, ensure that the Select components selection switch is activated.

To create a layout point:

1. Double-click the Layout Point tool in the list of components in the Component Catalog.

2. Define the properties of the layout point on the Parameters tab.

a. Enter a name and a description for the layout point. 

The following special characters are allowed in layout point names:_ ~ % ! @ #
& . = + - and space.

Note that the maximum length of the name is 16 characters if you export layout
data to .cnx and .tfl formats. When exporting to a text file, there is no
limitation to the number of characters in the name. The maximum length of the
description is 24 characters.

b. Enter the diameter of the layout point. 

Layout Manager uses the XS_IMPERIAL advanced option to determine the units.
Set XS_IMPERIAL to TRUE to show imperial units.

c. Select whether the layout point is a reference point or not. 

A reference point is a mapping point to another coordinate system such as a geo-
spatial coordinate system or a municipal monument.

See also
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d. Select a color for the layout point.

e. Select a shape for the layout point.

f. Select a group from the list or create a new group by entering a name.

3. Select a location for the layout point in the model. 

The layout point is created when you select the location.

4. Click Tools --> Layout Manager....

5. Click Refresh to show the added point.

You can also add a layout point to a group in Layout Manager. First select a group, then
select the point in the model. Right-click the group and select Add Selected from the pop-

up menu. Click the Refresh button to show the point.

Creating a group in Layout Manager on page 223

Measured points in Layout Manager on page 233

25.3 Creating a layout line
Use the Layout Line tool in the Component Catalog to create layout lines.

Before you start, ensure that the Select components selection switch is activated.
Create layout points in your model. A layout line is created between two layout points.

To create a layout line:

1. Double-click the Layout Line tool in the list of components in the Component Catalog.

2. Define the properties of the layout line.

a. Enter a name and a description for the layout line.

b. Enter the diameter of the layout line. 

Layout Manager uses the XS_IMPERIAL advanced option to determine the units.
Set XS_IMPERIAL to TRUE to show imperial units.

c. Select a color for the layout line.

d. Select a group from the list or create a new group by entering a name.

3. Pick the first layout point.

4. Pick the second layout point. 

See also
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The start point and the end point cannot be in the same location.

The layout line is created.

5. Click Tools --> Layout Manager... .

6. Click Refresh to show the added line.

You can also add a layout line to a group in Layout Manager. First select a group, then
select the line in the model. Right-click the group and select Add Selected from the pop-

up menu. Click the Refresh button to show the line.

Creating a group in Layout Manager on page 223

Creating a layout point on page 225

25.4 Viewing groups, layout points and layout lines
The properties of groups, layout points and layout lines are shown in the property pane in
Layout Manager. You can zoom to and highlight selected layout points and layout lines in
the model and in Layout Manager.

Click Tools --> Layout Manager... and do any of the following:

To Do this
Show or hide the properties of
groups, layout points and layout
lines in Layout Manager

Click the Show property pane button in Layout
Manager. The property pane is visible by default.

Zoom in to a point or a line in
the model

1. Select the point or the line in Layout Manager.

2. Right-click the point or the line.

3. Select Zoom Selected from the pop-up menu.

Highlight a point or a line in
Layout Manager

1. Select the point or the line in the model.

2. Click in Layout Manager.

3. Select Highlight selected model point.

To remove the highlighting, select Redraw.

Layout Manager on page 222

See also

See also
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25.5 Exporting from Layout Manager
You can export layout data from your model to a layout device. You can export the layout
data from Layout Manager to a file and move the file later to a layout device. You can also
export a file directly to a layout device if you connect the layout device to your computer
using a USB or a Bluetooth connection. Note that in addition to Trimble devices, other layout
devices can also read in the .txt and .cnx file types.

To export layout data from Layout Manager:

1. Click Tools --> Layout Manager... .

2. Click Settings  to check that you have defined the needed export settings.

3. Select the group that you want to export. 

If you have defined a local coordinate system for a group, the points in such a group are
exported according to the local coordinate system. The local coordinates of the points are
shown in the export dialog box. The temporary work plane location will not affect the
coordinates of the exported points.

If you select more than one group, ensure that the groups have the same local coordinate
system. If the groups have different local coordinate systems, a warning message is
displayed and you cannot proceed to export.

4. Click Export .

5. Select an export option: 

• Export point file (.txt) to export layout points.

• Export job file (.cnx) to export all layout data that is in the model to Trimble®
LM80.

• Export Field Link File (.tlf) to export all layout data that is in the model to a field
link device.

• Export job file (x86) to export all layout data that is in the model to Trimble® LM80.
This option can be used in 32-bit computers only.

The layout points that you create in the model are design points that you can export to a
layout device.

6. Enter a name for the export file.

7. Define the destination folder.

8. Click Save.

9. If needed, select a drawing in Map file. 

You can attach a layout drawing when exporting a job file (.cnx) and a field link file
(.tfl). You can use the layout drawing with the layout point data in the layout device.

10. Click OK.

Layout Manager on page 222See also
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Defining default export settings in Layout Manager on page 229

Defining the drawing scale in Layout Manager on page 229

Defining default export settings in Layout Manager
You can define the default export settings for each export file type: point file (.txt),
Trimble LM80 job file (.cnx), and Trimble Field Link (.tfl). The units depend on the
settings in Tools --> Options --> Options --> Units and decimals .

To define the default export settings:

1. Click Tools --> Layout Manager... .

2. Click Settings .

3. Click Point File to define the export settings for point files (.txt).

a. Select the unit.

b. Select the delimiter.

c. Define the order of column headers in point files. Right-click a header in the list and
select Move Up or Move Down.

4. Click Trimble LM80 to define the export settings for Trimble® LM80 job files (.cnx).

a. Select the Default directory.

b. Select the default Length unit. 

You can select to export as meters, feet-inches, or survey feet.

c. Select the plane Angle unit. 

The default angle unit is Degree.

d. Select the Version of the Trimble® LM80 device. 

The default version is V4. Ensure that the setting matches the version of your layout
device.

5. Click Trimble Field Link to define the Trimble Field Link file default directory for field link
files (.tfl).

6. Click OK.

Exporting from Layout Manager on page 227See also
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Defining the drawing scale in Layout Manager
You can include a drawing when exporting all layout data in a job file or a field link file from
Layout Manager. To ensure that the drawing is exported correctly, you need to define the
drawing scale.

To define the drawing scale:

1. Create a drawing of your model. 

We recommend you make the drawing as simple as possible, include only parts and grids,
to show the drawing correctly in a layout device. You can, for example, create a drawing
template to be used in Layout Manager export.

2. Double-click the view frame and open View Properties.

3. Copy the drawing scale.

4. Click Tools --> Layout Manager... .

5. Click Drawing Scale Calculator  in Layout Manager.

6. Enter the drawing scale in the Scale Denominator box.

7. Click Calculate. 

The drawing scale is shown in the Scale box.

8. Copy the drawing scale from the Scale box and close the Drawing Scale Calculator
dialog box.

9. Click Drawing File --> Export... in the drawing.

10. Define the export file name on the Export file tab.

11. Go to the Options tab.

12. Paste the copied drawing scale in the Drawing scale box.

13. Click Export.

You can now export the job file or the field link file and the drawing from Layout Manager.

Exporting from Layout Manager on page 227

25.6 Importing to Layout Manager
You can import layout data to your model from a layout device to verify the as-built
conditions. You can copy the file that contains the layout data from the layout device to your
computer and import the file later to Layout Manager. You can also import a file directly to
Layout Manager if you connect the layout device to your computer using a USB or a
Bluetooth connection.

To import layout data to Layout Manager:

1. Click Tools --> Layout Manager... .

See also
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2. Set the work plane to the model origin or to the location you want to use as the origin
when importing points and lines.

3. Click Import 

4. Select an import option. 

• Import point file (.txt) to import layout points.

Point files (.txt) are always imported to the Design Points tab, regardless of
whether they have been measured on the site or not.

• Import job file (.cnx) to import all layout data in a Trimble® LM80 job file.

Job files (.cnx) are imported to the Measured Points tab.

• Import Field Link file (.tfl) to import all layout data in a field link file.

Field link files (.tfl) import both design points that have been exported from Tekla
Structures originally and measured points that have been measured on the site. In
the import dialog box, a design point is flagged if the point name and, therefore,
the point already exists. We recommend that you do not import an existing design
point. Clear the check box next to the flag to exclude an existing point from the
import .

• Import job file (.cnx 32 bit only) to import all layout data in a Trimble® LM80 job
file to a 32-bit computer. You need to connect your computer directly to the
Trimble® LM80 device to use this option.

5. Select the file to import.

6. Click Load to show the file contents.

7. If needed, define the point file columns in the Text File Import - Column Headers
Mapping dialog box.

8. Define the import location in your model using the Insert coordinate system options. 

You can either select the Insert to default coordinate system option or define the
location. To define the location:

• Click the Pick button next to the Location box and pick the origin in the model.

• Click the Pick button next to the Axis X box and set the x direction in the model.

• Click the Pick button next to the Axis Y box and set the y direction in the model.

• Click Set.

9. Select the group to which the layout data is imported. 

If you do not select any existing group or create a new group, the layout points are
imported using their existing Trimble layer categories.

10. Click OK.
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Design points are layout points that have been created in the Tekla Structures model.
Measured points are layout points that have been measured on the construction site.

Layout Manager on page 222

Defining point file columns in Layout Manager on page 232

Measured points in Layout Manager on page 233

Defining point file columns in Layout Manager
You can import layout points to your model in a point file. The point file lists the layout point
names and the coordinates. If the point file does not have a header or if Layout Manager
does not recognize the header, the Text File Import - Column Headers Mapping dialog box
is displayed.

To define the point file header columns:

1. Check that the point file content matches the columns. 

The content of the point file is shown in the table at the bottom part of the dialog box.
You need to check that the content is shown in the correct columns. The columns are
shown at the top part of the dialog box.

Example of a point file:

See also
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2. If needed, change the columns at the top of the dialog box.

3. Select a measuring unit.

4. Select in the Process first line option whether the first line in the point file is a header
row or not. 

• Yes means that the first line has layout point data and that it is not a header line.

• No means that the first line is a header line.

5. Click OK.

Importing to Layout Manager on page 230

Measured points in Layout Manager
Measured points are points that are measured on the construction site using a layout device
and imported to Tekla Structures. You can view the properties of measured points in the
property pane in Layout Manager or in the Layout Point tool dialog box. In addition to the
general point properties, such as name, diameter, and shape, measured points have measured
point properties that cannot be modified in Tekla Structures.

To view the properties, select the point in Layout Manager or double-click the point in the
model.

The measured point properties are as follows:

See also
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Property Description
Is Stakeout Point You can label a measured point as staked

in the Trimble® LM80 device if it deviates
from the corresponding layout point
created in the model.

The property is shown in the Layout Point
tool dialog box.

Is Field Point A field point has been measured on the
construction site and imported to Tekla
Structures.

Is Field Line is the corresponding property
for layout lines.

The property is shown in the Layout Point
tool dialog box.

HR Height of rod is the height of the prism on
the pole. It is used to determine
instrument height, and therefore the
actual elevation of the measured point.

HA Horizontal angle is the angle that was
measured from the back sight or 0 angle.

VA Vertical angle is the difference in angle
measurement from the horizontal position
of the instrument scope.

SD Slope distance is the actual distance
regardless of elevation change. Horizontal
angle is the distance along a horizontal
plane.

PPM Parts per million is a factor used to
determine measurements that take into
account the air conditions and how they
affect the ability of light to travel through
the air. This property is important in the
measurement calculation and accuracy.

Benchmark offset Benchmark offset is a measurement that
is taken to define a benchmark that
elevation measurements are calculated
from.

Importing to Layout Manager on page 230

Creating a layout point on page 225

See also
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26 Tekla Web Viewer

You can publish your Tekla Structures models as web pages that can be viewed via the
Internet using Internet Explorer.

Publishing a model as a web page on page 235

Customizing Web Viewer tooltips on page 236

Web templates on page 237

E-mailing Web Viewer models on page 238

Receiving Web Viewer models on page 238

Sending Web Viewer links on page 238

Creating a named view in Web Viewer on page 239

Creating a clip plane in Web Viewer on page 240

Showing and hiding an object in Web Viewer on page 241

Using a large model in Web Viewer on page 242

Moving and zooming in Web Viewer on page 242

26.1 Publishing a model as a web page

To publish a Tekla Structures model as a web page:

1. Click File --> Publish as Web Page... .

2. Select Publish as Web Page.

3. Select whether to publish the entire model or selected objects. 

If you are publishing selected objects, use the appropriate selection switch to control
whether parts, or parts in assemblies or cast units are published.

4. Select the file type.

5. Define a title for the published web page.

See also
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6. Select a Web Viewer template.

7. Define the destination folder and the file name. 

You can define the location and the name of the published model folder. You can also
rename the published file but do not change the file name extension (*.xml). By
default, Tekla Structures creates a PublicWeb folder with sub-folders in the current
model folder and places the published model there as an index.html file.

8. Select the tooltip template. 

You can create your own tooltip templates in Template Editor. The preview shows how
the tooltip is shown in Web Viewer.

9. Click Publish.

The web browser includes several commands for examining the model. You can right-click
the model in the browser to access a pop-up menu containing these commands.

Customizing Web Viewer tooltips on page 236

Web templates on page 237

26.2 Customizing Web Viewer tooltips
You can define what kind of tooltips are shown in a published Web Viewer model. Use
Template Editor to create a tooltip template.

To customize Web Viewer tooltips:

1. Click Drawings & Reports --> Template Editor... .

2. Create a new template.

3. Save the template in the *.rpt format in the ..\Tekla Structures
\<version>\environments\<environment>\template\tooltips
folder.

4. Click File --> Publish as Web Page... .

5. Select a customized tooltip template in the Tooltip in Web Viewer list. 

The preview shows how the tooltip is shown in Web Viewer.

6. Click Publish.

If you do not want to show the template name as a file name in the tooltip template list,
add the template in the WebViewerTooltips.ini file. The file is located in the
same folder as the tooltip templates. For example, to show
MyPartInformation.rpt as My Part Information add: 
albl_MyPartInformation=MyPartInformation.rpt

See also
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Publishing a model as a web page on page 235

26.3 Web templates
The subfolders under ..\ Tekla Structures\<version>\nt\WebTemplates
\TeklaWebViewer contain all Web Viewer specific materials, for example, a tool
(*.dll) for viewing the model and templates for HTML files.

When you publish a model as a web page, Tekla Structures copies the tool and the files to
the folder you have given in the File name box in the Publish as Web Page dialog box. You
cannot modify the tool, but you can modify the HTML files to include information that is
relevant to your company and the project.

See also
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Project-specific fields must be inside % signs in the HTML files. Tekla Structures uses
information from the model you are publishing in these fields. For example, when you want
the project name to show in the Web Viewer model, add %NAME% in the HTML file. When
you publish your model, Tekla Structures takes the project name from the Project Properties
dialog box.

Do not remove the string %PUBLISHED_MODEL% from the index.html file. Tekla
Structures replaces the string with the file name information from the Publish as Web
Page dialog box.

Publishing a model as a web page on page 235

26.4 E-mailing Web Viewer models

To e-mail a published model:

1. Zip the entire PublicWeb folder. 

Remember to use the folder structure.

2. Attach the.zip file to an e-mail message and send it to the recipient.

Receiving Web Viewer models on page 238

26.5 Receiving Web Viewer models

When you receive a zipped Web Viewer model, ensure that you keep the folder names when
extracting the files. To open the model, double-click the index.html file.

Creating a named view in Web Viewer on page 239

Creating a clip plane in Web Viewer on page 240

Showing and hiding an object in Web Viewer on page 241

Using a large model in Web Viewer on page 242

Moving and zooming in Web Viewer on page 242

See also

See also

See also
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26.6 Sending Web Viewer links

There are two tools you can use to send links from the Web Viewer:

• Send Web Viewer Link

Use this tool to send a link to a single Tekla Structures view.

To see the view name in the Named views list, the recipient must copy the text string
and paste it into the Web Viewer model.

To send several views, copy the text strings pointing to the views into a text file and send
the text file. The recipient then copies the contents of the text file and pastes it into the
Web Viewer model.

• Send ULR Link

Use this tool to send a URL link to the model.

The recipient must have access to the folder that contains your published model.

Receiving Web Viewer models on page 238

Creating a named view in Web Viewer on page 239

26.7 Creating a named view in Web Viewer

To create a named view from a published model:

1. Open the index.html of the published model.

2. Zoom in to the part of the model from which you want to create the view.

3. Right-click and select Copy location.

4. Create a new file in any text editor (for example, Microsoft Notepad) and paste the
location information into it. It should look, for example, as follows: 

5. Enter a name for the view. Replace the default name xyz with a name you want the view
to have.

6. Copy the updated location information to the published model. Select all text in the text
editor, right-click and select Copy.

7. In Web Viewer, right-click on the model and select Paste location. 

The view name appears in the Named views list.

See also

Tekla Web Viewer 239 Creating a named view in Web Viewer



Web Viewer does not save named views with the published model. You can save the text file
that contains the location information, then cut and paste the text to the published model in
Web Viewer the next time you want to use the view.

To allow others to see your named views, send the views using the Send Web Viewer link
tool.

Sending Web Viewer links on page 238

26.8 Creating a clip plane in Web Viewer

Use the keyboard shortcut P or the pop-up menu to create a clip plane.

To create a clip plane, use the
keyboard shortcut P, and select
a plane in the model.

To select the clip plane, click the
scissor symbol.

See also
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Moving clip planes

Move the clip
plane by
dragging the
scissor symbol.

You can
change the
location of the
symbol by
holding down
the Shift key
and moving
the symbol.

Select one clip
plane and
press the
space bar to
jump between
the clip planes.

Tekla Web Viewer on page 235

26.9 Showing and hiding an object in Web Viewer

To show and hide an object in a Web Viewer model:

To Do this
Hide an object 1. Move the mouse pointer over the object.

2. Hold down the Ctrl key and scroll up using
the mouse wheel (or press the Page Up
key).

Show a hidden object 1. Move the mouse pointer over the hidden
object.

2. Hold down the Ctrl key and scroll down
using the mouse wheel (or press the Page
Down key).

See also
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To Do this
Show all objects Press the Esc key.

Tekla Web Viewer on page 235

26.10 Using a large model in Web Viewer
You can disable full content rendering in Web Viewer to use a large model faster.

To use a large model faster in Web Viewer:

1. Right-click and select Disable full content rendering from the pop-up menu.

2. To enable full content rendering again, select Enable full content rendering from the
pop-up menu.

Tekla Web Viewer on page 235

26.11 Moving and zooming in Web Viewer

To move and zoom in a Web Viewer model:

To Do this
Zoom in or out Do one of the following:

• Press the Page Up or Page Down key.

• Scroll the mouse wheel up and down.

Move the model Do one of the following:

• Click Pan and drag.

• Drag with the mouse middle button.

Rotate the model Do one of the following:

• Click Rotate and drag.

• Hold down the Ctrl key and drag with the middle
mouse button.

Fly through the model 1. Click Fly and move the mouse forward to fly
forward.

2. To change flying direction, move the mouse to
the desired direction.

3. To stop, click Esc.

Center the model on
the screen

Click Center.

See also

See also
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To Do this
Return the model to
the original view

Click Home.

Relocate the center of
rotation

1. Press the V key.

2. Click to select a new center of rotation.

You can also right-click the model and select the move and zoom commands from the pop-
up menu.

Tekla Web Viewer on page 235See also
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27 Tekla BIMsight

Tekla BIMsight is a free project collaboration software.

With Tekla BIMsight you can combine models from different project participants and check
for hard and soft conflicts visually and with conflict checking tools. You can communicate
with other parties involved in the project by adding notes, markups and project
documentation to the models.

You can download Tekla BIMsight at www.teklabimsight.com.

Importing reference models from Tekla BIMsight on page 244

Importing additional reference models from a Tekla BIMsight project on page 244

Publishing a model to Tekla BIMsight on page 245

27.1 Importing reference models from Tekla BIMsight

You can import models from a Tekla BIMsight project to Tekla Structures as reference models.

To import reference models from a Tekla BIMsight project:

1. Click File --> Import from Tekla BIMsight... . 

The Import From Tekla BIMsight dialog box opens.

2. Browse for the Tekla BIMsight project (.tbp file).

3. Click Import to import the models from the Tekla BIMsight project. 

You may need to subdivide the reference models, fit the work area in the model, and
change the main 3D view depth to see the reference models entirely after importing.

Importing additional reference models from a Tekla BIMsight project on page 244

See also

See also
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27.2 Importing additional reference models from a Tekla BIMsight
project
Additional models may have been added to a Tekla BIMsight project after you have imported
reference models from the project to Tekla Structures. You can import the additional
reference models to Tekla Structures.

To import additional reference models from a Tekla BIMsight project:

1. Save the Tekla BIMsight project with the same name as previously.

2. In Tekla Structures, click File --> Import from Tekla BIMsight... .

3. Browse for the Tekla BIMsight project (.tbp file).

4. Click Import to import the models from the Tekla BIMsight project.

New reference models are added to the Tekla Structures model. The existing reference models
are not modified in any way. Tekla Structures keeps track of the reference models by
checking the TeklaBIMsightGUID attributes.

27.3 Publishing a model to Tekla BIMsight
You can publish your Tekla Structures model and the reference models included in the model
as a Tekla BIMsight project file.

To publish a Tekla Structures model as a Tekla BIMsight project (.tbp):

1. Click File --> Publish to Tekla BIMsight... . 

The Publish to Tekla BIMsight dialog box appears.

2. Enter a name for the project file.

3. Select the folder where you want to save the project file.

4. Select other options as required. 

• You can include assemblies, base quantities, bolts, grids and reinforcements in the
published project.

• You can split models according to phases.

• Select the Open After Publish check box to open the project in Tekla BIMsight after
publishing.

5. Do one of the following: 

• Click Publish All to publish the whole model. If the model contains reference models
they are also included.

• Click Publish Selected to publish the selected objects.

IFC base quantities on page 89See also
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28 Tekla Structural Designer

Tekla Structural Designer is a software that allows you to design reinforced concrete
buildings and steel buildings. It works with real physical objects such as beams, columns and
slabs. The information transferred is the physical information such as geometry, section sizes
and grade as well as attributed data. In Tekla Structures, you can import from and export to
Tekla Structural Designer.

Tekla Structural Designer is a code-based modeling tool, which enables structural engineers
to establish a code compliance design of the structure, and perform calculations and schema
design, for example. All the design/code data is held within Tekla Structural Designer at all
times.

Tekla Structural Designer will analyze and design structures to a range of International codes
of practice.

The initial model can be started in either Tekla Structures or Tekla Structural Designer,
depending on the project needs. You can import and export many times, and make use of the
effective change management functionality.

The integration process allows you to pass models between Tekla Structural Designer and
Tekla Structures, allowing the updates in the model at both ends. As the model is integrated
between software applications, the changes are updated, and modifications performed since
the last integration operation are maintained within the model.

Tekla Structural Designer and Tekla Structures accept and produce files in the .cxl neutral
file format. The .cxl file format is an XML based neutral file format that allows
applications to link Tekla Structural Designer.

Importing with Tekla Structural Designer integrator on page 248

Re-importing with Tekla Structural Designer integrator on page 249

Exporting with Tekla Structural Designer integrator on page 250

Additional information about integration between Tekla Structures and Tekla Structural
Designer on page 251

See also
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28.1 Example workflow of integration between Tekla Structures and
Tekla Structural Designer
Integration between Tekla Structures and Tekla Structural Designer has been developed to
ensure that the initial model can be started in either tool without any detriment to the
design process. This added flexibility enables companies to align their software solutions
closely to their own workflows. (i.e. The initial model can be created in Tekla Structural
Designer by the engineer or in Tekla Structures by the technician.)

It is recommended that Tekla Structures model is used as the "master model" for geometrical
changes as this model also is linked to the BIM documentation. Alterations made to the
model geometry are best handled by altering the Tekla Structures model and transferring the
changes through to Tekla Structural Designer for redesign.

A typical workflow and the decision making process through the different stages of a project
could be as follows:

Initial scheme stage

• The initial model may be started in Tekla Structures or Tekla Structural Designer without
any detriment to the process.

• A number of factors may determine which software is used for starting the modeling
process, such as availability of staff, or deliverable requirements.

• Unless there are external drivers, Tekla Structures may prove to be the best starting point
for the model as it can provide most of the deliverable items at the initial stage.

• The model does not need to cover the complete building, it might be a typical bay or
floor, for example.

• The generated structure can be designed in Tekla Structural Designer for initial section
sizing at the initial stage and synchronized back to Tekla Structures for initial drawings
or material list creation.

• Simple drawings can be created at this stage, this can be done in Tekla Structures or
Tekla Structural Designer.

• Initial material lists for cost estimates can be generated at this stage.

Detailed design stage

• It is not always appropriate to carry models forward from the Initial scheme stage to the
Detailed design stage as changes to the overall scheme may have been made, which will
not be reflected in the initial scheme model. It is sometimes better to begin the model
again.

• Models can be started in Tekla Structures or Tekla Structural Designer to suit the user.
The models can then be transferred to the other modeling system.

• Importantly, the two models can be worked on at the same time, with synchronization of
the two models taking place to suit the workflow.

• Tekla Structural Designer can be used for a full gravity and lateral design of the structure.

• Within Tekla Structures, drawings can be generated to a tender stage level and general
arrangements submitted to building control for approval.
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Construction stage

• Using the model from the Detailed design stage, much of the Construction stage
process will take place in Tekla Structures so that the integration with other disciplines
can be accounted for.

• The design is not revisited unless the client drives the requirement for change.

• If a re-design of the structure is required, the same synchronization of Tekla Structures or
Tekla Structural Designer models can be carried out to suit the user.

• The model will be completed within Tekla Structures and fully detailed drawings for parts
can be created along with construction level arrangement drawings of the structure.

• Detail integration checks with other disciplines (e.g. mechanical and electrical engineers)
can be carried out at this stage.

28.2 Importing with Tekla Structural Designer integrator

Import with Tekla Structural Designer integrator creates Tekla Structures parts, such as
beams, columns, slabs, and shear walls based on the contents of the imported .cxl neutral
file.

Before importing, open Tekla Structures and the model where you want to import.

To import from Tekla Structural Designer:

1. Select File --> Tekla Structural Designer --> Import from . 

If you have not yet installed the Tekla Structural Designer integrator, you will be guided
to Tekla Warehouse where you can download and install the integrator.

2. In the import dialog box, enter the path of the import .cxl file in the Import file box or
click the ... button next to the box to browse for the file.

3. Once you have selected a valid file, the import buttons and the Preview Conversion
button will be enabled. To read the import file and display all the proposed profile and
material grade conversions to be used, click the Preview Conversion button. 

The import uses an internal conversion list containing the standard profiles and grades.
Any member with profile or material that cannot be converted using the internal
conversion will be flagged in red and the Tekla Structures name will be replaced with the
text *** NO MATCH ***.

4. If the text *** NO MATCH *** is displayed, you can convert the profiles and
materials manually in the following way:

a. Create a profile and/or material conversion file in a text editor using the file name
extension .cnv. 

The conversion files can also be used to override the standard conversion.

b. In the text file, enter the .cxl profile or material name, the equal sign (=) and then
the corresponding Tekla Structures name, for example: 
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STB 229x305x70=TEE229*305*70 for profile

S275JR=S275 for material

If the conversion files are not used, the members with profiles or materials that cannot
be converted will still be created but they will use the import file profile or material,
which may be invalid in Tekla Structures, and the members may be drawn as lines in the
model, but can then be edited manually in Tekla Structures

5. Select the grid options: 

• Delete Tekla Structures' grids: Import will remove all grid lines/planes from the
current Tekla Structures model.

• Import grids from import file: The grid lines from the import file will be imported
into the Tekla Structures model. A grid line pattern will be created, and all the
imported grid lines will be attached as individual grid planes to this pattern.

6. Import by pressing one of the following buttons: 

• Import at Origin: Import the model using the global X, Y and Z coordinates with the
global origin as the 0,0,0 point for the import model’s coordinate system.

• Import at Location: Select a point in the model to use as 0,0,0 and select a second
point to define the X axis to use.

If none of the items in the import file have previously been imported into the current model,
Tekla Structures imports the contents of the selected import file and creates all the required
objects in the Tekla Structures model.

Re-importing with Tekla Structural Designer integrator on page 249

28.3 Re-importing with Tekla Structural Designer integrator

When you import from Tekla Structural Designer you can control which changes will be made
in the Tekla Structures model. If none of the objects in the import file haven been previously
imported in Tekla Structures, the import will complete after Tekla Structures has created the
required objects. If objects already exist then the new members will be listed as new, but if
no objects exist then the import will just take place.

To re-import from Tekla Structural Designer:

1. Follow the steps in Importing from Tekla Structural Designer on page 248.

2. To display the properties of an object, select the object from the list on the left in the
import verification dialog box. 

If you select more than one object, only the properties for the first object on the list are
displayed, but all the objects that you selected are highlighted in the model.

3. If any object in the import file has previously been imported into the Tekla Structures
model, the Model Comparison Tool dialog box is displayed showing the changes and

See also
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allowing you to control which changes will be made in the Tekla Structures model. You
can do one of the following: 

• Ignore deleted list: The .cxl file may contain a list of objects deleted in Tekla
Structural Designer. If objects in this list still exist in the Tekla Structures model, they
will be deleted unless this check box is selected.

• Ignore new items: Objects that did not previously exist in the Tekla Structures model
that are in the import file are excluded from the import if you select this check box.

4. To append the Tekla Structures object ID to the object type string in the comparison tool
list, select Display part IDs.

5. If updating the positions of objects is not required, selecting Profile and material
updates only will only update the object profiles and materials, and ignore other
changes.

6. To reduce the amount of information displayed about the objects that have been
updated, select Only display changed fields. 

Only the values that have been changed are displayed instead of all the object properties.

7. Click Accept to use the current settings and complete the import. 

Once the import is complete you can view the changes in the model using Tekla
Structural Designer_Integration Status object group color and transparency settings
( View --> Representation --> Object Representation ).

Importing with Tekla Structural Designer integrator on page 248

28.4 Exporting with Tekla Structural Designer integrator

Export with Tekla Structural Designer integrator allows you to export the entire Tekla
Structures model or a selected subset of the model. The exported .cxl file can be uploaded
to Tekla Structural Designer to update the model, or to create a new Tekla Structural
Designer model based on the Tekla Structures model.

Before exporting, open Tekla Structures and the model from which you want to export.

To export to Tekla Structural Designer:

1. Select File --> Tekla Structural Designer --> Export to . 

If you have not yet installed the Tekla Structural Designer integrator, you will be guided
to Tekla Warehouse where you can download and install the integrator.

2. In the export dialog box, either enter the path of the export file in the Export file box or
click the ... button at the end to browse to a folder and enter a name for the file. 

See also
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3. Once you have selected a valid file, the export buttons and the Preview Conversion
button will be enabled. To process the model and display all the proposed profile and
material grade conversions to be used, click the Preview Conversion button. 

The export uses an internal conversion list containing the standard profiles and grades.
Any member with profile or material that cannot be converted using the internal
conversion will be flagged in red and the export name will be replaced with the text ***
NO MATCH ***.

4. If the text *** NO MATCH *** is displayed, you can convert the profiles and
materials in the following way:

a. Create a profile and/or material conversion file in a text editor using the file name
extension .cnv. 

The conversion files can also be used to override the standard conversion.

b. In the text file, enter the .cxl profile or material name, the equal sign (=) and then
the corresponding Tekla Structures name, for example: 

STB 229x305x70=TEE229*305*70 for profile

S275JR=S275 for material

If the conversion files are not used, the objects with profiles or materials that cannot
be converted will still be created but they will use the export file profile or material
that may be invalid.

5. You can export the whole Tekla Structures model or only the objects that you select. Do
one of the following to create the neutral file: 

• To export the whole model, click Export Model.

• To export only the selected parts, select the parts from the model and click Export
Selected.

The use of select and view filters is recommended to ensure that only structural part
of the model or elements requiring design are exported.

The Quick report window will show you the result of the export.

Additional information about integration between Tekla Structures and Tekla Structural
Designer on page 251

28.5 Additional information about integration between Tekla
Structures and Tekla Structural Designer
• It is possible to round trip twin profile sections between Tekla Structural Designer and

Tekla Structures. The UK twin profiles in Tekla Structural Designer have a fixed gap and
have been added to the automatic conversion. For other countries, it is necessary to use
the conversion file. The conversion file line for profiles is slightly different because you
need to include the gap in the line.

See also
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See below for three different double-angle profiles from Tekla Structural Designer:

2xUEA(LL) 100x75x8#00615=RSA100*75*8:10(LL)

2xUEA(SL) 75x100x8#00616=RSA100*75*8:12(SL)

2xEA 120x120x10#00614=RSA120*120*10:12

• The number after the “#” symbol is the profile code in the .cxl or .3dn file
format. The code is different depending on the profile type, whether it is metric or
imperial and which country it is from.

• The first number in the profile code represents whether the profile is metric or
imperial: 0 for metric, 1 for imperial.

• The next two digits in the profile code represent the country in this case 06 for UK.

• The last two digits in the profile code indicate the profile type, 15 for long leg to long
leg, 16 for short leg to short leg and 14 for equal angles.

• The Tekla Structures profile is the L shape to use for each of the two members Tekla
Structures will create to represent the single item in Fastrak. The number after the
colon (:) is the gap to use between the profiles in Tekla Structures, and the (LL) and
(SL) convey the required orientation of the members.

• On export, using the same conversion file, the two members in Tekla Structures will
be written to the .cxl file as one twin profile member assuming it is still logical
and possible to do so.

• The current export excludes the Westok items from the export allowing the user to
choose to retain Tekla Structural Designer items during the import to Tekla Structural
Designer. This is currently the only way to retain the Westok properties in Tekla
Structural Designer.

• Westok beams are imported from Tekla Structural Designer to Tekla Structures as
parametric profiles. Currently only standard, circular, non-stiffened holes are imported.

• The cold rolled profile catalogs in Tekla Structural Designer differ from those in Tekla
Structures. This means that transferring cold rolled members between the two systems is
not always complete.

• The timber profiles in Tekla Structures differ from timber catalogs in Tekla Structural
Designer. Therefore by default the timber conversions are limited, however resolving this
issue is simply a matter of using a conversion file and creating any of the require profiles
yourself in the Tekla Structures profile catalog.

• Curved objects can only be transferred from Tekla Structures to Tekla Structural Designer
if they have been modeled as curved polybeams created using three points, because
normal beams created with curved properties are not supported.

• Curved grids are currently imported into Tekla Structures as straight grids from the start
to the end of the Tekla Structural Designer grid line, ignoring the curve.

• Tekla Structural Designer grid lines can be defined anywhere and can be completely
irregular patterned. The import to Tekla Structures deals with this by creating a single
grid pattern and adding all the grid planes to that grid pattern. Some of the advantages
of making all the grid planes in a single grid pattern are that the intersection points work
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correctly and grid elevations views can be created easily. The main disadvantage of this
method is that the grid pattern cannot be updated in Tekla Structures by making changes
in the grid pattern’s properties.

Importing with Tekla Structural Designer integrator on page 248

Re-importing with Tekla Structural Designer integrator on page 249

Exporting with Tekla Structural Designer integrator on page 250

See also
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29 Tekla Warehouse

Tekla Warehouse is a service for collaboration, and for storing and sharing Tekla Structures
content.

Tekla Warehouse provides centralized access to a wide range of content that you can use in
your Tekla Structures models.

With Tekla Warehouse you can:

• Publish your content online.

• Use your company network or a commercial file storage and synchronization service to
share content.

• Save content locally for private use.

In Tekla Warehouse, content is organized into collections.

Tekla Structures collections contain official Tekla content that you can use in your models.
The content is grouped by geographical area. There is also a global folder for content that is
not location specific.

Tekla Warehouse has the following content categories:

• 3D products

• Custom components

• Tools

• Profiles

• Materials

• Bolts

• Reinforcement

• Model setup files

• Drawing setup files

• Report templates

To open Tekla Warehouse while using Tekla Structures, do one of the following:

• Click File --> Open Tekla Warehouse .

Accessing Tekla
Warehouse
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• Click  on the General toolbar.

Tekla Warehouse consists of the Tekla Warehouse web site (https://warehouse.tekla.com/)
and the Tekla Warehouse Service.

You need Tekla Warehouse Service to benefit from all the features Tekla Warehouse offers,
for example, easy installation of content into a Tekla Structures model, or local and network
collections.

For more information on Tekla Warehouse, go to Tekla Warehouse and click About.

Tekla Warehouse
Service

See also
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30 SketchUp

Trimble SketchUp is a modeling software used in, for example, architecture, construction,
engineering and landscape architecture. 3D Warehouse contains lots of SketchUp models
that you can import as reference models to Tekla Structures.

Both SketchUp export and import as reference model support SketchUp version 2014 and
earlier.

You can export Tekla Structures models as .skp files to be used in SketchUp.

Inserting a reference model on page 33

Exporting a model to SketchUp on page 256

30.1 Exporting a model to SketchUp

To export a Tekla Structures model to SketchUp in the .skp format:

1. Select the model objects to export. 

If you want to export all, you do not have to select anything. We recommend exporting
large models in portions.

2. Click File --> Export --> SketchUp...

3. Browse for the Output file location and enter the file name.

4. On the Advanced tab, select the objects that you want to export.

5. Click Create selected. 

If you want to export everything, click Create all.

See also
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31 Analysis and design systems

Analysis and design systems are used to design and analyze the frame or components within
a structure. These applications calculate the loading, stresses and strains on the elements.
They also calculate the moments, shears and deflections on objects under various loading
conditions.

These types of applications make use of various forms of analysis from the traditional first
order static, second order p-delta, geometric non-linear or buckling analysis. They can also
make use of various forms of dynamic analysis from modal extraction to time history and
response spectrum analysis along with the sizing of steel, concrete and timber elements to
the relevant national and international design codes.

Some examples of these systems are CSC Orion, ETABS, STAAD.Pro, SAP2000, Robot, ISM, S-
Frame, MIDAS, Dlubal, SCIA, Powerframe, GTStrudl, Strusoft, and AxisVM.

Analysis and design direct links on page 257

STAAD.Pro on page 259

SAP2000 on page 258

Robot on page 258

ISM on page 259

S-Frame on page 70

31.1 Analysis and design direct links

When you have a direct link to an analysis and design application, and you export the
analysis model from Tekla Structures using that particular analysis application, the model is
opened in the application. Tekla Structures and the analysis and design application need to
be installed on the same computer.

The analysis and design direct links are created either using the Tekla Open API or the older
COM link (Common Object Model transfer technology). A number of direct links are available
including AxisVM, CSC Orion, Diamonds, Dlubal, ETABS, GTStrudl, ModeSt, MIDAS, NISA,
Powerframe, ISM, Robot, SAP2000, SCIA, S-Frame, STAAD.Pro, STRUDS, and Strusoft. CSC
Orion, ETABS, STAAD.Pro, SAP2000, Robot and ISM are available for downloading in Tekla

See also
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Warehouse. For the other applications, the links can be downloaded from the vendor web
sites or by contacting the vendor.

There are special 64-bit installations for STAAD.Pro, SAP2000, Robot and ISM. The other
direct links should only be used with 32-bit installations of Tekla Structures, which can be
loaded on a computer with a 64-bit operating system.

Robot on page 258

SAP2000 on page 258

STAAD.Pro on page 259

ISM on page 259

31.2 Robot
The Robot Millennium A&D application is owned by Autodesk Inc. Full product details can be
found on the Robot Millennium web site.

• This application is suitable for basic interoperability, and it can export and import
cis/2 files.

• If you install Tekla Structures and Robot Millennium on the same computer, then a direct
link can be used.

• Currently only the EC3, LRFD, CM66, E32 and ANS design codes are available in Robot
when using the direct link.

• If you are upgrading to Robot 2012, you will need to uninstall Robot 2011 along with the
Autodesk Robot Structural Analysis link. Then install Robot 2012 and the link again. This
way you make Tekla Structures point to the Robot 2012 application.

Linking Tekla Structures with Robot

Analysis and design direct links on page 257

31.3 SAP2000

The SAP2000 analysis & design application is written by Computers & Structures, Inc. Full
product details can be found on their website.

• The SAP2000 analysis & design application can export and import cis/2 and ifc files, and
export SDNF files.

• If Tekla Structures and SAP2000 are installed on the same computer, then a direct link
can be used.

See also

See also

Analysis and design systems 258 Robot

https://teklastructures.support.tekla.com/en/support-articles/linking-tekla-structures-robot


• It is important that you run SAP2000 for the first time as a standalone application before
your load the link. Just start SAP2000 and create a new model, save it and close
SAP2000. This will then update your registry which is needed by the link.

Linking Tekla Structures with SAP2000

Analysis and design direct links on page 257

31.4 STAAD.Pro
The STAAD.Pro analysis and design application is owned by Bentley Systems, Incorporated.
Full product details can be found on their website.

• STAAD.Pro can export and import CIS/2 files, along with their std format. It has become a
semi-industrial standard especially in the plant and heavy engineering segments.

• If Tekla Structures and STAAD.Pro are installed on the same computer, then a direct link
can be used.

• Profile mapping for different installation environments is achieved by mapping the
profiles used by Tekla Structures and Bentley in files called
ProfileExportMapping.cnv and ProfileImportMapping.cnv located in
the TeklaStructures\TS_STAAD folder. Currently these files are only used in
import.

Linking Tekla Structures with STAAD.Pro

Analysis and design direct links on page 257

31.5 ISM
Bentley’s Integrated Structural Modeling (ISM) is a technology for sharing structural
engineering project information among structural modeling, analysis, design, drafting and
detailing applications.

ISM is similar to Building Information Modeling (BIM), but focuses on the information that is
important in the design, construction and modification of the load bearing components of
buildings, bridges and other structures. Full product details can be found on their website.

The ISM link is different form the other analysis and design links in that the physical model is
also transferred at the same time as the analysis and design model and the ISM model can be
imported into an empty Tekla Structures model. The round-trip of model information is also
controlled by a synchronizer.

If Tekla Structures version 17.0, 18.0, 18.1 or later and an ISM enabled Analysis & Design
application or Bentley Viewer v8i are installed on the same computer then a direct link can
be used.

See also

See also
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In order to use the link the ISM Structural Synchronizer version 3.0 needs to be loaded before
the link.

Linking Tekla Structures with an ISM enabled Analysis & Design application

Analysis and design direct links on page 257

31.6 S-Frame
The international version of the S-Frame analysis and design system is written by S-FRAME
Software Inc. Full product details can be found on their website. The product name is being
changed from S-Frame to S-Calc.

• S-Frame can export and import .dxf files. If Tekla Structures and S-Frame are installed
on the same computer, then a direct link can be used. A copy of the link can be requested
from S-FRAME Software Inc. Descriptions regarding the link can be found here: Building
information modeling (BIM) links.

• In some areas S-Frame used to be distributed by CSC, in which case the installation
points to different folders. The model name must not include spaces as this currently is
an issue as the analysis and design frame is not created if spaces are included.

The process of importing to and exporting from S-Frame

The Tekla API link allows you to write code to connect to an open model in Tekla and query or
manipulate the model. The link was established by using both the S-Frame and Tekla APIs. It
uses a library database to manage items between Tekla Structures and S-Frame.

A copy of the link and instructions on using the link can be requested from S-Frame Software
Inc.

The whole process involves the following steps: importing to S-Frame, displaying imported
items, and exporting from S-Frame. This process is described below.

Importing objects to S-Frame and displaying the objects

1. The S-Frame software checks to see if there is an open model in Tekla Structures using
the Tekla API.

2. If a connection can be established, the Tekla Structures model is queried for a list of
model objects, such as modeled members or panels.

3. The returned objects are iterated through, recognized types are processed, and equivalent
S-Frame objects are added or updated to a library database.

4. The IDs from Tekla Structures are stored so that items can be mapped back and forth
between Tekla Structures and S-Frame.

See also
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5. Once the objects have been iterated through, the library database is queried, and the
updated or created objects referenced in the library are displayed in S-Frame display
window.

Exporting from S-Frame

1. The S-Frame is queried for objects that are displayed in the S-Frame display window.

2. The library is iterated through for types of known objects (members and panels) that can
be mapped back and forth between Tekla Structures and S-Frame.

3. Using the unique IDs stored in the import, the Tekla Structures model is queried to see if
items exist. If they do not, they will need to be created, and the library will be updated.

4. Items can then be added or updated to Tekla Structures to match what is in S-Frame.
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32 Disclaimer

© 2015 Tekla Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced Software. Use of the
Software, and use of this Software Manual are governed by a License Agreement. Among
other provisions, the License Agreement sets certain warranties for the Software and this
Manual, disclaims other warranties, limits recoverable damages, defines permitted uses of the
Software, and determines whether you are an authorized user of the Software. All
information set forth in this manual is provided with the warranty set forth in the License
Agreement. Please refer to the License Agreement for important obligations and applicable
limitations and restrictions on your rights. Tekla does not guarantee that the text is free of
technical inaccuracies or typographical errors. Tekla reserves the right to make changes and
additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by international treaties.
Unauthorized reproduction, display, modification, or distribution of this Manual, or any
portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the
full extent permitted by law.

Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tedds, Solve, Fastrak and Orion are either
registered trademarks or trademarks of Tekla Corporation in the European Union, the United
States, and/or other countries. More about Tekla trademarks: http://www.tekla.com/tekla-
trademarks. Trimble is a registered trademark or trademark of Trimble Navigation Limited in
the European Union, in the United States and/or other countries. More about Trimble
trademarks: http://www.trimble.com/trademarks.aspx. Other product and company names
mentioned in this Manual are or may be trademarks of their respective owners. By referring
to a third-party product or brand, Tekla does not intend to suggest an affiliation with or
endorsement by such third party and disclaims any such affiliation or endorsement, except
where otherwise expressly stated.

Portions of this software:

D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights reserved.

EPM toolkit © 1995-2004 EPM Technology a.s., Oslo, Norway. All rights reserved.

Open CASCADE Technology © 2001-2014 Open CASCADE SA. All rights reserved.

FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.

Teigha © 2003-2014 Open Design Alliance. All rights reserved.

PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved.
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FlexNet Copyright © 2014 Flexera Software LLC. All Rights Reserved.

This product contains proprietary and confidential technology, information and creative
works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication,
distribution, display, modification, or transmission of such technology in whole or in part in
any form or by any means without the prior express written permission of Flexera Software
LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing,
possession of this technology shall not be construed to confer any license or rights under any
Flexera Software LLC intellectual property rights, whether by estoppel, implication, or
otherwise.

To see the third party licenses, go to Tekla Structures, click Help --> About and click the
Third party licenses button.

The elements of the software described in this Manual are protected by several patents and
possibly pending patent applications in the European Union and/or other countries. For more
information go to page http://www.tekla.com/tekla-patents.
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